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1. AN INTRODUCTION TO STAROFFICE WRITER

       

1. Entering a new text or modifying the existing text in a document is known as 
(a) Inserting (b) Hanging (c) Formatting (d) Text Editing

2. StarOffice was developed by
(a) Microsoft Corporation (b) Sun MicroSystems (c) IBM (d) Oracle Corporation

3. A document may contain

(a) Text (b) All the other three choices     (c) Tables (d) Pictures

4. Which one of the following is a Spreadsheet? 

(a) StarOffice Draw (b) StarOffice Calc (c) StarOffice Base (d) StarOffice Writer

5. In StarOffice Writer, the file can be saved by the command

(a) Save (b) Print (c) New (d) Open

6. To cut the selected text in Star Office Writer, use

(a) Search, Replace (b) Search, Cut (c) Edit, Insert (d) Edit, Cut 
7. Which of the following is use d to create presentations?

(a) StarOffice Base (b) StarOffice Draw (c) StarOffice Writer (d) StarOffice Impress

8. Text documents can be created in StarOffice, using

(a) StarOffice Draw (b) StarOffice Writer (c) StarOffice Calc (d) StarOffice Impress

9. The keyboard shortcut to save a document file is

(a) Ctrl + S (b) Shift + S (c) Alt + S (d) Ctrl + F 

10.  Which button is used to hold down and drag across the text to select?

(a) Right mouse (b) Left arrow (c) Left mouse (d) Right arrow

11. The keyboard shortcut to copy a text is

(a) Ctrl + D (b) Ctrl + X (c) Ctrl + V (d) Ctrl + C
12. The flashing vertical bar is called

(a) Cursor (b) End-of-document marker (c) Insertion bar (d) Insertion point

13. The key combination to be pressed to cut a selected text is 

(a) Ctrl + V (b) Ctrl + X (c) Ctrl + C (d) Ctrl + E

14.  StarOffice Writer is a

(a) Spread sheet (b) Word processor (c) DBMS (d) Presentation software

15. The shortcut key that is used to select the entire document in StarOffice

(a) Ctrl + C (b) Ctrl + V (c) Ctrl + X (d) Ctrl + A

16. The command used to start StarOffice is 

(a) StartAllProgramsStaroffice (b) StartAllProgramsStaroffice8

(c) StartFileText (d) File NewText

17. The key used to paste a text is

(a) Ctrl + A (b) Ctrl + Z (c) Ctrl + V (d) Ctrl + X

18. Which key deletes the character to the right of the insertion point?

(a) Backspace (b) End (c) Delete (d) Home 

VOLUME-I ONE MARKS 
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19. In StarOffice Writer, to move one character right, press the key

(a) Right Arrow (b) TAB (c) Shift + Right Arrow (d) Left Arrow

20. The key used to delete the character to the left of the insertion point is

(a) Delete (b) Backspace (c) Enter (d) Space Bar

21.  Which is a word processor?

(a) StarOffice Writer (b) UNIX (c) HTML (d) Spread Sheet 

22. How many sets of scroll arrows are available in StarOffice Writer?

(a) 5 (b) 4 (c) 2 (d) 3

23. Naming a file is used to

(a) Find a file (b) Find & Open that file again (c) Open a file (d) Close a file

24. Which movement key is pressed to move one word to the right? 

(a) Ctrl + A (b) Shift + A (c) Ctrl + Right arrow (d) Ctrl + Left arrow

25. In StarOffice Writer, the thick horizontal line in the page area is called as 

(a) End-marker (b) End-of-document marker   (c) Page-marker (d) Page-end marker

26. Which key is to be pressed to move to the end of the document?

(a) Ctrl+ (b) Ctrl+Home (c) Ctrl + End (d) Ctrl + 

27.  By using which command a new document can be opened?

(a) FileDocument New (b) File TextNew

(c) FileNewText Document (d) File TextDocument

28. Which command is used to reopen a document? 

(a) FileNew (b) FileSave (c) File Open (d) FileDocument

29. The button used to perform the replacement without confirmation is

(a) Cancel (b) Replace All (c) Replace (d) Select

30. The key combination used to move the insertion point to the beginning of a document is

(a) Ctrl + Home (b) Ctrl + Esc (c) Ctrl + Up arrow (d) Ctrl + End

31. Word processing package is

(a) Excel (b) Lotus AmiPro (c) Windows 95 (d) Foxpro

32. Which key is used to correct mistakes?

(a) Erase (b) Delete (c) Delete or Backspace    (d) Backspace 

33. The user can toggle between type-over mode and the insert mode by using

(a) Esc key (b) Insert key (c) Backspace key (d) Delete key

34. Which button is clicked to close the find and replace dialog box?

(a) Close (b) Cancel (c) Abort (d) Ok

35. The insertion point can be moved one cell to the right in a table by pressing

(a) Shift+Tab (b) Tab (c) Alt+Tab (d) Ctrl+Tab

36. To go to the beginning of a line in a StarOffice Writer document, press

(a) End (b) Home (c) Alt + Home (d) Ctrl + Home

37. In StarOffice Writer, Which key is used to move one word to left?

(a) Ctrl + Home (b) Ctrl + Right Arrow (c) Alt + Right Arrow (d) Ctrl + Left Arrow 
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38.  Which of the following is not a word processor?

(a) MS Word (b) Notepad (c) StarOffice Writer (d) Word Star

39. The insertion point can be moved to anywhere in the document using 

(a) Mouse (b) Keyboard (c) Mouse or Keyboard     (d) Mouse Pointer 

40.  Which key should be pressed at the end of each paragraph?

(a) Space bar (b) Shift (c) Enter (d) Ctrl

41. To scroll a relative distance in the document, use

(a) Combo box (b) Scroll box (c) List box (d) Check box

42.  Which of the following always indicates where the new text will appear?

(a) Text area (b) Insertion point (c) Vertical scroll bar (d) End-of-document marker

43.  In which combo box, the word to be searched is typed?

(a) Search (b) Replace (c) Search for (d) Replace with

44. The key combination to be pressed to find & replace the text is

(a) Ctrl + R (b) Ctrl + S (c) Ctrl + F (d) Ctrl + X

45.  StarOffice uses its own desktop called as

(a) Program Desktop (b) Windows Desktop (c) Desktop (d) Star Desktop
46. The title of the new StarOffice Writer document is

(a) No title (b) Untitled (c) Blank space (d) Untitled1 
47.  How many applications Star Office consist of?

(a) 4 (b) Several (c) 5 (d) 3

48.  Which button is to be clicked to skip the found text and to continue the search? 

(a) Ignore (b) Find (c) Cancel (d) Replace 

49. Which bar gives the current mode information about insert mode or type-over-mode? 

(a) Status bar (b) Tool bar (c) Title bar (d) Menu bar

50. In StarOffice Writer, Which one of the following is not used for editing?

(a) Paste (b) Save (c) Cut (d) Copy

51 The extension name of Star Office Writer file is 

(a) .odw (b) .odb (c) .ods (d) .odt
52 Which menu option is used for working with multiple documents? 

(a) Format (b) File (c) Window (d) View

53. In Star Office Writer, under which menu all the formatting options are available? 

(a) Edit (b) File (c) View (d) Format
54. The button used to skip the fount text in Star Office Writer is:

(a) Find All (b) Replace All (c) Replace (d) Find   
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2. TEXT FORMATTING
1. In a certain style, a set of characters and numbers is called as

(a) Paragraph (b) Alignment (c) Indentation (d) Font 

2. When typing in StarOffice Writer, all text aligned in

(a) Right (b) Center (c) Left (d) Justify

3. How many types of formatting are available in StarOffice Writer?

(a) One (b) Two (c) Five (d) Three

4. How many types of paragraph alignment can be selected in StarOffie Writer?

(a) 5 (b) 3 (c) 4 (d) 6

5. When an increase indent icon is selected the paragraph is indented by 

(a) 1/2 inch (b) 3/4 inch (c) 1 inch (d) 1/4 inch

6.  Which key combination is use to right align a text?

(a) Ctrl + E (b) Ctrl + L (c) Ctrl + J (d) Ctrl + R
7. StarOffice Writer default line spacing

(a) 1.5 line (b) Single line (c) Double line (d) Fixed

8. In StarOffice Writer, Soft returns are inserted as

(a) Comma (b) Blank space (c) Line breaks (d) Page breaks

9. Which keyboard shortcut is used to underline the selected text?

(a) Ctrl + L (b) Ctrl + B (c) Ctrl + U (d) Ctrl + I

10.  Which key combination is used for left aligning the selected paragraph? 

(a) Ctrl + L (b) Ctrl + R (c) Ctrl + E (d) Ctrl + J

11. Which font looks like professional?

(a) Arial (b) Fajita (c) Lucida (d) Times New Roman
12. Different colours can be utilized in a text by clicking the icon

(a) Font colour icon (b) File icon (c) Colour icon (d) Open file icon

13. The size of a font is measured in

(a) Inches (b) Dots (c) Pixels (d) Points
14.  A paragraph is any text followed by 

(a) Hard format (b) Hard return (c) Soft format (d) Soft return

15. The visual clue that helps the reader to see how the document divided into paragraph is

(a) Spacing (b) Highlighting (c) Numbering (d) Indenting 

16.  Which fonts are actually sets of symbols?

(a) Wingdings (b) Thorndale (c) Fajita (d) Times New Roman

17. How many types of line spacing are available in StarOffice Writer?

(a) 12 (b) 10 (c) 7 (d) 6

18. The suitable FONT for business documents

(a) Professional (b) Business (c) Fajita (d) Times New Roman
19. The most common type of text formatting is 

(a) Bold (b) All the other three choices (c) Italic (d) Underlined 
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20. Which of the following shortcuts is used to make the selected text bold?

(a) Ctrl + I (b) Ctrl + L (c) Ctrl + U (d) Ctrl + B 

21. StarOffice help facility is called as

(a) On-line (b) Automatic (c) Interactive (d) Off-line 

22. A paragraph can be justified using

(a) Ctrl + R (b) Ctrl + L (c) Ctrl + E (d) Ctrl + J 

23. A negative indenting value will result in

(a) Hanging indent (b) Increase indent (c) Positive indent (d) Decrease indent

24. A named set of defaults for formatting text

(a) Bullet (b) Style (c) Indent (d) Forms

25. To call attention to key ideas in a document, we can

(a) Formatting (b) Highlighting (c) Indenting (d) Numbering

26. The decorative font symbol in StarOffice Writer 

(a) Times New Roman (b) Lucida (c) Arial (d) Fajita

27. Which dialog box can be displayed when you make a click on FormatCharacter menu?

(a) Character (b) StarOffice Writer window     (c) StarOffice Help (d) Replace 

28. The equivalent points to an inch in font size is

(a) 72 (b) 102 (c) 75 (d) 82

29.  Which is used to list the important points and messages?

(a) Bullets (b) Shortcut keys (c) Bullets and Numbers       (d) Numbers 

30. All the formatting options are available under

(a) Format menu (b) Edit menu (c) Tools menu (d) File menu 

31. Some splash can be added to the documents with the help of the

(a) Printer (b) Buttons (c) Pointer (d) Colour printer 

32. To remove the highlighting in StarOffice Writer, select the text and from the colour palette list select

(a) No Highlight (b) Remove Fill (c) No Fill (d) Clear

33.  When typing in StarOffice Writer, which margin is ragged or uneven?

(a) Bottom (b) Right (c) Left (d) Top

34. To change the line spacing in StarOffice Writer, select 

(a) Format Paragraph (b) ParagraphFormat (c) ViewFormat (d) EditFormat Paragraph

35.  Which indent is used in Numbered Lists?

(a) Hanging Indent (b) Increase Indent (c) Left Indent (d) Right Indent

36.  Which keyboard shortcut is used to display an Extended Tip in StarOffice Writer?

(a) Shift + F1 (b) F1 (c) Ctrl + F1 (d) F7

37. The key to access the Star Office Help

(a) F1 (b) F12 (c) F2 (d) F7

38.  Which of the following windows is used to change the help content depending on what is being done in the main 
window?

(a) Help Tip (b) Extended Help Tip (c) Help Agent (d) Online Help 
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39.  Which of the following helps in providing the document more readability?

(a) Spacing (b) Numbered & Bullets     (c) Indentation (d) Paragraph

40. Which type of printer is required to get the hard copy of the document in colour? 

(a) Graphic (b) Line (c) Dot-Matrix (d) Colour printer 

41.  Which is used for setting off a paragraph from the main body text? 

(a) Positive indent (b) Right indent (c) Left indent (d) Center indent

42.  Which box can be used to search for help on other StarOffice elements?

(a) Help Agent (b) Help Tip (c) Choose Help File (d) Extended Tip

43.  Which icon is to be clicked to undo the indent? 

(a) Right indent (b) Increase indent (c) Left indent (d) Decrease indent

44.  Which one of the following statements is false?

(a) A paragraph is any text followed by a soft return
(b) StarOffice offers an online help facility

(c) The colour printer is required to get colour hard copy

(d) A paragraph can be justified by pressing ctrl + J key

45. The keyboard shortcut used while aligning to make the text centered is

(a) Ctrl + J (b) Ctrl + E (c) Ctrl + L (d) Ctrl + C

46.  By default, the Star Office Writer document font size is

(a) 10 (b) 12 (c) 11 (d) 9

47. The command used to open Star Office help to search for a help topic is

(a) HelpStarOffice Help (b) FormatHelp (c) FileHelp (d) HelpOnline Help 

48.  How many types of help systems are provided by StarOffice?

(a) Several (b) 1 (c) 3 (d) 2

49.  Which of the following StarOffice help appears automatically when you perform a complex task?

(a) Online Help (b) Help Agent (c) Extended Help Tip (d) Help Tip

50. Which spin arrows are used to enter the amount to indent text from the right in paragraph dialog box?

(a) Before text (b) After text (c) Before paragraph (d) Above paragraph

51. Bullets and Numbering option is available under

(a) View (b) Edit (c) Format (d) File

52. In StarOfficeWriter, the key pressed to enter a hard return 

(a) Esc (b) Backspace (c) Enter (d) Space bar

53. If the value of first line spin box in the paragraph dialog box is negative it will create

(a) Hanging Indent (b) Indent (c) Left Indent (d) First line Indent

54. In StarOffice Writer, the menu used to apply different styles for the bullets and numbers 

(a) Insert (b) Format (c) View (d) Edit 
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3. CORRECTING SPELLING MISTAKES 
1. Which of the following includes a dictionary and spell-check program in StarOffice?

(a) StarOffice Base (b) StarOffice Draw (c) StarOffice Calc (d) StarOffice Writer

2. Which key is pressed to select the spelling command?

(a) F4 (b) F6 (c) F7 (d) F2 

3.  Which button is clicked to replace all occurrences of a word?

(a) Change all (b) Ignore all (c) Ignore once (d) Change

4. Which of the following displays alternative spellings for a misspelled word in Spell check dialog box?

(a) Not in dictionary (b) Autocorrect (c) Add (d) Suggestions list 

5. Which command is used to add the error and its correction to the auto correct list? 

(a) ToolsCorrect (b) ToolsSpellcheck (c) FormatAutoCorrect   (d) ToolsAutoCorrect
6. StarOffice Writer puts a squiggly line for not matching dictionary words with the colour of

(a) Blue (b) Green (c) Black (d) Red 
7. Which button is clicked to add the word to the dictionary in Spelling check dialog box?

(a) Cancel (b) Add (c) New (d) Insert

8. In how many ways StarOffice Writer can identify the spelling mistakes?

(a) Four (b) Two (c) Many (d) Three

9. To open spelling dialog box, we 

(a) EditSpellingCheck (b) Tools SpellingCheck

(c) FileSpellingCheck (d) Format SpellingCheck 

10. StarOffice Writer can automatically correct some spelling mistakes using

(a) SpellCorrect (b) AutoCheck (c) AutoSpelling (d) AutoCorrect

11. Which of the following icons is used to turn ON or OFF automatic spell check feature?

(a) AutoCorrect (b) Spelling (c) Auto Spellcheck (d) Spellcheck

12. Which button is used to skip the spelling change for the current word?

(a) skip (b) Ignore 
once 

(c) Change (d) Ignore all

13. The number of tabs in AutoCorrect dialog box

(a) 3 (b) 4 (c) 2 (d) 5 

14. The only Check box in the AutoCorrect dialog box is

(a) Match Case (b) Text Only (c) Numbers (d) Whole Words Only

15. The command to open a spell check dialog box is

(a) EditSpellingCheck (b) Tools SpellingCheck

(c) EditCheck Spelling (d) Tools CheckSpelling 
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4. WORKING WITH TABLES 
1. The intersection of a column and a row is

(a) Grid (b) Cell (c) Border (d) Table

2. In StarOffice Writer, a table is a grid with a specified number of

(a) Columns (b) Rows and Columns   (c) Rows or Columns (d) Rows

3. Which command is used to delete the selected row?

(a) TableDeleteRows (b) Table RowsDelete

(c) FormatDeleteRows (d) Table DeleteColumns

4. The simplest way to add a row at the last row of the table is to press 

(a) Insert (b) Tab (c) Enter (d) Right arrow

5. The entire table can be selected by choosing Select All

(a) File (b) Format (c) View (d) Edit

6. Which icon is used to split a cell into two or more cells?

(a) Table fixed (b) Merge cells (c) Split cells (d) Line style

7. The command used to bring out the table formatting toolbar is

(a) ViewToolbarsTable  (b) TableInsertTable (c) FormatTable (d) TableInsert 

8. Which key is pressed to move backward through the cells in a table?

(a) Shift + Tab (b) Tab (c) Shift (d) Back space

9. To make all columns even, the command used is

(a) ColumnSpace Equally (b) Format Column Equally

(c) FormatRow Equally (d) Row Space Equally 

10.  Which key is pressed to move forward through the cells?

(a) Shift (b) Shift + Tab (c) Backspace (d) Tab 
11. Which command is selected to create a simple, default-style table? 

(a) ViewToolbarsTable(b) TableInsert (c) FormatTable (d) TableInsertTable 

12. Which icon is used to delete the current row from the table?

(a) Delete Column (b) Insert Column (c) Delete Row (d) Insert Row

13 By default each cell includes a

(a) Border (b) Column (c) Grid (d) Row 

14. The entire table is selected using

(a) EditSelect All (b) FormatSelect All (c) FormatSelect (d) EditSelect 

15. Which icon is used to combine two or more cells into a single cell?

(a) Split cells (b) Table fixed (c) Optimise (d) Merge cells

16. By default, the insertion point in the__________ cell of the table.

(a) First (b) Second (c) Last (d) Center

17. Which command is used to insert more than one row in the table? 

(a) TableAddRows (b) InsertRows (c) Table InsertRows (d) Table Rows Insert 

18. When the insert table dialog box appears on the screen, the name of the table is given in

(a) Name text box (b) Header box (c) Columns text box (d) Rows text box 
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19.  Which of the following commands is used to delete the selected table?

(a) FormatTableDelete (b) Format DeleteTable

(c) DeleteTable (d) TableDelete Table
20. Which menu is used to select the entire table?

(a) File (b) Format (c) Edit (d) View

21. The command used to delete the selected column in a Star Office Writer table is.

(a) ToolsColumnDelete (b) TableDelete Columns

(c) FormatDeleteColumns (d) Tools DeleteColumns

22. The combination of rows and columns are called as

(a) Cell (b) Table (c) Row (d) Column

23. Which command is used to add the required quantity of columns to the table?

(a) TableColumnInsert (b) InsertColumns
(c) TableInsertColumns (d) Table AddColumns

24. How many options are available under Optimise icon of Table Formatting Toolbar?

(a) 2 (b) 5 (c) 3 (d) 4 

25. Which icon is used to insert a row below the current row?

(a) Delete Column (b) Inserting Row (c) Inserting Column (d) Delete Row 

26. In Insert Table dialog box, the number of columns and rows are entered using

(a) Spin Arrows (b) Check Boxes (c) Radio Buttons (d) Grids

27. Using which dialog box, the column width can be changed in a table?

(a) Mouse (b) Table Format (c) Keyboard (d) Ruler

28. By clicking which icon, a palette of colors is displayed?

(a) Border color (b) Merge cell (c) Borders (d) Line Style

29.  Which is used to specify the number of rows and columns?

(a) Menu (b) Tool bar (c) Insert Menu (d) Grid 
30. Which icon is used to display a floating toolbar with different border options?

(a) Line style (b) Borders (c) Optimize (d) Table fixed

31. Which icon is used to choose the style of line to be used for the border?

(a) Line style (b) Merge cells (c) Optimize (d) Borders

32. When the text or data reaches the cell border, Star Office Writer will wrap the text to the next line and expand the
cell making it

(a) Wider or Taller (b) Wider and Taller (c) Taller (d) Wider

33. To delete a row or column in a table, select the menu

(a) Tools (b) Format (c) Table (d) Insert

34.  Which of the following toolbars is used to choose the line style for the Star Office Writer Table?

(a) Formatting (b) Table Formatting (c) Table (d) Style

35. To make the column narrower, the border is dragged towards

(a) Right (b) Left (c) Up (d) Down

36. To delete only the entries and not the table, the command used

(a) TableDeleteRows (b) TableDeleteColumns

(c) TableDeleteTable (d) Entire Table is selected and delete key is pressed 
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37. The keyboard shortcut used to create the table in StarOffice Writer is

(a) Ctrl + F2 (b) Ctrl + F (c) Ctrl + F12 (d) Shift + Tab

38. Which keyboard shortcut is used to increase the column width?

(a) Alt + Right arrow (b) Ctrl + Left arrow (c) Alt + Left arrow (d) Ctrl + Right arrow

39. Which keyboard short cut is used to decrease the column width, without changing the width of the table?

(a) Alt + Right arrow (b) Alt + Ctrl + Right arrow 

(c) Alt + Ctrl + Left arrow (d) Alt + Left arrow

40. Which keyboard short cut is used to increase the row height?

(a) Alt + Down arrow (b) Ctrl + Up arrow (c) Ctrl + Down arrow (d) Alt + Up arrow

41. In Star Office Writer, which of the following commands is used to get a table format dialog box? 

(a) TableTable properties (b) Table Table Format 
(c) InsertTable (d) Insert Table properties 

42.  If TableTable Properties command is used, which of the following dialog box is opened? 

(a) Table Format (b) Table properties (c) Format Table (d) Cell properties

43. In Star Writer the first Icon in the floating toolbar for insertion function is:

(a) Merge Cell (b) Borders (c) Insert Table (d) Split cell 
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5. PAGE FORMATTING
1. The default width of left and right margins in StarOffice Writer is 

(a) 1.75 inch (b) 1.25 inch (c) 1.5 inch (d) 1 inch

2. Ruler option is used to change

(a) Margins (b) Paper Orientation (c) Footer (d) Header

3. If the length of the document is more than the width, it is called

(a) Landscape (b) Footer (c) Portrait (d) Margin

4. If the width of the paper is more than the length, it is called

(a) Footer (b) Landscape (c) Portrait (d) Header

5. The default orientation for a document is

(a) Margin (b) Portrait (c) Landscape (d) Header

6 To create footer, which tab is clicked in Page style dialog box?

(a) Header (b) Page (c) Footer (d) Borders

7. The Header & footer are separated from the rest of the text by

(a) A gray box (b) A thick line (c) A grid (d) A thin line

8. The area at the bottom of the page is called

(a) Bottom space (b) Footer (c) Header (d) Margin

9. The default top and bottom margins

(a) 0.5 inch (b) 1.5 inches (c) 1 inch (d) 1.25 inches

10. Which command is clicked to insert page numbers?

(a) InsertFields Page Number (b) FooterPage Number 

(c) InsertPage Number (d) Insert Page
11.The margin settings for a page is displayed by clicking the tab

(a) Header (b) Page (c) Organizer (d) Background

12. Which command is clicked to appear the page style dialog box?

(a) FormatPage (b) ToolsPage (c) FormatPage Style (d) EditPage 

13. Which is normally used to contain the page numbers?

(a) Footer (b) Header (c) Text area (d) Border

14. W hich is normally used to contain the titles or topics?

(a) Header (b) Footer (c) Text area (d) Border

15. Which tab is used to create a header on the page style dialog box?

(a) Header Toolbar (b) Header File (c) Header Tab (d) Header Taskbar

16. Which dialog box is used to set the width of the paper?

(a) Character dialog box (b) Header dialog box (c) Page Style dialog box (d) Table Format dialog box

17. In StarOffice Writer, the Page Preview option is available under the menu,

(a) File (b) View (c) Edit (d) Format

18. If the ruler is not displayed in StarOffice Writer screen, which option is clicked?

(a) FormatRuler (b) ToolsRuler (c) ViewRuler (d) Edit Ruler

19. Which of the following are some references and remarks added at every page of the document?

(a) Margins and Borders (b) Borders and Columns   (c) Portrait and Landscape   (d) Header and Footer 
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20. Which spin boxes are used to enter the size of the paper?

(a) Top and Bottom (b) Left and Right (c) Width and Height (d) Length and Breadth

21. The new margin setting is entered using the---------------arrow.

(a) Up (b) Right (c) Left (d) Spin

22. The margins for a particular page can be set to an exact value using

(a) Scroll bars (b) Tool box (c) Rulers (d) Page Style dialog box 

23.  Most documents are printed in the paper with the size of

(a) 10 inch by 9.5 inch (b) 8.5 inch by 11 inch (c) 8 inch by 11.5 inch (d) 8.5 inch by 11.5 inch

24. The margins for a particular page can be set approximately using

(a) Page Style dialog box (b) Marker (c) Scale (d) Ruler 

25. How many spin boxes will be displayed when the header check box is clicked?

(a) 4 (b) 3 (c) 2 (d) 5

26. Which buttons are used to change the page orientation?

(a) Radio (b) Option (c) Round (d) Command control

27.  Which option gives an overall picture of the document visually?

(a) Print view (b) Print Preview (c) File view (d) Page Preview
28. Which one of the following statements is false?

(a) The default orientation is portrait (b) A cell is the intersection of a row and a column

(c) Header is an area at the bottom of the page (d) StarOffice Writer includes spell check program 

29. The default height of a page in default orientation is

(a) 8.6 inch (b) 1 inch (c) 1.25 inch (d) 11 inch

30. The default width of a page in default orientation is

(a) 8.5 inch (b) 11 inch (c) 8 inch (d) 11.5 inch 

31. How many types of page orientations are there?

(a) 2 (b) 4 (c) 1 (d) 3

32. The ruler option in StarOfficeWriter is available under

(a) Edit (b) View (c) Format (d) File

33. In a text document, the area at the top of the page is called as

(a) None of the three choices (b) Footer (c) Header (d) Page number 

34. How many methods are used to change the page margins? 

(a) Four (b) Two (c) Six (d) Three

35. In Star Writer which dialog box is used to set the width of the paper?

(a) Format (b) Table (c) Paragraph (d) Page style 
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6. SPREADSHEET
1. A data file created with spreadsheet is called a

(a) Chart (b) Formula (c) Cell (d) Worksheet

2. StarOffice Calc is a part of

(a) Windows (b) Linux (c) MS Office (d) StarOffice

3. Which is a tool for working with numbers?

(a) StarOffice Impress (b) Database (c) StarOffice Writer (d) Spreadsheet
4. The first electronic Spreadsheet is (or) The first commercial spreadsheet package is

(a) Visicalc (b) StarOffice Calc (c) Lotus 1-2-3 (d) QPro

5. Every formula should begin with the symbol _ ___ ___ ___ __.

(a) = (b) > (c) + (d) !

6. A cell address is made absolute by using the

(a) ! (b) = (c) $ (d) *

7. The text operator in StarOffice Calc is

(a) $ (b) & (c) ! (d) *

8. The active cell is identified by the

(a) Record pointer (b) Cursor (c) Cell pointer (d) Insertion point 

9. A continuous group of cells is known as

(a) Row (b) Column (c) Range (d) Group

10. To preview a worksheet before printing, click Page View from

(a) Edit menu (b) View menu (c) File 
menu 

(d) Format menu

11. Two or more adjacent cells are referred to as

(a) Column (b) Range (c) Row (d) Cell

12.  Which of the following is an example of spreadsheet package?

(a) Improve (b) Excel (c) Quattro Pro (d) All the other three choices
13. Which is the default type of cell addressing?

(a) Both Relative & Absolute (b) Reference (c) Relative (d) Absolute

14. Which icon is used for inserting a formula in the worksheet?

(a) Insert Formula icon (b) Insert Chart icon (c) Insert Applet icon (d) Insert Object icon

15. The format for entering Time is

(a) HH:MM:SS (b) SS:MM:HH (c) MM:HH:SS (d) HH:SS:MM

16. Which of the following is a reference operator?

(a) : (or) ! (b) ; (c) & (d) =

17.  The InsertFunction option is used to select a

(a) AutoFormat (b) Chart (c) Function (d) Graph 

18. In order to shift the content of a cell to the right and create an empty cell, select the cell and click the icon

(a) Insert Cells Right (b) Insert Rows (c) Insert Columns (d) Insert Cells Down

19. Which command is used to print a part of a worksheet?

(a) Format Print RangesEdit (b) Format Print Ranges Delete

(c) FilePrint (d) Print icon 
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20. In StarOffice Calc Screen, below the menu bar is the function bar and

(a) Tool bar (b) Formula bar (c) Status bar (d) Object bar

21. One of the most commonly used functions in Star Office Calc is

(a) SUM (b) AVERAGE (c) SQRT (d) ABS

22. Which operator combines sections of text to the entire text?

(a) = (b) > (c) ! (d) &

23. Which icon is selected to display the numbers in currency format?

(a) Currency (b) Add Decimal (c) Percent (d) Standard

24. The date format is

(a) MM/DD/YY (b) DD/MM/YY (c) YY/MM/DD (d) DD/YY/MM

25. The syntax of formula begins with the sign

(a) < (b) ( (c) + (d) =

26. The predefined formulae that are available in Star Office Calc are

(a) Keywords (b) Constants (c) Functions (d) Variables 

27. The option used to open a worksheet that has been saved is

(a) FileSave (b) FileSaveAs (c) FileNew (d) FileOpen
28. To change the height of a row, the command used is

(a) FormatRow Height (b) Format RowWidth

(c) FormatColumnWidth (d) Format ColumnHeight

29. Which command is used to save a worksheet?

(a) FileSave (b) FileOpen (c) FileQuit (d) FileExit 

30. In order to insert a column, use the icon

(a) Insert Columns (b) Insert Cells Down (c) Insert Cells Right (d) Insert Rows

31. The intersection of rows and columns are called

(a) Spreadsheets (b) Labels (c) Grids (d) Cells 
32. The option used to close the worksheet is

(a) FileExit (b) FileClose (c) FileNew (d) FileOpen 

33. StarOffice Calc was developed

(a) Microsoft International    (b) Sun Microsystems (c) Lotus Corporation (d) Borland International

34. Which cell addresses do not change when copied?

(a) Reference (b) Absolute (c) Relative (d) Both Relative & Absolute

35. The full form of Visicalc is

(a) Visicalculation (b) No full form it is a company name 

(c) Visicalculator (d) Visible Calculator

36. The command used to generate a series of data in a spreadsheet is

(a) Auto number (b) Auto (c) Auto generate (d) Fill 

37.  Which is the first cell of the Spreadsheet?

(a) 1 (b) 1A (c) A (d) A1 
38. Who invented Visicalc for AppleII?

(a) Bon Frankston (b) Dan Bricklin and Bon Frankston (c) Dan Bricklin  (d) Charless Babbage 
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39. Which operators combine cell areas?

(a) Comparative (b) Reference (c) Arithmetic (d) Text

40. Electronic spreadsheet uses the concept of

(a) 'Where to' analysis (b) 'What if' analysis (c) WYSISWYG (d) 'Why if' analysis

41.  The PCs became popular due to the invention of

(a) Excel (b) Visicalc (c) QPro (d) Lotus 1-2-3

42. The command used to generate a series of data is

(a) EditSeries (b) InsertSeries (c) Fill Series (d) EditFill Series
43. What is the function used to find the square root of a number?

(a) SQTR (b) SQR (c) SQT (d) SQRT

44. To draw in spreadsheet, click

(a) Image icon (b) Draw icon    (c) Insert Picture 
icon 

(d) Show Draw Functions icon 

45. Which of the following functions calculates the total of a given set of numbers?

(a) SQRT (b) ADD (c) COUNT (d) SUM 

46. Visual representation of data is referred as

(a) Charts (b) Frames (c) Bar diagrams (d) Graphs

47.  Which formula is for working with multiple sheets in StarOffice Calc?

(a) 2-D (b) 1-D (c) Mathematical (d) 3-D 
48.  Dan Bricklin and Bon Frankston invented

(a) Lotus 1-2-3 (b) Visicalc (c) StarOffice Calc (d) Excel

49. To insert objects like charts, images and formula in a worksheet, click the option

(a) Insert Object (b) Insert Chart (c) Insert Picture (d) Insert Formula

50.  Graphical representation of numbers is known as

(a) Bar diagrams (b) Graphs (c) Frames (d) Charts

51. The cells are addressed in terms of

(a) Row labels (b) Row and Column labels 

(c) Labels (d) Cell labels

52. Which key is used to edit data in a worksheet?

(a) Ctrl + F (b) F6 (c) F2 (d) F7

53. To format the data in a cell, click

(a) ToolsCells (b) FormatCells (c) InsertCells (d) EditCells 

54. Which command is used for preparing the chart in Star Office Calc?

(a) ChartFrom File (b) InsertFrom File (c) InsertObjects (d) InsertCharts 

55. Automatic fill command of StarOffice Calc is equivalent to

(a) Cut and Paste (b) Copy and Insert (c) Cut and Insert (d) Copy and Paste 
56. The combination of column and row headings is known as

(a) Cell Address (b) Cell (c) Cell Pointer (d) Cell Range

57.  Which is the shortcut icon for Function Wizard in Spreadsheet?

(a) InsertFunction (b) Ctrl + F2 (c) fan(x) (d) f(x)  
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58. The command used for inserting special characters in Spreadsheet is

(a) InsertSpecial Characters (b) InsertASCII Characters

(c) InsertPictureFrom File (d) Insert Special Symbols

59. The OLE stands for

(a) Object Linking Embedded (b) Object Linking Enrolled 

(c) Object Linking Environment (d) Object Linking Enrichment

60.  Over the time, the term spreadsheet has come to refer specifically to

(a) File (b) Tabular column (c) Software package (d) Worksheet

61. Which of the following bars is used to display the current cell and its content in StarOffice Calc?

(a) Formula bar (b) Tool bar (c) Status bar (d) Menu bar

62. To remove print range setting, click

(a) FormatPrint RangesErase (b) Format PrintDelete

(c) FormatPrint RangesEdit (d) Format Print RangesDelete

63. Data and formula can be entered into the

(a) Cell address bar (b) Status bar (c) Menu bar (d) Cell

65. The function bar is below the

(a) Menu bar (b) Scroll bar (c) Status bar (d) Object bar

66. Lotus 1-2-3 was introduced in the year

(a) 1982 (b) 1980 (c) 1985 (d) 1984

67. In order to insert an empty row, the icon to be selected is

(a) Insert Cells Right (b) Insert Cells Down (c) Insert Columns (d) Insert Rows

68. Visicalc contained______ of columns.

(a) 65 (b) 62 (c) 63 (d) 64

69. The spreadsheet developed by Lotus Development Corporation is

(a) Quattro Pro (b) Improve (c) StarOffice Calc (d) Excel69

70. Which icon is used to import objects from other applications into a worksheet?

(a) Insert OLE Object (b) Insert Formula (c) Insert Chart (d) Insert Applet 

71. Borland International introduced

(a) Quattro Pro (b) Improve (c) StarOffice Calc (d) Excel

72. Which facility of StarOffice Calc helps to format the worksheet with different predefined styles and colours?

(a) AutoPilot sheet (b) AutoStyle Sheet (c) AutoCorrect sheet (d) AutoFormat sheet

73. To change the width of a column, the command used is

(a) FormatRowHeight (b) Format ColumnWidth

(c) FormatRowwidth (d) Format ColumnHeight

74. In Spreadsheet, each cell is referred to by its

(a) Insertion Point (b) Record Pointer (c) Cell Address (d) Cursor

75. Which function key is pressed to appear a vertical cursor on the formula bar?

(a) F7 (b) F1 (c) F5 d) F2
76. Which icon provides to generate a scrolling screen within a worksheet?

(a) Insert Applet (b) Insert OLE Object (c) Insert Floating Frame (d) Insert Chart 
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77. Which menu is selected to quit from StarOffice?

(a) FileExit (b) FileQuit (c) Menu Exit (d) MenuQuit

78. In which menu, Function option is available?

(a) Open (b) Reference (c) Insert (d) File

79. Exponentiation is represented by

(a) + (b) % (c) / (d) ^

80. Which one of the following is not a comparative operator?

(a) = (b) <> (c) / (d) >

81. The option under the File menu used to print the worksheet is 

(a) Page View (b) Print Preview (c) Print Range (d) Print

82. In Fill Series dialog box, the equivalent type for multiplication

(a) Growth (b) Date (c) Autofill (d) Linear 

83. The percentage (% ) icon multiplies the contents of the cell by

(a) 1000 (b) 10 (c) 1 (d) 100

84. Which of the following is an intersection operator?

(a) ; (b) & (c) ! (d) :

85. To view data in the form of charts, use

(a) Spreadsheet (b) StarOffice Base (c) StarOffice Writer (d) Table

86. Which reference operator is used to set the range in a spreadsheet?

(a) : (b) ! (c) ; (d) $

87. Which number format icon is used to display the contents of the selected cells in default format?

(a) Percent (b) Currency (c) Add Decimal (d) 
Standard 88.  Spreadsheet columns are labeled from

(a) A to IV (b) A to IU (c) A to Z (d) A to IA

89. The number of icons appeared in the Insert Cell floating tool bar are

(a) Four (b) Five (c) Three (d) Six

90. In StarOffice Calc, rows are numbered from 1 to

(a) 21000 (b) 22000 (c) 31000 (d) 32000
91. The status bars and scroll bars are at the

(a) Extreme right (b) Extreme bottom (c) Top (d) Extreme left

92.  Visicalc for Apple II was invented in the year

(a) 1977 (b) 1981 (c) 1982 (d) 1979
93. Lotus 1-2-3 became very popular because of its ability to combine

(a) Graphics features (b) Both Graphics and Database Management features

(c) Database management features (d) Mathematical formulae

94. Excel was introduced by

(a) Borland International (b) Microsoft Corporation    (c) Lotus Corporation    (d) Sun Microsystems

95. The automatic fill feature of StarOffice Calc is used for the purpose of

(a) Moving (b) Inserting (c) Copying (d) Deleting 
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96. Which option is used to delete a row?

(a) EditDelete Cells (b) EditDelete (c) EditDelete Rows (d ) EditDelete Contents

97. To increase the width of a column, the mouse is clicked and dragged towards the

(a) Right (b) Upward direction (c) Left (d) Downward direction

98. To decrease the width of the cell, the mouse is dragged

(a) Upwards (b) Towards the right (c) Downwards (d) Towards the left

99. In StarOffice Calc, the non-numeric entries are referred with--------
(a) Character (b) String (c) Label (d) Non-numeric

100. The Personal Computer was introduced in the year

(a) 1976 (b) 1982 (c) 1975 (d) 1979

101. Which is not a comparative operator?

(a) <> (b) >= (c) < (d) &

102. Visible calculator package was developed for

(a) Super Computers (b) Mainframe Computers   (c) Micro Computers (d) Mini Computers

103. Lotus1-2-3 was introduced by

(a) Sun Microsystems (b) Microsoft Corporation

(c) Borland International (d) Lotus Development Corporation 

104. The automatic fill feature is used to

(a) Type the formula (b) Draw charts (c) Create a series (d) Copy the cell contents 

105. Visicalc was an essential program for

(a) Cost benefit analysis (b) Tender evaluation (c) Inventory control (d) Financial analysis 

106. The cell A4 becomes absolute when you enter

(a) A$$4 (b) A$4$ (c) $A4$ (d) $A$4 

107. In spreadsheet of multiple sheets, a list of sheets appear as tabs

(a) at the bottom (b) at right (c) at left (d) at the top 

108. Cells B3, B4, C3, C4, D3, D4 in StarOffice Calc can be referred as

(a) B3:D4 (b) B3:D3 (c) B4.D4 (d) B3.D4

109. The cell D7 in StarOffice Calc becomes absolute, when you type it as

(a) $D*7 (b) *D$7 (c) *D*7 (d) $D$7 

110. The cells A4, A5, A6, B4, B5 & B6 are referred in a Worksheet as 

(a) A1:B6 (b) A4:A6 ; B4:B6 (c) A4:B6 (d) A1:A6 ; B1:B6

111. How many rows and columns are in Visicalc?

(a) 254, 36 (b) 524, 36 (c) 63, 254 (d) 254, 63

112. How many cells are available in the worksheet range C1:E2?

(a) 6 (b) 10 (c) 4 (d) 8

113. Which cell of worksheet is referred as Home Cell?

(a) 1A (b) AA (c) First cell (d) A1 

114. Which refers to the files that you create with spreadsheet software?

(a) Rows and columns (b) Spreadsheet (c) Table (d) Worksheet 
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115. Which of the following statements is false?

(a) Small red triangles indicate column width is enough

(b) Spreadsheets are made up of rows and columns

(c) Exit under File can be used to quit from StarOffice

(d) At the top of Spreadsheet window is the Menu bar

116. The Inequality comparative operator symbol is

(a) >< (b) <> (c) = (d) >=

117. Which Series type option can be used for both positive and negative increment?

(a) Linear (b) Date (c) Growth (d) AutoFill

118. The 3D formula to calculate the sum of the numbers in the cell A1 of Sheet1 and A1 of Sheet2 is

(a) =SUM(Sheet1.A1:Sheet2.A1) (b) =SUM(Sheet1.A1;Sheet2.A1)
(c) =SUM(Sheet1:A1;Sheet2:A1) (d) =SUM(Sheet1.Sheet2.A1:A2)

119. Which command is used to print the worksheet with grids?

(a) FormatBorders (b) FormatGrids (c) FormatSheet (d) FormatPage

120. By default, how many numbers of sheets are available in a spreadsheet?

(a) 4 (b) 3 (c) 1 (d) 2

121. Which of the following data can be typed into a spreadsheet cell?
(a) All these three choices    (b) Text (c) Numbers (d) Formulae

122. Which bars have shortcut icons for frequently done tasks in the spreadsheet?

(a) Menu bar (b) Formula bar (c) Object bar (d) Main Tool bar

123. The operator <> is used to check

(a) greater than (b) equal (c) inequality (d) less than

124. Fill command in Star Office Calc is available under the menu is

(a) Edit (b) Format (c) Mouse (d) Keyboard

125. The process of arranging the data in some order in a table is called

(a) Merging (b) Sorting (c) Filtering (d) Searching

126. Which of the following has short cut icons for frequently done tasks in spreadsheet?

(a) Function bar & Object bar (b) Formula bar

(c) Main Tool bar (d) Menu bar

127. Which icon in standard toolbar is used to draw in Star Calc?

(a) Show draw functions (b) Show functions picture 

(c) Draw picture (d) Show icon 
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7. DATABASE
1. The term data comes from the word

(a) Datus (b) Datum (c) Datem (d) Datas

2. A database is a repository of collections of related

(a) Row (b) Table (c) Information (d) Column

3. Which of the following is used to arrange data in some order? 

(a) Sorting (b) Form (c) Query (d) Filter

4. How many field types are there in Star Office Base?

(a) 11 (b) 20 (c) 13 (d) 14

5. The entire collection of related data in one table is referred to as

(a) Query (b) File (c) Field (d) Record

6. Which key uniquely identifies a record in a database table? 

(a) F1 key (b) Primary key (c) F5 key (d) Secondary key

7. Editing the data includes

(a) Deleting a record (b) Changing the format of the database 

(c) All the other three choices (d) Appending a record

8. Which database file consists of a single data table?

(a) Relational (b) Flat-File (c) Network (d) Hierarchical

9.  Which is a process of joining data from two tables of different databases?

(a) Filtering (b) Searching (c) Merging (d) Sorting

10. To edit a record, we have to select the record by clicking on

(a) Record pointer (b) Record button (c) Tab key (d) Record key

11. Process of performing correction on the existing data is called as

(a) Filtering (b) Editing (c) Searching (d) Sorting

12. Printed information that is assembled by gathering data is called

(a) Table (b) Form (c) Query (d) Report

13. By clicking on the Delete Rows option the selected record will

(a) Appended (b) Changed (c) Deleted (d) Edited

14. Sorting on more than one field of a table at the same time is called

(a) Multi Sorting (b) Multiple sorting (c) Searching (d) Sorting

15. DBMS is an acronym for

(a) Data Base Management System (b) Data Base Maintaining System

(c) Data Binary Management System (d) Data Base Manipulating System

16. Which is simply a screen that displays fields of a record in a well spaced out manner?

(a) Filter (b) Table (c) Query (d) Form

17.  In How many ways the Manipulation of database can be done?

(a) 7 (b) 6 (c) 10 (d) 8

18. Standard Filter is also called as

(a) Conditioned Filter (b) Complete Filter (c) Default Filter (d) AutoFilter 
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19. The process used to select a desired specific data from a database is

(a) Filtering (b) Sorting (c) Merging (d) Searching

20. The shortcut key used for saving a table in Star Office Base is

(a) Ctrl + F (b) Ctrl + A (c) Ctrl + E (d) Ctrl + S 

21. A Database is a collection of

(a) Fields (b) Columns (c) Rows (d) Tables

22. A repository of collections of related data or facts

(a) Program (b) Database (c) Data (d) Information

23. SQL stands for

(a) Standard Query Link (b) Structured Query Language 

(c) Standard Query Language (d) Structured Query Link

24. The accurate length of decimal digits in a single precision number is

(a) 7 (b) 14 (c) 13 (d) 8

25.  Sorting is a process of

(a) Joining the data (b) Performing corrections

(c) Arranging the data (d) Selecting a desired specific data

26. Which one of the following databases is very powerful?

(a) Relational (b) Hierarchical (c) Network (d) Flat-File

27.  Which command is used to create a new database in StarOffice Base?

(a) NewFileDatabase (b) FileNewTable (c) NewDatabase (d) FileNewDatabase

28. The collection of Tables, Queries, Forms and Reports are generally referred to

(a) Multimedia (b) Document (c) Database (d) Spreadsheet

29. What are the two types of report in StarOffice Base?

(a) Static and Dual (b) Static and Standard (c) Standard and Dynamic   (d) Static and Dynamic

30. In case of double precision, decimal values are accurate upto the length of

(a) 8 Places (b) 6 Places (c) 14 Places (d) 7 Places

31. To send text outline into presentation, select

(a) FileOutline to Presentation (b) File Presentation

(c) FileSendPrsentation (d) File SendOutline to Presentation

32. The keyboard shortcut used to switch over from one software window to another window is

(a) Alt + Tab (b) Shift + Tab (c) Tab (d) Ctrl + Tab

33.  DDE means

(a) Dynamic Data Exchange (b) Dynamic Datas Exchanged

(c) Dynamic Data Enrichment (d) Dynamic Data Environment

34. The Paste Special menu is available under the menu

(a) Insert (b) File (c) Edit (d) View

35. A row in a StarOffice Base table represents a _ ___ ___ _.

(a) File (b) Structure (c) Field (d) Record
36. In which database, records are organized in a tree like structure?

(a) Relational (b) Network (c) Hierarchical (d) Object oriented 
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37. Which is the user defined screen to view data from a table or a query?

(a) Report (b) Form (c) Filter (d) Query 

38. Which one of the following is a type of query?

(a) Table (b) Filter (c) Report (d) File
39. Which is the most prevalent database in today’s business organizations?

(a) Flat-File (b) Network (c) Relational (d) Hierarchical

40. Which of the following icons is used to remove the filter?

(a) Filter (b) Remove Filter (c) Remove Filter / Sort       (d) Sort 

41. Spreadsheet is an example for

(a) Flat-file (b) Network (c) Relational (d) Object Oriented

42. Which is used to browse through selected records to meet a set of criteria?

(a) Searching (b) Filter (c) Query (d) Sorting

43. Which database is very similar to hierarchical structure?

(a) Flat-file (b) Object-oriented (c) Relational (d) Network

44. Filter used with a condition is called

(a) Default Filter (Standard Filter) (b) Conditioned Filter (c) AutoFilter (d) Unconditioned Filter

45.  Which one of the following can be saved for later use? 

(a) Questions (b) Filters (c) Queries (d) Filters and Queries

46. Users can define their own more sophisticated data types are called as

(a) Primitive (b) System defined (c) Built-in (d) User-defined 

47. Records that are organized in parent-child type relationship is

(a) Hierarchical (b) Flat File (c) Network (d) Relational

48. Which of the following limits the information on the screen of database?

(a) Viewing (b) Arranging (c) Sorting (d) Filtering

49. Based on the conceptual structures, the Star Office Base databases are classified into

(a) 7 (b) 5 (c) 2 (d) 8

50. How many options are there in the left pane of StarOffice Base screen?

(a) 3 (b) 4 (c) 5 (d) 2

51. In StarOffice Base, each table column represents a

(a) Field (b) Record (c) Cell (d) File

52. Which database defines data characteristics, attributes, and procedures as complex objects? 

(a) Relational Database (b) Object Oriented Database 
(c) Flat-File Database (d) Hierarchical Database

53. In which database, one record type can be related to any number of other record types? 

(a) Hierarchial (b) Relational (c) Flat-file (d) Network
54. Which of the following options is used to insert the field names of the database table as headings for each of the

text table columns?

(a) Create column name (b) Create row only (c) Insert column name (d) Apply column name
55. Which of the following options is used to insert an empty heading line into the text table? 

(a) Create row only (b) Create row name (c) Create empty row (d) Apply column name 

 
www.Padasalai.Net                                                              www.TrbTnps.com

http://www.trbtnpsc.com/2018/02/latest-12th-study-materials-2018.html

www.Padasalai.Net



 
M.VIJAYA KUMAR, MCA.,M.Phil.,B.Ed.,PGDCA., 

 

        Sastra Matriculation Higher Secondary School                          26 
 

 
  

        

56.  Which dialog box is used to select the option DDE link?

(a) Paste (b) Paste Data (c) Paste Link (d) Paste Special

57. Which of the following features is for displaying and browsing a selected list or subset of records from a table? 

(a) Searching (b) Sorting (c) Filtering (d) Merging

58. Which database represents different approach for the data? 

(a) Network database (b) Hierarchical database   (c) Object oriented database   (d) Relational database

59. Which option of form designing is similar to creating a query using AutoPilot option? 

(a) Default Filter (b) Remove Filter (c) AutoFilter (d) Auto Pilot
60. The language designed specifically for communicating with a database is 

(a) PASCAL (b) SQL (c) OQL (d) BASIC

61. Entering new record at the end of the table is referred as

(a) Inserting a record (b) Changing a record (c) Creating a record (d) Appending a record 

62. Multiple reports can be created and stored for

(a) A table (b) A query (c) A table or a query (d) A filter 

63.  Which of the following is displayed in the lower part of the Table Design window?

(a) Field Properties pane (b) File Properties pane (c) Field pane (d) Properties pane

64. The filter used to display only the records, which match the value of the current field is

(a) Limiting Filter (b) Default Filter (c) Auto Filter (d) Query Filter

65. Which database concept is used to assemble information from data? 

(a) Report (b) Table (c) DBMS (d) Query 

66. What are user- constructed statements? 

(a) Reports (b) Filters (c) Queries (d) Forms

67. Which data type can be integer, float, double precision, date, time, etc.,?

(a) User-defined (b) Non-numeric (c) Information (d) Numeric

68. Which of the following database structures were primarily used on Mainframe computers? 

(a) Relational (b) Flat-file (c) Hierarchical (d) Object Oriented

69. Which one of the following statements is incorrect?

(a) SQL is a structured query language (b) Collection of related fields is called a record 

(c) StarOffice Base is a Spreadsheet software (d) Merging is a process of joining data 

70. The option used to specify the maximum characters can be entered in a StarOffice Base field is

(a) Entry required (b) Format Example (c) Length (d) Default Value

71.  Character, Number or Boolean are

(a) User-defined data types     (b) Primitive data types    (c) Data types (d) Information

72. The field type that is not allowed by StarOffice Base is 

(a) Image (b) Project (c) Text (d) Binary Field

73. In StarOffice Base, Integer and Float data types are called as

(a) Primary data types (b) Primitive data types   (c) Secondary data types     (d) Computer data types

74. In database creation, which option of field property specifies the user should enter a value for that field?

(a) Entry Required (b) Default value (c) Format (d) Length 

 
www.Padasalai.Net                                                              www.TrbTnps.com

http://www.trbtnpsc.com/2018/02/latest-12th-study-materials-2018.html

www.Padasalai.Net



 
M.VIJAYA KUMAR, MCA.,M.Phil.,B.Ed.,PGDCA., 

 

        Sastra Matriculation Higher Secondary School                          27 
 

 

  

       

75. In StarOffice Base, field alignment is a part of

(a) Query design (b) Form design (c) Table design (d) Report design

76. The menu for creating a new table in Star Office Base is

(a) TabelTable Design (b) New TableTable Design

(c) InsertTable Design (d) New Table

77. Which of the following is a program, or collection of programs that allows any number of users to access data?

(a) Table (b) Query (c) Report (d) DBMS

78 Which one of the following are special views of the data in a table?

(a) Reports (b) Tables (c) Queries (d) Forms

79. How many steps are available in Query wizard window?

(a) 2 (b) 4 (c) 8 (d) 6

80. The common fields of two or more tables of relational database is called as

(a) Primary Key (b) Cell (c) Key (d) Row 

81. How many steps are available in Report wizard window? 

(a) 4 (b) 8 (c) 6 (d) 2

82. Which of the following is not a valid field type in Star Office Base?

(a) Memo (b) Picture (c) Image (d) Date

83. To update data automatically in a text document which is copied from a spreadsheet, the option used is

(a) DDE link (b) RTF (c) GDI metafile (d) HTML

84. To transfer heading together with its accompanying paragraphs to presentation, select

(a) FileSendAutoAbstract to Presentation (b) File SendOutline to Presentation

(c) FileSendAutoHeading to Presentation (d) File SendAutoformat to Presentation

85. While inserting a database table into a text document, the data should be inserted as 

(a) Text (b) Any of the other three choices    (c) Table (d) Fields

86. To insert the Spreadsheet Calc cell in StarOfficeWriter, select 

(a) EditPaste Special (b) EditPaste (c) FormatPaste (d) ToolsPaste Special 

87.  Which of the following is not a step in data processing?

(a) Validation (b) Verification (c) Collection (d) Computation
88. Which involves data collection, verification, validation and report generation? 

(a) Data processing (b) Table (c) Database (d) Data

89. In which Computers Hierarchical Database were used?

(a) Super (b) Micro (c) Mainframe (d) Mini

90. Queries are_________ statements.

(a) user-defined (b) predefined (c) structural (d) user-constructed

91. The key combination used to save the database table is 

(a) Ctrl + V (b) Ctrl + A (c) Ctrl + C (d) Ctrl + S 

92. Which of the following is not a step in data processing? 

(a) Computation (b) Validation (c) Collection (d) Verification

93. To sort the records in the ascending order, select the field and click on 

(a) Sort icon (b) Sort Ascending icon     (c) Ascending icon (d) Sort / Filter icon 
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94. Which icon is pressed to display the records in original order after sorting?

(a) Delete Sort/Filter (b) Exclude Filter/Sort (c) Remove Filter/Sorter (d) Delete Filter/Sort

95. The hierarchical database structures were primarily used for 

(a) micro computers (b) super computers (c) Mainframe computers (d) mini computers

96. A filter is also type of

(a) Form (b) Report (c) Query (d) Table

97. To copy the selected cell range in text document, which option in the paste special dialog box has to be selected? 

(a) Link (b) OLE link (c) DDE link (d) Paste

98. A set of processed data is called

(a) Procedure (b) Information (c) Database (d) Datum

99. In StarOffice Base, which of the following icons is used to display the records in the original order?

(a) Standard Filter icon (b) Remove Filter/Sort icon

(c) Auto Filter icon (d) Default Filter icon 

100. How many general categories are there in DBMS?

(a) 3 (b) 2 (c) 6 (d) 4

101. In Star Base which pane in the table design window is used to customize the field? 

(a) Page style (b) Format (c) Record properties (d) Field properties

102. Which of the following language is used to support DBMS?

(a) SQL (b) Star Writer (c) COBOL (d) Java 
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8. INTRODUCTION TO MULTIMEDIA 
1. Which of the following is a computer based presentation technique that incorporates text, sound, animations and

video elements? 

(a) Multimedia (b) Animation (c) Modeling (d) Compression

2. Which application allows us to send and receive messages over cell phones?

(a) MMS (b) CBT (c) MNS (d) MOS

3. The act of allowing the users to participate actively is called as 

(a) Interactive multimedia    (b) Active multimedia (c) Internal multimedia (d) Innovative multimedia

4. The conversion of analog sound waves to a digital format is called as 

(a) Sampling (b) Amplitude (c) Pitch (d) Crest

5. The technique used to blend two or more images to form a new image is

(a) Sampling (b) Morphing (c) Rendering (d) Warping

6. What are the processes used to create a 3-D animation?

(a) Animating (b) Rendering (c) Modeling (d) All the other three choices

7. In which technique, the recurring set of information is identified and replaced by a single piece of information? 

(a) Compression (b) Help (c) Vector Graphics (d) Virtual reality

8. MIDI stands for

(a) Musical Interface Digital Instrument (b) Modeling Instrument Digital Information

(c) Modeling Instrument Digital Interface (d) Musical Instrument Digital Interface 

9. MPEG stands for

(a) Movie Pictures Experts Group (b) Motion Pictures Experts Group 

(c) Moving Pictures Experts Group (d) Music Pictures Experts Group

10. Which 2-D animations are usually seen in computer games?

(a) Object-based animations (b) Procedure-based animations

(c) Attributes-based animations (d) Cel-based animations

11. How many frames per second causes the video to look jerky?

(a) <10 (b) <15 (c) <9 (d) <20

12. Which technique is used to distort a single image to represent something else?

(a) Rendering (b) Animating (c) Morphing (d) Warping

13 GIF stands for

(a) Graphic Interchange Format (b) Graphic Information Format

(c) Graphic Interconnection File (d) Graphical Interface Format

14. The two categories of image (or) video file compressions are

(a) Modeling and Animating (b) 2D and 3D 

(c) Morphing and Warping (d) Lossy and Lossless 

15. MMS means

(a) Microwave Media Service (b) Multimedia Messaging System
(c) Multimedia Media Service (d) Microwave Messaging Service 

16. Which special hardware card is used to improve the efficiency in the display of images on the screen? 

(a) Vector graphics (b) Static graphics (c) Dynamic graphics (d) Scalar graphics 
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17. JPEG may be expanded as

(a) Joint Physical Exports Group (b) Joint Physical Experts Group

(c) Joint Photographic Experts Group (d) Joint Photographic Expression Group 

18. How much of color depth results in the image looking murky? 

(a) <255 (b) <16 (c) <8 (d) <256
19. The sound editing program, which can be added to enhance the quality of converted sound waves are 

(a) Sound Merge (b) Sound Edit (c) Sound Forge (d) Sound Mix

20. What are the two types of animations?

(a) 1D or 3D (b) any dimensional (c) 2D or 3D (d) 1D or 2D

21. What are the categories of 2-D animations?

(a) Only Frame-based animations (b) Only Object-based animations 

(c) Cel-based animations and Object-based animations (d) Only Cel-based animations

22. Which of the following is widely used to add special effects to movies?

(a) Multimedia (b) Sound (c) Graphics (d) Text

23.  AIFF stands for 

(a) Audio Interchange File Format (b) Audio Information File Format 

(c) Audio Interchange File Form (d) Audio Internal File Format 

24. How many attributes control the characteristics of sound? 

(a) 2 (b) 4 (c) 1 (d) 3

25. Which of the following are examples of static images?

(a) Bitmap images (b) MPEG files (c) Photographs (d) Shockwave files 

26. The full form of HTTP is

(a) Hyper Text Transfer Process (b) Hyper Text Transport Protocol 

(c) Hyper Text Transmission Protocol (d) Hyper Text Transfer Protocol 

27. Which special software is used to view the multimedia presentations?

(a) Windows Music Player (b) Windows Movie Player 

(c) Windows Motion Player (d) Windows Media Player

28. The full form of HTML is

(a) Hyper Text Machine Language (b) Hyper Text Markup Language 

(c) Hyper Text Manipulation Language (d) Hyper Text Marking Language 

29. When sound or video is included as par t of a web page, then it is called as

(a) inbuilt sound (b) internal sound (c) built-in sound (d) inline sound
30. Which is a program that can be launched by the browser to "help" play sound or video? 

(a) Plug-out (b) Play-out (c) Plug-in (d) Play-in

31. Helper Application is also called as

(a) Play-in (b) Plug-in (c) Plug-out (d) Play-out

32. The extension for the video files stored in the MPEG file format is

(a) .mpg or .mpeg (b) .mpeg or .mpe (c) .mpg or .mpe (d) .mpig or .mpg 
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33 The full form of AVI is

(a) Audio Video Instruction (b) Audio Video Interleave 

(c) Audio Visual Instruction (d) Audio Visual Interleave 

34. Which of the following are frequently used to make computer games thrilling and realistic?

(a) High-end graphics (b) High-end graphics and Animations 

(c) Animations (d) Cartoon strips 

35. GIF is limited to

(a) 8 bit palette (b) 12 bit palette (c) 4 bit palette (d) 16 bit palette

36. Which animation consists of multiple drawing, each one a little different from the other?

(a) Cel-based animations (b) Frame-based animations 

(c) Object-based animations (d) Width-based animations

37. Sound files in the MIDI format have the extensions

(a) .mid or .midi (b) .md or .mi (c) .md or .mid (d) .midi or .md 

38. The popular web browsers are

(a) Windows Explorer (b) Both Netscape Navigator and Internet Explorer 

(c) Netscape Navigator (d) Internet Explorer 

39. The various multimedia components are coordinated with a technique called

(a) Vector graphics (b) Virtual Reality (c) Morphing (d) Warping

40. The two most common multimedia file formats are

(a) JPG and MPEG (b) GIF and JPG (c) GIF and MPEG (d) GIF and Animated GIF

41. The Real Audio formats have the extension 

(a) .rm or .rad (b) .ram or .rf (c) .rm or .ram (d) .rm or .rf

42. Which of the following file formats are developed by Apple?

(a) AU/SND (b) SND/AIFF (c) AIFF/MIDI (d) SND/MIDI

43. Which one of the following image files is an example for lossy format?

(a) WAVE (b) SND (c) JPEG (d) GIF

44. The shockwave format is used to store multimedia components created using 

(a) Netscape Navigator (b) Media Player (c) Flash (d) Internet Explorer

45. Which attributes are controlling the characteristics of sound? 

(a) Analog and digital (b) Amplitude and Frequency (c) Length and Breadth (d) Crest and Valley

46. The height of each crest in the analog wave pattern is called as 

(a) Time (b) Volume (c) Amplitude (d) Frequency

47. The distance between the crests of the analog wave pattern is called as

(a) Volume (b) Valley (c) Pitch (d) Amplitude

48. AIFF format was developed by 

(a) Real Networks (b) Apple (c) Microsoft (d) IBM 

49. Which is the most common version of e-learning packages?

(a) CBT/WBT (b) WBT/SBT (c) MMS/SMS (d) CBT/XBT 

50. Files in the AIFF format have the extension 

(a) .aiff or .aifi (b) .aif or .aiff (c) .aiff or .aff (d) .aif or .aifi 
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51. The sound format developed by Macromedia is

(a) QuickTime (b) Wave (c) AIFF d) Shockwave

52. Which sound format is more popular for transfer of data over the Internet?

(a) MIDI b) AIFF (c) AU (d) RealAudio

53. Which animations are referred to as slide or path animations, created by moving an object across a screen?
(a) Object-based animations (b) Frame-based animations 

(c) Cel-based animations (d) Width-based animations

54. Which of the following is the commercial multimedia content development software?

(a) All the other three choices (b) Flash (c) Maya (d) Dream Weaver 

55. In which industry, Multimedia is heavily used?

(a) Research (b) Education (c) Entertainment (d) Business

56. The extension name of files in QuickTime format is

(a) .qck (b) .mov (c) .qtf (d) .quk

57. The multimedia sound format developed by IBM and Microsoft was

(a) AIFF (b) WAVE (c) SND (d) AU

58. In which file, more complex techniques than GIF are applied to compress images, like photographs where the 
color of every pixel is different?

(a) MPEG (b) JPG (c) NxView (d) GIF

59. Which file format is being suited for simple graphic images with relatively few colors?

(a) NxView (b) MPEG (c) JPG (d) GIF

60. Which image format supports full color and produces relatively small size files?

(a) Animated GIF (b) MPEG (c) GIF (d) JPEG
61. Which compression algorithm takes advantage of the limitations of human visual senses? 

(a) Lossy (b) Vector graphics (c) Lossless (d) Lossless and Lossy

62. The extension name for Windows Media Format is

(a) .wam (b) .wmf (c) .wmv (d) .wma 

63. Which of the following multimedia formats is commonly used for transferring music information between 
electronic music devices?

(a) SND (b) WAVE (c) MIDI (d) AIFF

64. MIDI was developed in the year of

(a) 1992 (b) 1972 (c) 1962 (d) 1982

65. Which multimedia file format supports both Audio and Video? 

(a) AIFF (b) AU (c) RealAudio (d) MIDI

66. The inline sound can be added to a web page by using the HTML tag 

(a) <bgsound> or <img> (b) <sound> or <img>     (c) <bgsound> (d) <img>

67.  Helper applications can be launched using the HTML tag 

(a) <applet> (b) <object> (c)All the other three choice    (d)<embed>

68. Which of the following multimedia formats is used to store only sounds? 

(a) AVI (b) MPEG (c) MP3 (d) QuickTime

69. Which of the following multimedia formats was developed by Microsoft?

(a) All the other three choices  (b) WAVE (c) Windows Media (d) AVI 
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70. Multimedia incorporates features like

(a) Text (b) All of these three choices  (c) Sound (d) Video

71. Shockwave format was developed by 

(a) Apple (b) Microsoft (c) IBM (d) Macromedia

72. The compression that retains the exact image throughout the compression is called

(a) lossless compression (b) animating (c) lossy compression (d) rendering 

73. In which year AVI format sound files are developed?

(a) 1992 (b) 1985 (c) 1995 (d) 1991

74. The technique that provides an environment experienced by users as similar to reality is 

(a) Animations (b) Vector graphics (c) Virtual reality (d) Modeling

75. In which year was RealAudio format developed?

(a) 1995 (b) 1994 (c) 1982 (d) 1981

76. All digital cameras have the option to save images in

(a) Bitmap format (b) GIF format (c) WMF format (d) JPEG format

77. The AVI format was developed by

(a) Microsoft (b) Macromedia (c) IBM (d) Apple

78. Which of the following is not a multimedia element? 

(a) Text (b) Video (c) Database (d) Sound 
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9. PRESENTATION
1. Which key is used to create a new presentation using a template?

a) shift + Alt + N b) Shift + Ctrl + N c) ctrl + Alt + N d) Shift+ Tab

2. Which of the following view allows creating and editing slides?

a) Normal b) Outline c) Notes d) Handouts

3. Which command is used to insert a picture in a slide? 

a) Insert Picture b) Format Picture

c) Insert Picture From file d) Insert From  Picture

4. How will you change the background color of the entire slide?

a) Format  Background b) Format Page Background

c) Format  Page d) Insert Page Background

5. Which key combination is used to print slides in Star Office?

a) Alt + P b) Ctrl + P c) Shift + P d) Shift + Ctrl + P

6. Select ------------ Colors to apply the colors supported by browser

a) use HTML b) use HTTP c) Use browser d) use link

7. In presentation the view that allows us to view miniature image of the all slide is ____ 

a) Slide sorter b) Master page c) Notes view d) Layout

8. Which of the following is used to import objects from other application into a presentation?

a) Insert ODBC object b) Insert OLEDB object c) Insert OLE object d) Insert DBMS object
9. The shortcut key for opening style list is ……………..

a) F8 b) F7 c) F5 d) F11 

10. The star office application that allow to create attractive and professional looking presentation is 

a) Star office writer b) Star office calc c) Star office impress d) Star office base

11. In star office impress, the page used to specify basic background information that needs to be included in all the 
slides is

a) Slide Transition b) Custom Animation c) Master Page d) Layout
12. The number of option displayed in the first page of the presentation wizard is……..

a) 2 b) 3 c) 4 d) 5
13. Which of the following options display “Created with StarOffice” message during the pause between each 

presentation?

a) Automatic b) Effect c) Show Logo d) Default
14. The view used to reorder is …………….

a) normal b) outline c) notes d) handouts
15. To open media player window, choose …………

a) ToolsMedia player b) EditMedia player c) Insert Media player d) View Media player

16. Which is not a Background fill option?

a) Color b) Gradient c) Picture d) Hatching

17. In Star Office Impress, the windows allows to quickly jump from one slide to other slide or move between open
file is -----------.

a) Desktop b) Navigator c) Preview d) Moving slider 
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18. Which command that is used to create a new impress presentation is?

a) FileNewPresentation b) FileNewStar office Impress

c) FilePresentation d) FileNewStar office presentation

19. To insert a slide, choose

a) SlideInsert b) InsertSlide c) Format Slide Insert d) PresentationSlide 

20. Which one of the following displays various transition effects that can be attached to a slide?

a) Custom animation b) Slide transition c) Animation effects d) Slide sorter

21. Which button is pressed to start the slide show in Star Office Impress? 

a) F1 b) F3 c) F5 d) F7

22. To open media player window, choose

a) ToolsMedia Player b) Slide ShowMedia Player

c) Insert Media Player d) View Media Player

23. To rename a slide choose slide 

a) Rename slide b) new slide c) rename d) slide rename

24. Which is used for performing calculation s in presentation?

a) Insert formula b) Insert OLE object c) Insert Applet d) Insert Object

25. Which of the following views allows recording slides, editing slide titles and heading? 

a) Normal view b) Notes view c) Handouts view d) Outline view
26. Which of the following commands is used to open HTML export view? 

a) File Export b) HTML Export c) File HTML Export d) File  HTML Export

27. --- --------- - -is the Star Office application that allows us to create attractive presentations? 

a) Star Office Impress b) Star Office Writer c) Star Office Draw d) Star Office Calc
28. To change the slide order, in the switching presentation view tab click …………

a) Slide Sorter b) Layout c) Outline d) None of these

29. Which key is used to select multiple slides?

a) Ctrl b) Alt c) Shift d) Tab 

30. Which key combination is used to print slides in star office?

a) Alt + P b) Shift + P c) Ctrl + P d) Shift + Ctrl + P

31. A ------------ box on the right allows you to view a preview of the slide with the selected background.

a) preview b) print c) speed d) automatic

32. The --------- section in the lower half of the page allows you to specify the final output medium for presentation. 

a) Output medium b) slide c) select an output medium d) select a medium

33. The ------------ page of the wizard allows you to specify the transition effects to be used in presentation.

a) first b)second c)third d)fourth

34. The select a slide transition section at the -------- of the page allows you to choose the transition effect and speed in 
the slides.

a) bottom b) right top corner c) top d) left

35. To create a new presentation using a template, choose ------------

a) File New Presentation b) File New Template

c) File New Document d) File New Templates and documents 
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36. StarOffice Impress allows us to ------------ and modifies Microsoft Power point presentation.

a) import b) export c) report d) compile

37. StarOffice Impress Window contains ------------ Panes 

a) 2 b) 3 c) 4 d) 5

38. The task pane on the right displays ------------ pages

a) 2 b) 3 c) 4 d) 5

39. Which dialog box appears when Shift + Ctrl + N buttons are clicked from star office impress?

a) Academic presentation b) Templates c) Documents d) Templates and Documents
40. --- --------- view allows to reorder, edit slide titles, and headings.

a) Normal b) Notes c) Handout d) Outline

41. --- -------- view is used by a presenter to add additional information to a slide

a) Notes b) Handout c) Outline d) Layouts

42. We can choose a ------------ while creating a new slide.

a) Notes b) Layout c) Outline d) custom

43. --- ------- Menu is used to start a presentation.

a) View b) Tools c) Slide Show d) Window

44. The onscreen presentation starts automatically in the ------------ mode

a) Minimized b) full screen c) maximized d) normal

45. End the presentation by pressing the ---------- key

a) End b) Enter c) Esc d) Break

46. Select -------------- to run a custom slide show in the order that you defined.

a) Slide Show b) Custom Slide Show c) View Show d) any the above

47. The new slide uses the page layout of the ------------. Slide 

a) first b) previous c) last d) any of the above

48. To define the order in the slide show, click on ------------

a) slide show b) view show c) custom slide show d) outline

49. To insert movie in a slide, click on --------------

a) Insert  Picture Sound b) Insert Audio and Video

c) InsertMovie and Sound d) Insert Picture and Sound

50. To play a movie or sound file click play on the -----------Tool bar 

a) Movie b) Sound c) Media d) Media Playback 

51. For movie files, the bar contains a list box where we can select the ----------- for the playback.

a) volume slide b) zoom factor c) position slider d) any of the above

52. The media player supports ---------- different media formats 

a) 2 b) 3 c) 4 d) many
53. To insert an object in a slide, choose ------------

a) InsertObject b) Insert Chart c) Insert  OLE d) InsertFormula

54. Insert OLE object is used to import objects like --------------

a) Formula b) text c) Microsoft application objects    d) all the above 
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55. Click ------------ to get slide view

a) Insert  Toolbar Slide View b) Insert Slide View

c) View Slide Show d) View  Tool Bars Slide View
56. The objects in your slide can have ------------ effects

a) 2 b) 3 c) 4 d) many
57. A ----------- determines the text formatting style for title outline and the background for one or for all of slides.

a) slide b) master slide c) slide design d) slide background

58. The styles outline one through outline ----------- Enables you to give the outlined headings and topics on your 
slides a uniform look

a) 8 b) 9 c) 7 d) 6

59. Open stylist by choosing ----------- 

a) Format Styles and Formatting b) Format Styles 

c) Tools  Styles and Formatting d) Insert stylist
60. If you want a slide show always with current page, use ……………

a) Edit Options  StarOffice Impress

b) Tools  Options General

c) Slideshow Options  StarOffice Impress General

d) Tools  Options Staroffice Impress General
61. Choose ---------- to hide a slide in the slide show 

a) Tools  Show/Hide slide b) Insert Show/Hide Slide

c) Slide Show Show/Hide Slide d) any of the above

62. Open navigator by choosing ---------- menu

a) View b) Insert c) Edit d) Format

63. Which pane displays the slides in the presentation?

a) Middle b) Left c) Right d) Top

64. By pressing which key in the keyboard the view of the slide can be enlarged? 

a) F1 b) F3 c) F5 d) F11

65. Which of the following can preview movie and sound files in a presentation? 

a) Flash b) Media player c) Windows d) Plug-in

66. Which command is used to open a custom slide show? 

a) Slide ShowCustom Slide Show b) InsertCustom Slide Show 

c) Edit Custom Slide Show d) FormatCustom Slide Show 

67. Which key is used to save the presentation?

a) FileSave b) Save Icon c) Ctrl + S d) All of these

68. Which icon turns sound off and on in Media Playback Toolbar?

a) Play b) Mute c) Pause d) Volume Slider

69. Which of the following is used to import applets into the presentation?

a) Insert Applet b) Insert OLE Object c) Insert Formula d) InsertObject 
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70. The full form of PDF file is----------

a) Portable Document Format b) Personal Document Format

c) Portable Document File d) Personal Document File

71. Which option allows to manually control the transition of slides? 

a) Automatic b) Default c) Normal d) Show Logo

72. Which page allows to add or modify animation effects to elements of a slide?

a) Master page b) Layouts c) Custom Animation d) Slide Transition

73. Which command is used to reduce the size of a slide to be printed?

a) FormatPage b) FilePrint c) Format Character d) Fit object to paper format 

74. In which view all the side show effects can be assigned to the slide?

a) Normal b) Outline c) Notes d) Slide

75. Which of the following command settings override the default printer options?

a) FilePrint b) Tools Options StarOffice Impress 

c) Format Page d) Layout settings

76. Which key is used to select a range of slides?

a) Shift b) Ctrl c) Shift or Ctrl d) None of these

77. In which view mode, all the slide titles will appear in a list along with the headings and sub-topics? 

a) Normal b) Outline c) Notes d) All the above

78. Which option in presentation wizard allows to specify the duration for each side and will automatically flip
through the slides at the specified speed?

a) Default b) Automatic c) Duration of page d) Duration of pause

79. The key used to move the line one level up in styles and formatting window is

a) Tab b) Alt + Tab c) Shit + Tab d) Enter

80. Which option should be selected in Publication Type to create HTML pages without frames? 

a) Standard HTML format   b) Automatic c) WebCast d) None of these

81. The extension name of Star office Impress file is

a) .odt b) .ods c) .odp d) .odd

82. A presentation can be exported in ------------format

a) PDF b) SWF c) Web Page d) All of these

83. A presentation can be created using----------- 

a) Template b) Scratch c) a or b d) Star office writer

84. --- --------- allows you to display important sides during a presentation. 

a) Custom Slide Show b) Master Page c) Custom Animation d) Media Player

85. Which of the following view is the easiest way to assign slide transition effects to slides?

a) Normal b) Slide c) Handout d) Format

86. Which checkbox allows to display the message during the pause between each presentation? 

(a) Create logo (b) Paste Logo (c) Show Logo (d) Logo

87. How many tabs are there in the middle pane to view the presentation in different formats?

(a) 2 (b) 3 (c) 4 (d) 5

88. Which option is used to apply the colours to the HTML pages?

(a) Use presentation (b) Use Chart colors (c) Use browser colors (d) Use graph colors 
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VOLUME-II ONE MARKS 
OBJECT ORIENTED CONCEPTS USING C++1.

       

1. The two separate segments that were realized when viewing the solution of a problem are 
(a) Data and Program (b) Data and Object (c) Data and Operations (d) Data and Class

2. The ability of an object to respond differently to different messages is called
(a) Polymorphism (b) Inheritance (c) Encapsulation (d) Overloading

3. Which is a kind of self-sufficient ‚subprogramƒ with a specific functional area?

(a) Object (b) Class (c) Entity (d) Overloading
4. The process of creating new data types from existing data type is called as

(a) Polymorphism (b) Inheritance (c) Encapsulation (d) Overloading
5. Which of the following is a group of related functions and data that serves those functions?

(a) Abstraction (b) Data (c) Object (d) Class
6. Which is the mechanism that bounds data and functions together within an object definition? 

(a) Inheritance (b) Encapsulation (c) Abstraction (d) Polymorphism
7. The group of data and operations together are termed

(a) Program (b) Class (c) Object (d) Function
8. The act of revealing the essential features of an object while curtailing the access of data is called as

(a) Data Hiding (b) Inheritance (c) Polymorphism (d) Class
9. Data Hiding is also called as

(a) Deletion (b) Abstraction (c) Reduction (d) Hidden
10. Which of the following is a template for entities that have common behaviour?

(a) Class (b) Object (c) Attribute (d) State
11. Which of the following reduces the software complexity with multiple definitions?

(a) Inheritance (b) Polymorphism (c) Data Abstraction (d) Encapsulation 
12. Which of the following classes is power packed, as they include the functionality of the base class along with

their own unique features?
(a) New class (b) Parent class (c) Derived class (d) Super class

13. An example for Object Oriented Programming Language is 
(a) C++ (b) FORTRAN (c) C (d) BASIC

14. Which of the following is the key factor of Object Oriented programming language?
(a) Functions and Object behaviour (b) Objects and Classes 
(c) Data and Operations (d) Data and Objects 

15. Which of the following data types allow programs to organize as objects?
(a) Class (b) Polymorphism (c) Inheritance (d) Data Abstraction

16. C++ belongs to which category of programming language?
(a) Structured (b) Procedural (c) Modular (d) Object Oriented

17.  Which of the following provides security to data?
(a) Data hiding or Abstraction (b) Derived class or Base class
(c) Abstraction or Inheritance (d) Abstraction or Class 

18. In the early programming languages, the input and output data items were represented as:
(a) Variable (b) Constant (c) Expression (d) Function 

 
www.Padasalai.Net                                                              www.TrbTnps.com

http://www.trbtnpsc.com/2018/02/latest-12th-study-materials-2018.html

www.Padasalai.Net



 
M.VIJAYA KUMAR, MCA.,M.Phil.,B.Ed.,PGDCA., 

 

        Sastra Matriculation Higher Secondary School                          40 
 

 
  

        

2. OVERVIEW OF C++ 
1. C++ was developed by -------------- 

(a) James Gosling (b) Rick Mascitti (c) Bjarne Stroustrup (d) Dan Bricklin

2. The basic types of elements essential for programming coding are collectively called as

(a) Identifiers (b) Keywords (c) Tokens (d) Constants

3.  Which is the smallest individual unit in a program?

(a) Variable (b) Keyword (c) Tokens (d) Constant

4. Which are reserved words with special meaning to the language compiler?

(a) Tokens (b) Constants (c) Keywords (d) Identifiers

5.  Which are also called as variables?

(a) Statements (b) Constants (c) Identifiers (d) Tokens

6. The hexadecimal integer is a sequence of digits starting with

(a) 0x (b) hex (c) 0 (d) 16

7. Which of the following letters is used to represent the floating-point constant in exponent form? 

(a) F or e (b) F (c) E Only (d) E or e

8. Which constant contains a single character enclosed within single quotes?

(a) integer (b) string (c) floating point (d) character
9. Escape sequences are represented using characters prefixed with a 

(a) * (b) / (c) \ (d) |

10. Non-graphic character constants are represented using

(a) Statements (b) Escape sequences (c) Variables (d) Comments 

11. The full form of ASCII is ----------------

(a) American Standard Code for Information Interconnect

(b) American Standard Code for Interchange Information

(c) American Standard Code for Instruction Interchange

(d) American Standard Code for Information Interchange
12. Which is a sequence of characters surrounded by double quotes? 

(a) string (b) character (c) word (d) numbers

13. Which of the following is the simple assignment operator?

(a) += (b) == (c) != (d) =
14. How many classifications of operators are there in C++?

(a) 3 (b) 13 (c) 14 (d) 12

15. The combination of operands and operators is called as

(a) Identifier (b) Equation (c) Variable (d) Expression
16.  Which of the following operators is used to compare numeric values? 

(a) Logical (b) Relational (c) Arithmetic (d) Assignment

17. Which of the following operators is a logical operator?

(a) OR (b) All the other three choices   (c) NOT (d) AND 
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18. Which of the following are characters with a specific function?

(a) Operators (b) Identifiers (c) Punctuators (d) Constants

19.  Which of the following data types is used to declare a generic pointer?

(a) char (b) string (c) int (d) void

20. Which data type indicates the compiler that the function does not return a value?

(a) string (b) int (c) char (d) void

21. Which variable holds the memory address of other variables?

(a) Pointer (b) Static (c) Dynamic (d) Temporary 

22 Which of the following is user defined named entities of memory locations that can store data?

(a) Tokens (b) Constants (c) Keywords (d) Variables

23. Which qualifier specifies that the value of a variable will not change during the run time of a program?

(a) short (b) long (c) int (d) const

24. The operators used only by the preprocessor are -------

(a) ++ and - - (b) # and ## (c) && and || (d) > and <

25. Which operator returns the memory requirement size of the given expression or data type in terms of bytes?

(a) signed (b) struct (c) static (d) sizeof
26. Which refers to the process of changing the data type of the value stored in a variable? 

(a) Type cast (b) Conversion (c) Type modification (d) Data conversion

27. Which of the following punctuators is used to terminate a C++ statement?

(a) : (b) } (c) ] (d) ;

28. In C++, the single line comment should be preceded or prefixed

(a) \\ (b) /** */ (c) /* */ (d) //
29. In which year, C++ was developed?

(a) 1985 (b) 1990 (c) 1975 (d) 1980

30. A variable name must begin with -----------

(a) Alphabet or Underscore (b) Number (c) Alphabet (d) Underscore

31. Which is an invalid identifier?

(a) test12 (b) 1test (c) _test (d) test

32. The constant that should not have fractional part is called as a/an

(a) exponent (b) float (c) double (d) integer

33. The escape sequence used to produce bell sound is

(a) \t (b) \n (c) \b (d) \a
34. The end of a string literal is by default added with a special character

(a) \x (b) \\ (c) \0 (d) \a

35. Which is a scope access resolution operator in C++?

(a) :: (b) ?: (c) .* (d) -> *

36. Which is a ternary operator in C++?

(a) .* (b) :: (c) ?: (d) ->*

37. Which of the following operator requires two operands?

(a) Binary (b) Conditional (c) Ternary (d) Unary 
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38. Increment and decrement operators are called as

(a) Ternary (b) Unary (c) Arithmetic (d) Binary

39. Which of the following is an example for pre-increment operator?

(a) --a (b) ++a (c) a++ (d) a„

40. The conditional operator is

(a) -- (b) ?: (c) ?:; (d) ++

41. The punctuator used to enclose the block of comment statement is

(a) /* */ (b) // (c) [ ] (d) { }

42. Which data type helps in improving the credibility and readability of the program?

(a) Type defined (b) User defined (c) Built-in (d) Derived 

43. Which of the following user defined data types allow users to define a variable that would represent an existing 
data type?

(a) typedef (b) union (c) class (d) enumeration

44. The user defined data type helps users in creating a list of identifier called

(a) class (b) enumeration (c) union (d) typedef

45. Auto variables get undefined values known as

(a) Scalar (b) Register (c) Garbage (d) Datatype

46. The modifier that allows the variable to exist in the memory of the computer, even after losing its scope is 

(a) global (b) auto (c) static (d) extern

47. Which variables are global variables known to all functions in the current program? 

(a) register (b) auto (c) static (d) extern

48. Which of the following is the fundamental (or) built in (or) basic data types? 

(a) All the other three choices (b) Void (c) Float (d) Integral

49. Integral data type is classified into

(a) float and double (b) int and char (c) int and float (d) int and double

50. The address of the operator in a pointer data type is 

(a) $ (b) & (c) * (d) #

51. Which of the following is not a C++ keyword? 

(a) new (b) this (c) cont (d) if

52. Which of the following is not a C++ keyword? 

(a) signed (b) size of (c) static (d) struct
53. The ASCII value of the character ‘a’ is

(a) 97 (b) a (c) 90 (d) 65

54. How many fundamental data types are there in C++?

(a) 4 (b) 1 (c) 3 (d) 2

55. The enumeration integer constants are starting with the value of

(a) 0 (b) 2 (c) 1 (d) any one value 

56. The range of integer data type is

(a) -32768 to 32767 (b) -32767 to 32768 (c) -32678 to 32678 (d) -32768 to 32768 
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57. How many bytes does the unsigned int data type occupy?

(a) 2 (b) 1 (c) 3 (d) 4

58. Predict the output

#include < iostream.h>

void main( )

{

int i=25;

cout << i << i++ << ++i;

}

(a) 25 26 27 (b) 27 26 26 (c) 25 25 26 (d) 25 25 27

59. int a ,b, c;

a=6;

b=7;

c = ( a++) - (--b) ;

cout << c;

The output of the above code, when it is executed is

(a) error (b) 9 (c) 0 (d) 11

60. Evaluate the expression a+=b* c where a =5, b=6, c=7. 

(a) 37 (b) 77 (c) 42 (d) 47

61. The statement int A; b; is invalid because 

(a) Capital A is not allowed

(b) Only one variable should be given

(c) Variables should be separated by comma

(d) All the other three choices

62.   int i =6;

unsigned int j =10;

cout << sizeof (i *j) ;

The output when the above code is executed is

(a) 4 (b) 2 (c) 8 (d) error

63. If a=5 and b=4, the value of the expression a+b/2* 6 is

(a) 18 (b) 16 (c) 15 (d) 17

64. Which brace is used to enclose the body of the C++ program? 

(a) () (b) {} (c) [] (d) <>

65 Which of the following defines a Local variable?

(a) Auto (b) Static (c) Register (d) Extern

66. Based on operand requirements, operators are classified as --------- type. 

(a) 4 (b) 5 (c) 3 (d) 2

67. The storage specifiers that instruct the compiler to store the variable in the CPU register to optimise access

(a) static (b) auto (c) register (d) extern 

 
www.Padasalai.Net                                                              www.TrbTnps.com

http://www.trbtnpsc.com/2018/02/latest-12th-study-materials-2018.html

www.Padasalai.Net



 
M.VIJAYA KUMAR, MCA.,M.Phil.,B.Ed.,PGDCA., 

 

        Sastra Matriculation Higher Secondary School                          44 
 

 
  

        

68. What is the maximum range of unsigned integer data type?

(a) 255 (b) 65535 (c) 3.4e+10 (d) 32768 

69. By default, the local variable is 

(a) Extern (b) Static (c) Register (d) Auto

70. Which variables are automatically initialized to zero when they are declared? 

(a) Static and Extern (b) Static and Register (c) Auto and Static (d) Register and Extern

71. Which of the following is the invalid variable declaration?

(a) int a,b; (b) int a; b; (c) int a; int b; (d) int a; float b;
72.  Ternary operators require how many operands?

(a) Two (b) One (c) Four (d) Three

73. Relational operators have lower precedence than

(a) Boolean operators (b) Relational operators (c) Logical operators (d) Arithmetic operators

74. What is the value assigned to x?

float x;

int a =7, b=3;

x= a/(float)b;

(a) Error (b) 3.0 (c) 2.0 (d) 2.33

75. Find the output:

#include <iostream.h>

#include <conio.h>

void main( )

{

int n1=10, *n2;

n2=&n1;

n2++;

cout << n1;

}

(a) 12 (b) 10 (c) 13 (d) 11

76. Which of the following modifiers increases the bytes for a particular data type?

(a) Signed (b) Long (c) Short (d) Unsigned

77.  Which of the following operators is also called conditional operator? 

(a) Binary (b) Unary (c) Relational (d) Ternary
78. 0.5864E1 represents

(a) 5.864 (b) 0.05864 (c) 58.64 (d) 0.5864

79. The modifier that allows the variable to exist in the memory even after losing its scope is:

(a) static (b) extern (c) auto (d) register

80. Which of the following is not a qualifier in C++?

(a) unsigned (b) signed (c) long (d) class 
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3. BASIC STATEMENT
1.  Which is a predefined object that corresponds to a standard input stream? 

(a) cin (b) cout (c) cinput (d) coutput

2.  Data is read from the keyboard during runtime by using the object

(a) c++in (b) cin (c) c++out (d) cout

3. In C++, which file comprises the combined properties of istream and ostream?

(a) iostream.h (b) stdio.h (c) string.h (d) conio.h

4. A preprocessor directive starts with the symbol

(a) \ (b) # (c) % (d) $

5. The operator >> is called as ------------ 

(a) Stream operator (b) Abstraction operator (c) Insertion operator (d) Extraction operator
6. The extraction operator is also called as

(a) Get from (b) Get to (c) Put to (d) Put from

7. Which of the following operators is called as insertion operator or put to operator? 

(a) >> (b) > (c) < (d) <<

8. How many sections are there in C++ program?

(a) 5 (b) 2 (c) 3 (d) 4

9. Which of the following functions will be executed automatically when a C++ program is executed?

(a) call by reference (b) main (c) recursive (d) void

10. The program statements that cause a jump of control from one part of a program to another are called as

(a) Assignment (b) Control Structures (c) Loop (d) Declaration

11.  How many major categories of control structures are there in C++?

(a) 5 (b) 2 (c) 3 (d) 4

12. Which is the simplest of all the decision statements? 

(a) nested if (b) switch (c) Simple if (d) if † else

13. Which of the following execute a set of instructions repeatedly for a certain number of times? 

(a) Loops (b) Selections (c) Statements (d) Operators

14. How many kinds of loops are there in C++?

(a) 3 (b) 4 (c) 2 (d) 1

15. Which loop is called as exit-check loop?

(a) while (b) do-while (c) do loop (d) for

16. Which of the following is an entry-check loop? 

(a) while (b) switch (c) if (d) do-while

17. Which loop is called as an entry controlled loop?

(a) while (b) do loop (c) do-while (d) for

18. Which of the following statements forces the next iteration of the loop to take place by skipping the remaining 
code?

(a) break (b) end (c) continue (d) begin 
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19. Which of the following statements accomplishes jump from the current loop?

(a) Break (b) Switch (c) While (d) Continue

20. A program written in high level language is called as

(a) Executable code (b) User code (c) Object file (d) Source code

21. The machine-readable form of a program is called as --------------- 

(a) User code (b) Computer code (c) Object file (d) Source code 

22. Which translator programs create a machine-readable program from the source code ?

(a) Assembler (b) Interpreter (c) Converter (d) Compiler
23. Which operator extracts data from the input stream object and places the value in the variable to its right? 

(a) Extraction (b) Abstraction (c) Stream (d) Insertion

24. Which operator directs the contents of the variable to its right to the object to its left?

(a) Abstraction (b) Extraction (c) Stream (d) Insertion

25. Which of the following variables get defined only when memory is fetched to store data?

(a) Function (b) Global (c) Local (d) Pointer

26. Which of the following statements chooses between two alternatives? 

(a) switch (b) nested if (c) Simple if (d) if...else
27. Which decision statement creates branches for multiple alternatives sections of code, depending on the value of a 

single variable?

(a) switch (b) if...else (c) while (d) for

28. Every action block of switch statement should be terminated using

(a) break (b) continue (c) stop (d) return

29. Based on the position of the condition, how many classifications of loops are there in C++? 

(a) 3 (b) 2 (c) 4 (d) 1

30. In which loop, condition marks the last statement of the body of the loop?

(a) while (b) for (c) switch (d) do-while
31. In for loop, which segment is evaluated before the commencement of every iteration?

(a) Increment (b) Any one of the choices   (c) Test condition (d) Initialization

32. Nested if statement can be replaced by the statement of 

(a) for (b) do-while (c) select case (d) switch case

33. An outer loop and an inner loop having the same control variable leads to 

(a) Syntax error (b) Software error (c) Semantic error (d) Logical error

34. Which C++ file comprises of all standard declarations and definitions for predefined functions? 

(a) Footer (b) Pointer (c) Program (d) Header

35. How many times the following loop will be executed? for(i=1;i<6;i++) 

(a) 5 (b) 7 (c) 6 (d) 1

36. The break statement would exit only the

(a) Current function (b) Current program (c) None of these three choices     (d) Current loop 

37. The declarations for the object cin are available under the header file 

(a) inputstream.h (b) stream.h (c) stdstream.h (d) istream.h 
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38. The statement which is used to exit from switch statement is

(a) exit (b) break (c) default (d) quit

39. Statement used in C++ to display messages and result is 

(a) cin (b) print (c) printin (d) cout 

40. Basic statements in C++ are constructed using

(a) operators (b) tokens (c) constants (d) variables

41. Read the following C++ program:

#include < iostream.h>

void main()

{

int num=2;

do

{

cout << num*num <<'\t';

num +=1;

}

while (num<6);

}

Name the control variable used in the program. 

(a) \t (b) num (c) None of these three choices          (d) +=1 

42. What is the test expression (condition) used?

(a) num (b) num * num (c) None of these three choices       (d) (num<6) 

43. How many times will the loop be executed?

(a) 4 (b) 5 (c) 3 (d) 6

44. What is the output of the following program?

(a) 4 9 16 25 (b) 0 4 9 25 (c) 2 4 9 16 25 (d) 6 4 6 8

45. The break statement would exit only the

(a) Current loop (b) Current program (c) Current function  (d) None of these three choices

46. How many times will the following loop be executed? for(i =1; i<30; i++)

(a) 1 (b) 31 (c) 29 (d) 30

47. Which creates object files from source code?

(a) Program (b) C++ (c) Compiler (d) Computer

48. What is the error thrown by the compiler for the following snippet? 

if(a>b);

cout <<"Greater";

e lse

cout <<"Lesse r";

(a) Misplaced if ...... else (b) Misplaced if (c) Misplaced else (d) Misplaced else..... if

49. Which statement is used to skip a part of loop and start the next cycle of loop? 

(a) Continue (b) Stop (c) Skip (d) Break 
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50. for(i =1;i<=10;i++) How many times is this loop executed?

(a) Ten times (b) Nine times (c) Not executed (d) Only one

51. Which is linked with libraries to create an executable file? 

(a) Object code (b) Compiler (c) Programs (d) Source code

52. The declaration for the object cin is available in a header file called

(a) string.h (b) istream.h (c) conio.h (d) stdio.h

53. The appropriate declaration statement to initialize the variable 'name ' with the value 'Abdul Kalam' is 

(a) char name[]= "Abdul Kalam"; (b) char name= "Abdul Kalam"; 

(c) char[] name= "Abdul Kalam"; (d) char []name= "Abdul Kalam";

54. Which of the following is an assignment operator? 

(a) << (b) = (c) + (d) ==

55. While <( condition)> {...} loop is called as

(a) exit-check loop (b) nested loop (c) entry-check loop (d) multi-check loop

56. Which command desires to terminate the loop irrespective of the test expression in C++?

(a) break (b) continue (c) while (d) exit

57. How many times the given loop will be executed? for(int i = 0; i < 6; i++) 

(a) 1 (b) 5 (c) 6 (d) 0

Read the following C++ program and answer the questions from 58 to 61.

#include<istream.h>

#include<conio.h>

void main( )

{

int num = 2;

do

{
cout<<num*num< ‘\t’;

num +=1;

}

while(num<6);

getch( );

}

58. What is the output of the program?

(a) 0 4   9   25 (b) 4   9   16  25 (c) 2 4   9   16   25 (d) 2  4   6 8

59. How many times the loop will be executed?

(a) 4 (b) 5 (c) 6 (d) 7

60. What is the test expression in the program?

(a) num = 2 (b) num += 1 (c) num * num (d) num < 6

61. What is the control variable used in the program?

(a) int (b) do (c) num (d) …\t- 
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62. What is the output for the given snippet?

int a = 1;

for(; a< 5; a++)

{
cout<<a<< ‘\t’;

}

(a) 1234 (b) 4321 (c) 1111 (d) 4444 
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4. FUNCTIONS C++ ENHANCEMENTS
1. The building blocks of C++ programs are

(a) Functions (b) Arrays (c) Classes (d) Statements

2. Which of the following statements marks the end of the function and also transfers control to the statement after
call statement?

(a) return (b) continue (c) main (d) break

3. Which induce the reusability of the code?

(a) Variables (b) Functions (c) Keywords (d) Instructions

4. A function can be called or invoked from another function by using its 

(a) Parameters (b) Name (c) Reference (d) All the other three choices 

5. Which of the following can be shared by other programs by compiling and loading them together?

(a) Function (b) Variable (c) Statement (d) Token

6. Parameters are separated or delimited by

(a) scope resolution operator (b) period (c) commas (d) semicolon

7. Which communicates with the function through arguments or parameters?

(a) data type (b) call statement (c) name (d) variable 

8. What are channels through which data flows from the call statement to the function? 

(a) Parameters (b) Function names (c) Operators (d) Data types

9.  In how many ways functions that have arguments can be invoked? 

(a) 3 (b) 2 (c) 1 (d) 4

10. The parameters associated with function header is called as

(a) Function (b) Formal parameters (c) Actual parameters (d) Arguments

11. The function that returns no value is declared

(a) void (b) float (c) int (d) default

12. Which of the following refers to the accessibility of a variable?

(a) void (b) storage class (c) Scope (d) inline

13. How many types of scopes are there in C++?

(a) 3 (b) 1 (c) 2 (d) 4

14. Which operator reveals the hidden scope of a variable? 

(a) Scope (b) Relational (c) Assignment (d) Binary

15. Which of the following act as place holders in function prototype? 

(a) Statements (b) Constants (c) Variables (d) Keywords

16. The calling function parameters are called as

(a) duplicate parameters (b) actual parameters (c) dummy parameters (d) formal parameters

17.  Which of the following reduce the size of the program?

(a) Variables (b) Functions (c) Arrays (d) Classes

18. In which method, any change made in the formal parameter is not reflected back to the actual parameters?

(a) void (b) inline (c) call by value (d) call by reference

19. Which functions execute faster but require more memory space?

(a) regular (b) normal (c) void (d) inline 
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20. The return type of the function prototype float power (float, int) is

(a) double (b) float (c) char (d) int

21. Which of the following keywords is just a request to the compiler?

(a) inline (b) extern (c) auto (d) register
22. Which scope variable’s life time is the life time of a program?

(a) Function (b) Local (c) File (d) Class

23. In which method, any change made in the formal parameter is reflected back in the actual parameter?

(a) call by reference (b) inline (c) call by value (d) void
24. Which looks like a normal function in the source file but inserts the function’s code directly into the calling

program?

(a) inline (b) main (c) scope (d) void

25. Which variables die when its block execution is completed?

(a) Function (b) Local (c) File (d) Class

26. Which scope is valid within block and all sub-blocks of function?

(a) Function (b) Class (c) File (d) Local

27. Which operator is used to distinguish local and file scope variables having the same name? 

(a) Relational (b) Binary (c) Assignment (d) Scope

28. The default return data type of a function, if no data type is explicitly mentioned is

(a) double (b) char (c) int (d) float

29.  Which of the following is NOT true, related to functions ?

(a) The default value in the formal parameters can be given in the form of variable initialization

(b) The default value for an argument can be given in between the argument list 
(c) The actual parameters can be passed in the form of constants to the formal parameters of value type

(d) The actual parameters can be passed only as variables to formal parameters of reference type
30. In the following code, the scope of the variable 'a' is

if (x < y)

{

int a;

a++;

}

(a) File scope (b) Function scope (c) Class scope (d) Local scope

31. The scope of any variable used in the entire program is

(a) Class (b) Function (c) File (d) Local

32. The variable declared above all blocks and functions is called as

(a) Class Scope (b) File Scope (c) Local Scope (d) Function Scope

33. Which scope is not known outside their own code block?

(a) Class (b) Local (c) Function (d) File

34. Which is used to help the compiler to check the data requirements of the function?

(a) Function prototype (b) Function calling (c) Function Definition (d) Header files

35. In which method, the called function creates new variables to store the value of the arguments passed to it? 

(a) Formal parameter (b) Call by value (c) Call by reference (d) Actual parameter 
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36. In C++, what can be assigned to the formal parameters of a function prototype? 

(a) Values (b) Program (c) Default values (d) Default arguments

37. Parameters that are associated with function call statement are

(a) global parameters (b) local parameters (c) formal parameters (d) actual parameters

38. The prototype of the over loaded member function must differ

(a) both by the number of its arguments and their data types

(b) both by the number of its formal parameters and their data types

(c) either by the number of its arguments or their data types

(d) either by the number of its formal parameters or their data types
39. Which of the following is used to separate a set of actual parameter function? 

(a) & (b) ;(semi-colon) (c) .(dot) (d) ,(comma)
40. The return type of the function prototype fact( float, char, double ); is 

(a) flaot (b) double (c) int (d) char

41.  Which of the following is called scope resolution operator?

(a) ?: (b) :: (c) & (d) *

42. The return type of the function prototype add(int, int); is: 

(a) float (b) int (c) void (d) char 
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5. STRUCTURED DATA TYPE ARRAY
1. Which of the following is a derived data type that can hold several values of the same type in C++?

(a) Function (b) Pointer (c) Array (d) Reference

2. The collection of variables of the same type that are referenced by a common name is

(a) Structure (b) Function (c) Pointer (d) Array

3. The size of the array should always be

(a) Positive (b) Negative (c) Float (d) Double

4. How many types of arrays are there in C++?

(a) 5 (b) 3 (c) 2 (d) 4

5. The process of arranging the data in an order in a given array is called

(a) Sorting (b) Filtering (c) Merging (d) Searching

6. Which are treated as single dimensional array of characters?

(a) Literals (b) Integers (c) Floats (d) Characters

7. A character array should be terminated with a symbol

(a) /0 (b) \x (c) 0 (d) \0

8. Which is the member function of standard input stream?

(a) puts( ) (b) gets( ) (c) read( ) (d) getline( )
9 .Which is the member function of standard output stream?

(a) write( ) (b) cin (c) getline( ) (d) gets( )

10. How many parameters are required for write ( ) function?

(a) 3 (b) 2 (c) 5 (d) 4

11. In which header file, string manipulators are defined?

(a) string.h (b) ctype.h (c) conio.h (d) iostream.h

12. Which string function copies source string to target string?

(a) strlen( ) (b) strcmp( ) (c) strcopy( ) (d) strcpy( )

13. Which string function returns the number of characters stored in an array?

(a) strcmp( ) (b) strlen( ) (c) strlength( ) (d) strcpy( )

14. Which array is stored in sequential memory blocks?

(a) 1-D (b) 4-D (c) 3-D (d) 2-D

15. In which type of arrays, matrices can be represented? 

(a) 1D-arrays (b) 2D-arrays (c) 4D-arrays (d) 3D-arrays

16. An array of strings is a character array of the type

(a) 4-D (b) 3-D (c) 2-D (d) 1-D

17. Which array is an array in which each element is itself an array?

(a) 1-D (b) Literal (c) 2-D (d) String

18. The array subscripts always commences from

(a) 0 (b) any one number (c) 1 (d) 2

19. The memory required for the integer array num_array[5]; is

(a) 5 bytes (b) 4 bytes (c) 10 bytes (d) 15 bytes 
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20. The second index of the 2-D array refers to

(a) Column (b) Length (c) Size (d) Row 

21 An integer array with indexes from 0 t o 4, all having value 1 may be declared and initialized as

(a) int x[4] = {1}; (b) int x[4] = {1,1,1,1}; (c) int x[ ] = { }; (d) int x[5] = {1,1,1,1,1};

22. To treat spaces as part of string literal, one has to use

(a) getline( ) (b) gets( ) (c) gets( ) or getline( ) (d) puts( )

23 Which member function treats white space or carriage return as terminator for string?

(a) getline( ) (b) gets( ) (c) cin (d) cout

24. The function strcpy(s1, s2)

(a) Appends s2 to end of s1 (b) Copies s1 to s2

(c) Appends s1 to end of s2 (d) Copies s2 to s1 
25. What will be output of the following snippet?

char s1[ 3]=”exam”; 

char s2[ 3]=”exam”; 

strcmp(s1,s2);

(a) 0 (b) >0 (c) error (d) <0

26 What will be the size of the array float num[4] [6];?

(a) 10 bytes (b) 96 bytes (c) 48 bytes (d) 24 bytes

27 How many number of elements can be stored in the array int sales[2][4]; ?

(a) 7 (b) 6 (c) 8 (d) 16

28. Deter mine the number of elements in the following array declaration int array[10][12];

(a) 480 (b) 240 (c) 120 (d) 22

29. Determine the number of elements in the following array declaration int x[ ][2]={0,1,1,2,2,3};

(a) 2 (b) can't determine (c) 6 (d) 3

30. short fine [ 'A']['E']; declares a two dimensional array with number of rows and columns of

(a) 26, 30 (b) 65, 69 (c) 1,5 (d) 97, 101

31. Arrays in C++ belong to which of the following data type?

(a) Primitive (b) Derived (c) Basic (d) User defined

32. In a 2-D array, the first sub-script stands for

(a) column (b) diagonal (c) object (d) row

33. Which of the following is a 2-dimensional character array?

(a) Array of strings (b) Literals (c) Matrix (d) Strings

34. Which of the following is an invalid array declaration?

(a) int array[]; (b) const int i=10; int array[i]; 

(c) Both int array[]; and int array[i]; (d) int array[i];

35. Which of the following functions compares the two given strings?

(a) cmpstr() (b) strcpy() (c) cpystr() (d) strcmp() 

36. Strings are otherwise called as

(a) characters (b) literals (c) names (d) constants 

 
www.Padasalai.Net                                                              www.TrbTnps.com

http://www.trbtnpsc.com/2018/02/latest-12th-study-materials-2018.html

www.Padasalai.Net



 
M.VIJAYA KUMAR, MCA.,M.Phil.,B.Ed.,PGDCA., 

 

        Sastra Matriculation Higher Secondary School                          55 
 

 
  

         

37. write() is a member function

(a) All of these three choices (b) string.h  (c) istream.h     (d) ostream.h

38.  Memory allotted for int num[2][4]; is

(a) 16 bytes (b) 10 bytes (c) 120 bytes (d) 60 bytes

39. Array parameter by default behaves like which parameter?

(a) Reference (b) Variable (c) Constant (d) Value

40. In the array, int sales[2][4]; the first row and second column is

(a) sales[1][2] (b) sales[2][1] (c) sales[0][1] (d) sales[1][0]

41. What is the size of the array in num[3][4];?

(a) 24 bytes (b) 12 bytes (c) 48 bytes (d) 14 bytes

42. gets( ) function is defined under which header files?

(a) stdlib.h (b) stdio.h (c) conio.h (d) ostream.h 

 
www.Padasalai.Net                                                              www.TrbTnps.com

http://www.trbtnpsc.com/2018/02/latest-12th-study-materials-2018.html

www.Padasalai.Net



 
M.VIJAYA KUMAR, MCA.,M.Phil.,B.Ed.,PGDCA., 

 

        Sastra Matriculation Higher Secondary School                          56 
 

 
  

        

6. CLASSES AND OBJECTS 
1. Which is a new way of creating and implementing a user defined data type?

(a) Polymorphism (b) Class (c) Encapsulation (d) Inheritance

2. Which provides a new method for packing together data of different types?

(a) Inheritance (b) Encapsulation (c) Polymorphism (d) Class

3. Which is a way to bind the data and its associated functions together?

(a) Encapsulation (b) Inheritance (c) Class (d) Polymorphism

4. How many parts are there in a class specification?

(a) 4 (b) 3 (c) 5 (d) 2

5. The body of a class is enclosed within a

(a) [ ] (b) < > (c) { } (d) ( )

6.  Every class declaration is terminated by

(a) :: (double colon) (b) ; (semicolon) (c) . (dot) (d) , (comma)

7. How many access specifiers are there in a class?

(a) 4 (b) 5 (c) 3 (d) 2

8. The class body contains the declaration of

(a) Variables and Functions (b) Variables and Arrays 

(c) Pointers and Functions (d) Functions and Arrays 

9. Which of the following class visibility label is optional?

(a) public (b) all the other three choices (c) protected (d) private 
10. Which members can be accessed only from within the class?

(a) protected (b) global (c) public (d) private 

11. Which members can be accessed from within the class and the members of the inherited classes?

(a) public (b) global (c) protected (d) private

12. Which members can be accessed from outside the class also? 

(a) protected (b) global (c) public (d) private

13. The binding of data and functions together into a single entity is referred to as

(a) Data Hiding (b) Abstraction (c) Inheritance (d) Encapsulation

14. Data abstraction in C++ is achieved through

(a) Polymorphism (b) Inheritance (c) Data Hiding (d) Encapsulation 

15. Which of the following is achieved through data hiding?

(a) Class Members (b) Class (c) Data Abstraction (d) Polymorphism

16. Class comprises of

(a) Members (b) Data types (c) Pointers (d) Arrays

17. Which of the following are data variables that represent the features or properties of a class? 

(a) Data members (b) Structures (c) Arrays (d) Member functions

18 Which access specifier is used to access friend functions?

(a) private (b) protected (c) class (d) public 
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19. How many classifications of members are there?

(a) 2 (b) 3 (c) 4 (d) 5

20. What are the special member functions of classes?

(a) Constructors and Destructors (b) Constructors and Methods

(c) Constructors and Attributes (d) Constructors and Abstractors 

21. In how many ways, the methods of a class can be defined?

(a) 2 (b) 5 (c) 3 (d) 4

22. A member function can call another member function directly is called as

(a) Friend functions (b) Inline functions (c) Nesting of member functions (d) Recursive functions

23. The variable that is initialized only when the first object of its class created is

(a) static (b) private (c) protected (d) public 

24. The static member variable is initialized to

(a) true (b) 0 (c) 1 (d) false

25. Which is the default access specifier?

(a) private (b) static (c) public (d) protected

26. A class which contains more than one object is called as

(a) Nested objects (b) Linked objects (c) Arrays of objects (d) Multi objects

27. Initially C++ was called as 'C with Classes' by

(a) ken Thompson (b) James Gosling (c) Bjarne Stroustrup (d) Charles Babbage

28. In the class, by default the members will be treated as.

(a) public (b) global (c) private (d) protected

29. The members and functions declared under private are not accessible by members outside the class is referred as

(a) Inheritance (b) Data hiding (c) Polymorphism (d) Encapsulation 

30. Instruments allowing only selected access of components to object and to members of other classes is called as

(a) Data Hiding (b) Encapsulation (c) Polymorphism (d) Data Abstraction
31. In C++, the member functions are called as

(a) Methods (b) Attributes (c) Operators (d) Operands 

32. In C++, Data members are called as

(a) Member functions (b) Attributes (c) Pointers (d) Methods

33. In C++, the class variables are known as

(a) Constants (b) Functions (c) Methods (d) Objects

34. The members of a class are accessed using the operator

(a) :: (double colon (b) : (colon) (c) , (comma) (d) . (dot)

35. The private data of a class can be accessed only through the member functions of its own class and certain special 
functions are called as ------------functions.

(a) recursive (b) inline (c) friend (d) nested

36. The members defined within the class behave

(a) inline functions (b) arrays (c) user defined functions (d) structures 

37. The memory space required for the float member variable

(a) 8 bytes (b) 1 byte (c) 4 bytes (d) 2 bytes 
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38. Which member variable’s initial value is done outside the class?

(a) auto (b) static (c) extern (d) register

39. Which data members are not related to any specific object of the class but are shared by all the objects of the
class? 

(a) public (b) private (c) protected (d) static
40. Which of the following is not a valid class access specifier?

(a) protected (b) private (c) pointer (d) public 

41. Which is the key feature of OOPS?

(a) Abstraction (b) Encapsulation (c) Data hiding (d) Data cancelling

42. The function associated with the class data type is called

(a) Arrays (b) Methods (c) Pointers (d) User defined data types
43. Which of the following statements is NOT true ?

(a) The return type of a member function cannot be of object data type
(b) A non-member function cannot access the private data of a class 

(c) Several different classes can use the same function name

(d) Member functions can be of static type

44. Which of the following is the parts of a class specification?

(a) Arrays and Functions (b) Pointers and Arrays 

(c) Datatypes and Pointers (d) Class declaration and Class function definitions

45.

class product

{

int c, q;

float p;

} p1;

The number of bytes occupied by p1 is

(a) 7 (b) 9 (c) 8 (d) 10

46. The member function declared under ------------ scope can be accessed by the objects of that class.

(a) protected (b) public (c) private (d) global 

47. The variable shared by all the objects of a class, it behaves like

(a) Static (b) Private (c) Extern (d) Auto

48. Which of the following is the most important feature of C++?

(a) Function (b) Array (c) Class (d) Pointer

49. Which is used to create user defined data type?

(a) Derived class (b) Base class (c) Data hiding (d) Class
50. How many copy(copies ) of the member variable is (are) created if it is static memory?

(a) Two (b) Three (c) One (d) Four 
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51.

class product

{

int a,b;

float P;

public:

void assign_data();

void display( );

};

void main( )

{

product P1, P2;

}

The number of memory bytes allotted for the variable P1 is

(a) 8 (b) 12 (c) 4 (d) 10

52. Class name is also called as

(a) function (b) method (c) member (d) tag

53. Which of the following class access specifiers is optional?

(a) Private (b) Protected (c) Public (d) Class

54. How many copy of the member variable is created if it is static memory?

(a) 1 (b) 2 (c) 4 (d) 3

55. Which of the following is true?

(a) Member function cannot be defined outside the class

(b) A class cannot have more than three member functions

(c) Member functions must all have same name

(d) Member function can be defined outside the class also
56. When objects are created, no separate space is allotted

(a) member functions (b) static member (c) data member (d) objects

57.

class example

{

int x,y, z;

float m,n;

}p[5] ;

In the above snippet how many objects are created?

(a) 5 (b) 4 (c) 3 (d) 1 
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58.

#include <iostream.h>

#include <conio.h>

class item

{

int code, quantity;

float price ;

void getdata( )

{

cout<< "\n Enter code , quantity and price :";

cin>> code>> quantity>>price ; 

}

protected:

void compute ( )

{

if( quantity>100)

tax=2500;

else

tax=1000;

}

public :

float tax;

void putdata( )

{

cout<< "\n Code :"<< code ;

cout<< "\n Quantity:" << quantity;

cout<< "\n Price :" << price ;

cout<< "\n Tax:"<< tax;

}

};

void main()

{

item i;

}

Memory allocation for instance "i" is

(a) 8 bytes (b) 12 bytes (c) 10 bytes (d) 16 bytes

59. public data member in the above class definition is

(a) code (b) price (c) tax (d) quantity

60. Method that can be accessed by object "i" is

(a) putdata() (b) getdata() (c) compute() (d) quantity() 
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61. class student

{

int x, y;

}a, b;

The above segment of coding a, b are:

(a) Object of class student (b) Super class of student

(c) Subclass of student (d) Classes 

62. Member function can be of which type?

(a) Class (b) Static (c) Variable (d) Destructor 
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7. POLYMORPHISM 
1. In C++, polymorphism is achieved through

(a) Inheritance (b) Encapsulation (c) Data hiding (d) Overloading

2. In how many ways polymorphism is achieved in C++?

(a) 3 (b) 4 (c) Many (d) 2

3. Which of the following terms means a name having two or more distinct meanings?

(a) Inheritance (b) Overriding (c) Encapsulation (d) Overloading
4. Which refers to a function having more than one distinct meaning?

(a) Overloaded operator (b) Overloaded operand

(c) Overloaded expression (d) Overloaded function 

5. The ability of function to process the message in more than one form is called as 

(a) Function overloading (b) Data abstraction (c) Operator overloading (d) Data hiding 

6. Which strategy is adopted by the compiler when functions are invoked in function over loading? 

(a) First Match (b) Matching (c) Match Best (d) Best Match

7.  Which adopts best match strategy to invoke function over loading?

(a) Compiler (b) Overloaded function

(c) Interpreter (d) Overloaded operator

8. The mechanism of giving special meaning to an operator is called as

(a) Function overloading (b) Operator overloading

(c) Data overloading (d) Variable overloading 

9. How many explicit argument(s) are taken by binary operators overloaded through a member function? 

(a) 4 (b) 3 (c) 1 (d) 2

10. During integral promotion, a char data type can be converted to

(a) float (b) integer (c) double (d) all the other three choices

11. Which data type can be converted to integer/char/double in integral data promotion?

(a) double (b) float (c) int (d) char

12. Which data type can be converted to char/double /float in integral data promotion?

(a) float (b) double (c) char (d) int

13. Which of overloaded functions are not considered by the C++ compiler as part of the parameter list? 

(a) Formal arguments (b) Default arguments (c) Actual arguments (d) Dummy parameters

14. Which of the following operators can be over loaded?

(a) Membership (b) Unary (c) sizeof (d) Conditional

15. Which of the following is used to declare the operator function?

(a) method( ) (b) function( ) (c) void( ) (d) operator( )
16 Which of the following must have atleast one operand of use r defined type? 

(a) Constructor overloaded (b) Operator overloaded

(c) Function overloaded (d) Method overloaded 

17. Which function is used to concatenate strings? 

(a) strcmp( ) (b) strplus( ) (c) strcpy( ) (d) strcat( ) 
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18. The sign for membership operator is

(a) ?: (question colon) (b) :: (double colon) (c) . (dot) (d) : (colon) 

19. Which operator is used to concatenate two objects of the type Strings?

(a) + (b) * (c) & (d) and

20. Which is one of the facets of C++ that supports object oriented programming? 

(a) Data hiding (b) Operator overloading (c) Data abstraction (d) Function overloading

# include <iostream.h>
# include <conio.h>
class negative
{
int i;
public :
void accept()
{
cout << “\nEnter a number ...”;
cin >> i;
}
void display()
{
cout << “\nNumber ...”<<i;

};

void operator-()
{
i = -i;
}
};
void main()
{
clrscr();
negative n1,n2;
n2.accept();
-n2;
n2.display();
getch(); 

}
21. The prototype of the overloaded member function is

(a) negative operator - () (b) void operator - (negative) (c) void operator - () (d) void operator minus

22. Which of the following statements invokes the over loaded member function?

(a) Negative n1() (b) n2+; (c) -n2; (d) --n2()

23. Which of the following cannot have same return type ?

(a) void fun(int x, int y); void fun(int x, float y); (b) int fun(int x); void fun(float x); 

(c) void fun(int x); void fun(int y); (d) void fun(char x); void fun(char x, int y); 

24. In operator overloading, the operator functions must be defined as 

(a) member function (b) either member function or friend function 

(c) None of these three choices (d) friend function 

25. Which of the following operators cannot be over loaded?

(a) += (b) ++ (c) + (d) :: 
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26.  While over loading functions, the possible integral promotions are 

(a) Both int char and char int  (b) charint (c) intchar (d) None of these 

27. The functionality of '+' operator can be extended to strings through 

(a) operator overloading (b) function overloading (c) class (d) inheritance 

28. The over loaded operator must have atleast one operand of

(a) user-defined type (b) derived (c) array (d) built-in type

29. During over loading of which of the following operators, the left hand object must be an object of their relevant
class

(a) Unary (b) None of these three choices      (c) Binary (d) Ternary

30. The over loaded function definitions are permitted for which of the following data types?

(a) All of these three choices     (b) User defined (c) Derived (d) Built in

31. Which of the following is not true related to function over loading?

(a) Do not use the same function name for two unrelated functions

(b) The return type of overloaded functions may be the same data type.

(c) Each overloaded function must differ by the number of its formal parameter.

(d) The default arguments are considered by the C++ compiler as part of the parameter list
32. Integral promotions are purely -------

(a) program oriented (b) compiler oriented (c) data oriented (d) computer oriented

33. The function operator() is declared in which part of the class ?

(a) static (b) private (c) public (d) protected

34. Which of the following statement is false in case of operator overloading? 

(a) Only existing operators can be overloaded

(b) Binary operators overloaded through member function take one explicit argument

(c) The overloaded operator must have at least one operand of user defined type

(d) The basic definition of an operator can be replaced
35. The word ‘poly’ means: 

(a) Class (b) Shape (c) Many (d) Constructor 
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8. CONSTRUCTORS AND DESTRUCTORS
1. Which of the following gets executed, when an instance of a class comes into scope?

(a) Overloading (b) Destructor (c) Constructor (d) Encapsulation 

2.  Which of the following initializes the class object?

(a) friend function (b) member function (c) inline function (d) constructor function 

3. When a class object goes out of scope, a special function that gets executed is

(a) Destructor (b) Destroy (c) End (d) Constructor

4. The constructor and the destruct or have the same name as the

(a) Function (b) Object (c) Variable (d) Class

5. Which are special functions of classes?

(a) Encapsulation (b) Both Constructors and Destructors 
(c) Constructors (d) Destructors 

6. Which of the following functions return nothing? 

(a) Destructor (b) Both Constructors and Destructors 

(c) Pointer (d) Constructor 

7. The constructor add( ) is called as

(a) New (b) Non-parameterized (c) Parameterized (d) Copy

8. Which is a function that removes the memory of an object? 

(a) Destructor (b) Scope (c) Pointer (d) Constructor

9. The destructor is prefixed with the symbol

(a) ~ (b) & (c) :: (d) ?:

10. Which is executed at the time of program termination? 

(a) Polymorphism (b) Class (c) Constructor (d) Destructor
11. Which of the following are not associated with any data type?

(a) Constructor and destructor (b) Functions

(c) Destructors (d) Constructors 

12. The memory space is allocated to an object using

(a) Instance (b) Constructor (c) Destructor (d) Overloading

13. The constructor without any parameter is called as

(a) Parameterized constructor (b) Copy constructor

(c) Default constructor (d) Standard constructor 

14. The constructor defined by the computers in the absence of user defined constructor

(a) Parameterized (b) Default (c) Destructor (d) Copy

15.  The constructor add( add &a ) is called as ----------- constructor. 

(a) Parameterized (b) Default (c) Copy (d) Non-parameterized

16. The constructor add( int s1, int s2) is called as ----------- constructor.

(a) Copy (b) Parameterized (c) Non-parameterized  (d) Default 

17. Which is executed automatically when the control reaches the end of the class scope?

(a) Destructor (b) Constructor (c) Function (d) Overloading 
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18. When an object is passed by reference to constructor, the constructor that is executed is

(a) Parameterized (b) Non-parameterized (c) Default (d) Copy

19. Which of the following cannot be overloaded? 

(a) Constructor (b) Operator (c) Destructor (d) Function

20. How many destructors are present in a class?

(a) any number (b) 2 (c) 3 (d) 1

21. Which of the following cannot have arguments?

(a) Function overloading (b) Operator overloading (c) Constructor (d) Destructor
22 Constructor should be declared under the scope

(a) private (b) pointer (c) public (d) protected

23. Which of the following is not true?

(a) Constructors can have parameters (b) Destructors cannot be overloaded 

(c) Constructors cannot be overloaded (d) Constructors is executed automatically 

24. Read the following C++ snippet:
class simple

{

private : 

int x;

public:

simple(int y)

{

x=y;

}

~simple ()

{

}};

What is the name of the constructor?

(a) simple (b) public (c)private (d) ~simple
25. Read the following C++ snippet:

class simple

{

private : 

int x;

public:

simple (int y)

{

x=y;

}

~simple ()

{

}

}; 
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What type of constructor is used in this snippet?

(a) Parameterized (b) Copy (c) Non-parameterized (d) Data hiding

26. Which of the following is true?

(a) A destructor can have arguments (b) Constructor returns int type 

(c) Constructor can have arguments (d) A destructor has a return type 

27. Which of the following constructors is executed when a member function returns an object?

(a) Complier generated constructor (b) Default constructor 

(c) Non-parameterized constructor (d) Copy constructor
28. Read the following snippet:

class simple

{

private : 

int x; 

public:

simple (int y)

(x=y);

};

void main()

{

simple s(6);

}

How many objects are created?

(a) 7 (b) 1 (c) 0 (d) 6 
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9. INHERITANCE
1. The process of creating new classes from the existing classes is

(a) Polymorphism (b) Encapsulation (c) Inheritance (d) Data Abstraction

2. Inheritance is a process of creating new classes

(a) Base classes (b) Parent classes (c) Super classes (d) Derived classes

3. The existing class is called as

(a) Sub class (b) Abstract class (c) Derived class (d) Base class
4. The default visibility mode is 

(a) static (b) protected (c) private (d) public 

5. A derived class inherits from multiple base classes is known as

(a) Multiple inheritance (b) Hybrid inheritance (c) Multilevel inheritance (d) Single inheritance

6. When a derived class inherits only from one base class is known as

(a) Multipath inheritance (b) Multiple inheritance (c) Multilevel inheritance (d) Single inheritance
7. The class from which the new classes are derived is known as 

(a) Base (b) Child (c) Derived (d) Sub

8.  Which of the following class is a power packed class with additional attributes and methods? 

(a) Derived (b) Static (c) Abstract (d) Base

9.  Which of the following class inherits all the properties of the base class?

(a) Abstract (b) Super (c) Base (d) Derived

10. Which keyword is used to define a derived class?

(a) base (b) class (c) derived (d) sub

11. Access specifier is also referred to as

(a) Accessibility (b) Visibility mode (c) Acceptability or Accessibility (d) Acceptability

12. The symbol that must be used between derived and base class is 

(a) : (b) :: (c) & (d) #

13. Which are not inherited but are executed first when an instance of the derived class is created? 

(a) Data Members (b) Member functions (c) Destructors (d) Constructors
14 Which form of inheritance is reflected by the transitive nature of inheritance?

(a) Multilevel (b) Multiple (c) Hierarchical (d) Single

15. Classes used only for deriving other classes are called as

(a) Super classes (b) Abstract classes (c) Static classes (d) Concrete classes

16. Read the following declarations:
class vehicle
{
int wheels ;

public:

void inputdata(int, int);

void outputdata( );

protected:

int passenger;

}; 
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class heavy_vehicle:protected vehicle

{

int diesel _petrol;

protected:

int load;

public:

void readdata(i nt, int);

void write data() ;

};

class bus:private heavy_vehicle

{

char marks[20];

public:

void fetchdata(char) ;

void displaydata( );

};

Which is the base class of the heavy_vehicle?

(a) vehicle (b) both bus and vehicle (c) heavy_Vehicle (d) bus

17. The data member that can be accessed from the function displaydata() is

(a) load (b) passenger (c) marks (d) all these three choices

18. The member function can be accessed by an object of bus class is ___ ___ ___ ___ .

(a) None of other three choices (b) inputdata, outputdata

(c) readdata, writedata (d) fetchdata, displaydata 

19. The most powerful feature of an object oriented programming language is 

(a) Encapsulation (b) Class (c) Polymorphism (d) Inheritance
20. Which of the following is a class from which other classes are derived?

(a) Derived class (b) Base class (c) Function class (d) Super class

21. How the derived class should be indicated?

(a) class der_name, visibility mode, base class_id          (b) class der_name :: visibility mode base class_id

(c) class der_name : visibility mode base class_id       (d) class der_name ; visibility mode base class_id

22. Read the following declarations:

class A

int x,y;

protected:

int s,t;

public:

int u, v;

};

class B:public A

{

}; 
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The data members that inherit from Class A to Class B 

(a) u, v (b) x, y (c) Both s,t and u, v (d) s, t

23. u, v data members contain which visibility mode in Class B?

(a) Public (b) Private (c) Either Private or Protected  (d) Protected

24. s,t data members contain which visibility mode in Class B?

(a) Static (b) Protected (c) Private (d) Public

25. What must be used between derived class and visibility modes?

(a) ; (b) :: (c) : (d) !

26. For which class, objects cannot be declared? 

(a) Abstract (b) Destructor (c) Void (d) Constructor 
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10. IMPACT OF COMPUTERS ON SOCIETY 
1. 85% of computer usage is

(a) Spreadsheet (b) Presentation (c) Word processing (d) Database

2. Which of the following permits banking from the comfort of the home by using internet facilities? 

(a) e-Learning (b) e-Commerce (c) e-Banking (d) e-Shopping

3. CBT stands for

(a) Computer Based Tools (b) Computer Based Techniques 

(c) Coded Binary Tools (d) Computer Based Tutorials 

4. The technical element used to reach out the benefits of IT to the common man is

(a) Connectivity (b) Affordable computers (c) All the other three choices (d) Software

5. Which enables data storage and management at home?

(a) Emotion Container (b) Memo frame (c) Personal Archives (d) Archive unit

6. Which is an easy interaction with other people through touch screen? 

(a) Archive unit (b) Bookshelf (c) Memo frame (d) Personal creativity tool

7. Which of the following units will prevent people from acquiring bad habits? 

(a) Archive unit (b) Personal Archives (c) Memo frame (d) Emotion Container

8. We can purchase any product, any brand, and any quantity from anywhere using

(a) e-Shopping (b) e-Learning (c) e-Commerce (d) e-Market

9. Which is an advanced data accessing system?

(a) Bookshelf (b) Memo frame (c) Archive unit (d) Personal creativity tool 
10. Which of the following enables online educational programs leading to degrees and certifications?

(a) e-Commerce (b) e-Learning (c) e-Education (d) e-Shopping 

11. ATM is an example for

(a) e-shopping (b) e-banking (c) digitization (d) transcription

12. Which of the following functions is used as electronic pets in computerized home?

(a) Robot (b) Interactive screen (c) Creative line (d) Projection TV

13. What is useful in computer based education?

(a) Teaching (b) e-shopping (c) CBT (d) Transcription

14. Which is useful in customer -related functions?

(a) e-banking (b) e-shopping (c) e-mail (d) Call centers
15. ATM means

(a) Auto Teller Machine (b) Arithmetic Teller Machine 

(c) Automatic Teller Machine (d) Automated Teller Machine 

16. How many technical elements are require by a common man reach the benefits of IT? 

(a) 4 (b) 3 (c) 6 (d) 5

17. Which enables easy interaction with other people through tough screen, scanner and microphone facilities?

(a) Personal archives (b) Memo frame (c) Archive unit (d) Picture phone and pad 
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11. IT ENABLED SERVICES 
1. IT that helps in improving the quality of service to the users is called

(a) IT Evolution Studies (b) IT Enabled Studies 

(c) IT Environment Studies (d) IT Enabled Services 
2. ITES stands for 

(a) IT Enabled Services (b) IT Evolution Studies

(c) IT Enabled Studies (d) IT Environment Studies 

3. Which of the following traditional services are IT Enabled?

(a) Spreadsheet (b) All the other three choices (c) Word Processors (d) Databases 

4. Which can be collected for one purpose that may be useful for some other purpose?

(a) Program (b) ITES (c) Computer (d) Data
5. BPO may be expanded as.

(a) Business Process Online (b) Business Publication Outsourcing 

(c) Business Process Outsourcing (d) Business Publication Online 

6.  Which is defined as a telephone based shared service center for specific customer activities? 

(a) Data Management (b) Call Centers (c) Medical Transcription (d) Digitization 

7. The process of collecting, digitizing, and processing data is called as

(a) Data Management (b) Digitization (c) Call Centers (d) Medical Transcription 

8. Which of the following is a permanent, legal document that formally states the result of a medical investigation? 

(a) Medical Transcription (b) Digitization (c) Data Management (d) Call Centers

9.  How many steps are involved in medical transcription?

(a) 4 (b) 2 (c) 5 (d) 3

10. Which refers to the conversion of non-digital material to digital form?

(a) Medical Transcription (b) Tele-Medicine (c) Call centers (d) Digitization

11. Which increases the employment opportunities?

(a) KPO (b) ITES (c) IT (d) BPO

12. A facility that allows the user to speak into a special device while typing a letter using computer is called 

(a) Telephone (b) Cell phone (c) Speaker (d) Dictaphone

13. Which is the key for effective and profitable use of IT in organizations? 

(a) Data Management (b) Digitization (c) Call Centers (d) Medical Transcription 

14. Which services comprise punching data from manually filled forms and images? 

(a) Tele-Medicine (b) Call Centers (c) Data Processing (d) Medical Transcription 

15. Which is critical for the success of ITES?

(a) Computer Crime (b) Computer Virus (c) Computer Time (d) Computer Ethics
16. Which of the following is not an IT enabled services? 

(a) Data management (b) e-Governance (c) Reservation (d) Tele-medicine

17. The two important aspects that must be ensured by the ITES provider are

(a) Customer security and needs (b) better look and feel 

(c) Data security and customer privacy (d) personal security and customer satisfaction 
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12. COMPUTER ETHICS
1. Which is the set of rules for determining moral standards?

(a) Programs (b) Cracking (c) Ethics (d) Crimes

2. Which refers to the protection of hardware? 

(a) Data security (b) Physical security (c) Personnel security (d) Personal security

3 Making and using duplicate hardware and software is called

(a) Crime (b) Publicity (c) Piracy (d) Security

4. A self-replication program that can cause damage to data and files stored on the computer is 

(a) Antivirus (b) Virus (c) Language (d) Bacteria

5. How many new viruses are found each day? 

(a) 57000 (b) 6 (c) 55000 (d) 5700

6. The software runs on an idle computer without the knowledge of the organization is called

(a) Software time (b) Theft of Computer time (c) System time (d) Hardware time 

7. Which of the following laws prevent computer crimes in India?

(a) Crime (b) Illegal (c) Cyber (d) Zero

8. The illegal access to the network is called

(a) Cracking (b) Accessibility (c) Security (d) Management

9. The illegal access to the computer hardware and software 

(a) Browsing (b) Hacking (c) Chatting (d) Cracking

10. ''Cracking'' comes

(a) Transcription (b) Website Service (c) Data Security (d) Computer Crime

11. Which refers to software setups that permit only authorized access to the system?

(a) Personal security (b) Personnel security (c) Physical security (d) Data security

12. Which security refers to protecting data and computer system against dishonesty? 

(a) Personnel (b) Physical (c) Data (d) Personal

13. How many percent of computer crimes happen within the company?

(a) 80 (b) 90 (c) 60 (d) 70

14. How many known virus programs are in existence?

(a) 6 (b) 55000 (c) 5700 (d) 57000

15. Which of the following is not a way of protection? 

(a) Physical Security (b) Personal Security (c) Piracy (d) Personnel Security

16. Which of the following is the telephone based Shared Centre?

(a) Website Services (b) Call center (c) Medical Transcription (d) e-Governance 

17. Computer ethics has its roots in the work of

(a) Norbert Wiener (b) Herman Hollirith (c) Charles Babbage (d) Blaise Pascal 

 
www.Padasalai.Net                                                              www.TrbTnps.com

http://www.trbtnpsc.com/2018/02/latest-12th-study-materials-2018.html

www.Padasalai.Net



 
M.VIJAYA KUMAR, MCA.,M.Phil.,B.Ed.,PGDCA., 

 

        Sastra Matriculation Higher Secondary School                          74 
 

 
 
 
  

VOLUME - I   2, 3 MARKS 
STAR OFFICE WRITER (1-5)  

         

1. How will you select text with keyboard? (June 2007, June 2014)
To select a text with keyboard   the following steps are followed

1. Insertion point is moved to the start of the text to be selected.
2. The Shift key is pressed down and the movement keys are used to highlight the required text. 
3. When the Shift key is released, the text is selected.

2. What are the differences between copying text and moving text in StarOfficeWriter? 
(Oct 2007, March 2014)

S.No. Copying Moving 

1.

Copying leaves  the source text
untouched and makes a new copy 
in the destination location. 

Moving removes the text from
source location  and  places 
them in the destination
location. 

2.

The keyboard  short cuts  to copy
the text are
Ctrl + C  To copy text
Ctrl + V  To paste text 

The keyboard  short cuts  to
move the text are
Ctrl + X  To cut text
Ctrl + V  To paste text 

3.
The text is  copied  from one 
location to another. 

The text is  moved  from one
location to another 

3. How will you correct the mistakes in a document? [June-08]
The mistakes can be corrected either by using the Backspace key or the Delete key.
 Backspace key is used to delete the character left of the insertion point. 
 Delete key is used to delete the character right of the insertion point. 

4. What is meant by text editing? (TBQ) [MAR-09, OCT-09, MAR10, OCT 10 March 2013]
 Entering a new text or modifying the existing text in a document is known as text editing. 
 Copy, Cut, Paste and Find and Replace are some of the commonly used editing functions. 

5. How will you switch over from insert mode to type over mode in a document? (June 10) 
1. By using the insert key, the user can toggle between Insert Mode and Type over Mode. 
2. The status bar gives the information about the current mode.

6. How can you switch between multiple documents?(or) How can you work with multiple documents
in Star office writer.(March 2011)

Once the documents are open you can switch between them in the following two ways. 
1. Click on the Window menu option and select the file from the list of documents displayed. 
2. Click on the document button visible on the taskbar.   
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7. What does the term 'Word processing' refers to? (or) What is word processing? (or) What is Star
Office Writer? (oct 2012, Sep 2014) 

The term word processing refers to the activity carried out using a computer and a suitable
software to create,  view,  edit,  manipulate,  transmit, store,  retrieve and print documents.  A
document may contain text, tables, graphs, charts, equations, pictures and drawings.

Example: Star office Writer
8. List out some of the word processing  packages.  (or) Write any  four word processing  packages? 

(June 2013)
 MS Word
 Lotus AmiPro
 WordPerfect 
 WordPro
 WordStar
 StarOffice Writer.

9. How will you create bulleted list? (or) What are the steps in creating bulleted list in Star Office 
Writer document? [Mar 2007] 

1. Select the text that to which bullets are to be added. 

2. Click on the Bullets icon from the formatting tool bar. 
3. The StarOffice Writer will add bullets to each paragraph within the selection, and not to each

line. 
4. StarOffice Writer will add bullets to any blank lines within the selection.

Example:
 Tamil 
 English
 Mathematics
 Physics
 Chemistry

10. How will you create numbered list?  [Mar 2008, Jun 2009]
1. Select the text to be numbered.

2. Click on the numbering icon to create a number list.
3. The StarOffice Writer will number each paragraph within the selection.
4. Blank lines within the selection will be numbered.

Example:
1. Tamil 
2. English
3. Mathematics
4. Physics
5. Chemistry 
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11. What are the difference types of paragraph alignment in star office writer?  [Oct 2008][Jun - 2012]

12. How will you change the line spacing in star office writer?( June 2011, Oct 2013) 
1. Select the paragraph (s) that needs to be changed.
2. Select Format paragraph . 
3. The Paragraph dialog box appears. 
4. Click on the Indents & Spacing tab if necessary 
5. Click on the line spacing drop-down list box, and select the required line spacing option
6. Click the ok button.

13. What do you mean by‚ Hanging indent? (Oct 2011, March 2012) 
 Hanging Indent is a special kind of indent that can be used for numbered list.
 The first line option  can  be used  to  indent the line of a paragraph.  Using spin  arrows,   

if a positive value is specified, the first line will be indented. 
 

 A negative value will result in  a Hanging Indent.  That is,  the first line will hang outside the 
paragraph.

14. How can you create bullets and numbered list in Star office writer? (Oct 2011)
1. Select the text that to which bullets are to be added. 

2. Click on the Bullets icon from the formatting tool bar.
3. The StarOffice Writer will add bullets to each paragraph within the selection, and not to each

line. 
4. StarOffice Writer will add bullets to any blank lines within the selection.

Steps to create Numbered List:
1. Select the text to be numbered.

2. Click on the numbering icon to create a number list.
3. The StarOffice Writer will number each paragraph within the selection.
4. Blank lines within the selection will be numbered.

15. What are the different types of line spacing in Star office writer? (March 2014) 
1. Single line 2. 1.5 line 3. Double 4. Proportional
5. At least 6. Leading 7.  Fixed.

Sl.No Icon To make text Press 

1. Left aligned Ctrl + L 

2. Right aligned Ctrl + R 

3. Centered Ctrl + E 

4. Justified Ctrl + J 
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16.  What is  the use of Auto  spell -check feature or icon ?  [or] How does  StarOffice Writer check

spelling while typing? [Oct 2007]

 StarOffice Writer has  an automatic spell - check feature that can  check  for possible spelling 

mistakes even as the document is being typed.

 This feature can be turned ON or OFF by clicking on the Auto Spellcheck icon.

 When Auto Spellcheck feature is ON, StarOffice Writer compares each word typed with the words 

in the dictionary and underlines words that do not match with a squiggly red line. These red lines

can  be ignored  and  the typing work  may be continued. The correction can  be made after the 

document is created.

17. What is the use of Auto correct option? (or) What is meant by Automatic Spelling Correction?

[Jun  -  2008]

 Star office writer will automatically correct some spelling mistakes.  Star office writer recognizes

some common  misspellings  and  typographical mistakes  and  makes  the replacement 

automatically using auto correct option. 

 For instance, if a word is typed as “teh”, staroffice writer automatically replaces this with the correct

word “the”.

18. How to make the selected rows and columns of the same size in a table?
(June 2007, Oct-10, March 2012)

i) Select the rows and columns that are to be resized. 
ii) To make all columns even, right click inside the table and select Column  Space Equally in the 

pop - up menu.
iii) To make all rows even, right click inside the table and select Row Space Equally in the pop -

up menu.

19. How will you insert columns in a table in Star office Writer? (March 2009) 
TO INSERT COLUMN

 To insert a Column, select the Insert columns icon and press once. Now a new column is 
inserted to the right of the present column.

TO ADD MORE THAN ONE COLUMN
 To insert more than one column in the table, Table  Insert Columns command is used. Now a 

corresponding dialog box appears.  Here one can  select the required  number of columns  from
“amount “spin box and click OK button. The required numbers of columns are added to the table. 
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20. How can you change the width of a column in a table? [Jun-09]
i) To resize a column, place the cursor in a table cell, hold down Alt, and then press the left or the
right arrow. To resize the column without changing the width of the table, hold down Alt + Ctrl, and 
then press the left or the right arrows.
ii) When precise measurements for each column are known, follow the given steps: 
 TableTable Properties command is used.
 Table Format dialog box appears. 
 Type column size in the Column Width spin box and Click Ok. 

21. How will you delete entire table? [Oct-09]
If the entire table is selected by dragging the mouse across it and the Delete key is pressed, only the 

entries are deleted and not the table. 
To delete the table the following steps are used:

i) The entire table is selected using Edit SelectAll or TableSelect Table command while
keeping the insertion point inside the table.

ii) The menu option TableDeleteTable is used to delete the selected table. 

22. In Star office Writer, how do you delete rows and columns in the table? [June2014]
To delete Rows:

The Rows to be deleted are selected
The command Table  Delete Rows is used to delete the selected rows. 

To delete Columns
The Columns to be deleted are selected
The command Table  Delete Columns is used to delete the selected Columns. 

23. How do you create Header? (or) How will you create a header in a Star Office Writer document? 
[Mar 2007, Mar 2010]

 Select Format Page to open Page style dialog box.

 Select the Header tab on the Page Style dialog box can be used. 

 A screen with various options for the header appears.

 In the dialog box, the Header on check box is clicked. Four spin boxes are also displayed. In those

spin boxes the distance of the header from the text area, the header height, the distance from the left 

margin and the right margin are entered. 

 Click Ok button.

24. What is the purpose of creating footer in the document? [Mar 2008] 

The purpose of creating footer in the document is to include the page number or other text that helps
the reader to identify the document. 
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25. What is meant by header and Footer? [Oct 2008, Mar 2011, Oct 2013] 

Header:

Header is an area at the top of the page.

Footer: 

Footer is an area at the bottom of the page.

Uses:

Header/Footer is used to add the references such as Author Name, Document Title, Page Number,

etc.

26. What are the types of page orientations? (or) What are the two types of page orientation? Which

one is the default page orientation? [June 2010]

The two types of page orientation are

i) Portrait

ii)Landscape

Portrait: When the length of the document is more than the width then it is called portrait. The default

page orientation is portrait. 

Landscape: When the width of the document is more than the length then it is called landscape.

27. How can you insert page numbers in footer area in Star Office Writer? [June 2011, Oct 2013]

Once the header and footer are created, the text to be included can be specified. This can be down in the 

following steps. 

i. Click in the header or footer area.

ii. Click on Insert  Fields. A sub menu with a list of options appears. Clicking on an option in the
list will insert the appropriate text in all the pages. For example, clicking on Insert Fields 

Page Number will insert page numbers on every page. Normal text can also be included in the
header and footer. To do so, simply type the text where we want it. 

28. What is header? How will you insert page number in footer?
 Header is an area at the top of the page.
 To insert Page Number in footer, click in the footer area and select InsertFieldsPage Number. 
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29. Give the difference between Relative cell addressing and absolute cell addressing. 
[MAR -07,JUN-09, JUN-11]

Relative cell addressing Absolute cell addressing 

This is default type of cell addressing used 
by StarCalc. 

A Cell address can be made absolute by
using the $ sign in front of row and column
names. 

In relative cell addressing, the formulae are
automatically recalculated every time the 
contents of the cells used in the formulae 
change. 

The formulas are not automatically 
recalculated every time the contents of the
cells used in the formula change. 

Cell addresses change when copied. Absolute cell addresses do not change
when copied. 

Ex : = C4 + D4 + E4 + F4 Ex : $C$4 

30. What do you mean by date arithmetic in star office calc? (or) Explain the date arithmetic with an 
example. [MAR -07,10,11,12,13, JUN-08, Oct-08, JUN-2014, OCT-2014]

Manual date calculations can be tricky because we have to keep track of number of days in months.
In  spreadsheets,  date calculations  become very simple.  Here the user can add a number to  a  date and
arrive at a new date , find the difference between two dates and use a  wide variety of function and 
formats to get what is required.

Example:

Enter a date 03/04/05 in a cell, say A2. Remember that while entering dates the month always comes 
first. Suppose you want to calculate the date 79 days after this date. To do so, enter the formula, = A2 + 79,
in another cell, say A4. The date 05/22/05 appears in the cell.

31. Name the different types of cell referencing in Star office Calc. [JUN-07, OCT-09]

There are two types of cell referencing in Star office calc. They are
1. Relative cell referencing.
2. Absolute cell referencing.   

6. SPREADSHEET  
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32. What is the use of Auto format sheet? [JUN-07,MAR-08, JUN-10]
 Auto  format sheet facility of StarCalc helps to  format the worksheet with different 

predefined styles and colours.
 To access these predefined styles and colors choose the command Format AutoFormat.

The AutoFormat dialog box appears displaying various predefined format styles. A preview 
for each style is also displayed in the box. Select the required format 

33. Can we change the data present in a cell? If so, how? [OCT-07, MAR-09,12, JUN-10,11, OCT-10] 
Yes, the user can edit the contents in the following two ways:

1. Type in the new data. The new data will simply overwrite the old contents of the cell. 
2. Click on the formula bar with the mouse, press the F2 function key or simply double click on the

cell. A vertical cursor appears on the formula bar. Move the cursor to the left using the left arrow key 
or the backspace key and edit the data.

34. Write the names of popular spreadsheet packages. (or) Name some popular spread sheet
packages. [Oct  -  2007, 2013]

Packages Developers Uses Year 

Visi Calc 
Dan Bricklin  and Bob
Frankston 

VisiCalc was essentially a
financial analysis program.

1979 

Lotus 1-2-3
Lotus Development
Corporation

This package became very
popular because of its  ability to 
combine database management
and  graphics  features  with  its
spreadsheet.

1982 

Excel Microsoft corporation 

Quattro Pro Borland International 

Improve Lotus Corporation 

StarOffice Calc Sun Microsystems 

35. How will you insert special characters in a worksheet? [MAR-14]
 Place the cell pointer in any cell.
 For inserting special characters, click the Insert  Special characters from the menu bar and

select the desired special characters from the Special Character dialog box. For example, select 
 from the Special Character dialog box and click the OK button.

36. How will you save the worksheet? [Mar  -  2008]
 To save the worksheet created, go to the File menu and select the Save or the Save As option. 
 A screen (Save as dialog box) will appear, type in a file name and click on Save. 

 The user can also click on the save icon on the standard tool bar. 
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37. Write the spreadsheet applications. (or) Mention few spread sheet applications. [Jun  -  2008, 2013]
1. Payment of bills
2. Income tax calculations
3. Invoices or bills
4. Account Statements
5. Inventory control 
6. Cost-Benefit analysis
7. Financial Accounting
8. Tender Evaluation
9. Result analysis of students. 

38. How will you change width of a column in a worksheet? [Jun  -  2012] 
The width of the column can be changed by two methods

Method 1:

To change the column width, select the column whose width to be changed. Click on Format 
 Column  Width and type the new column width in the dialog box which appears. On 
pressing OK button the column width gets changed to the specified value

Method 2:

Point the mouse pointer to the line separating the column, whose width has to be changed
from next column.  The mouse pointer becomes  a double headed arrow.  The pointer is
clicked and dragged to the left to decrease the width and dragged to right to increase the 
width.

39. In Star office Calc, what are functions? Give example. (or) Define: Functions in Star Calc. Give
two examples. [OCT-2012, 2013]

Functions are predefined formulae that are available in StarOfficeCalc. StarOfficeCalc has a wide
variety of functions that allow us to perform several frequently done calculations. 

Example: SUM( ), SQRT( ), AVERAGE( ).

40. What is meant by Auto Fill command? [MAR-2013] 

 Auto Fill command automatically generates a data series based on a defined pattern.

 It is also used to copy the contents of a cell to other cells.

41. What are Cell and Cell pointer? [Oct  -  2008]
Cell:

The intersection of rows and columns creates cell. 

Cell Pointer:
The active cell in which you want to type the data is identified by the cell pointer which is a

rectangular box covering that cell. 
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42. Define: Electronic spreadsheet. (or) What is an electronic spread sheet?
[Mar  -  09, OCT-12, JUN-12] 

 An electronic spread sheet is a work sheet used in a computer to create and quickly perform "What 
if” analysis of interrelated columnar data in workspaces.

 Spreadsheets are made up of rows and columns.
 The intersection of rows and columns creates cell. 
 The Cells are addressed in terms of the row and column labels. 

Ex: Star office Calc.

43. What is meant by range? Give example [Jun  -  2009, Sep-2014]
 A continuous group of cells in a worksheet is called a range.
 A Range address is the address of the first cell in the Range, followed by a colon, followed by

the address of the last cell in the range.
For example, the cells G1, G2, G3, G4 and G5 can be called G1: G5

44. Write a note on text operators in Star office Calc. (or) What is   text operator?  Give an example.
[Oct  -  2009]

The operator which combines sections of text to the entire text is called text operators. 

Operator Name Example Result 

& (And) Text operator : AND "Star"&"Office" yields StarOffice 

 
45. Explain how to generate the series: 33, 30, 27, …..3. [MAR-2010] 

1. Select the range of cells.
2. Choose EditFillSeries to get Fill Series dialog box.
3. Select Liner Type.
4. Select Direction as Right.
5. Enter 33 as Start value.
6. Enter 3 as End value.
7. Enter -3 as Increment value and click ok button.

46. What are functions? How can you insert them in the worksheet? [OCT-10,11] 

 Functions  are predefined formulae that are available in  StarOfficeCalc. StarOfficeCalc has  a 
wide variety of functions that allow us to perform several frequently done calculations.

 Functions can be inserted in the worksheet using Function Wizard dialog box.

 Function Wizard dialog box can be opened using Insert Function or Function Wizard icon 
f(x) in the formula bar. 
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47. Explain the different types of cell referencing in Star office calc. [OCT-11]

There are two types of cell referencing in Star office Calc. They are

1. Relative cell addressing is the default type of cell addressing used by StarCalc. Because of
relative cell addressing, formulae automatically get recalculated every time the contents of the
cells used in the formulae change. Cell addresses change when copied. Ex: = C4 + D4 + E4 +
F4.

2. Absolute cell addressing is  type of cell addressing used  in  Spreadsheet.  In  Absolute cell 
addressing, a cell address can be made absolute by using the $ sign in front of row and column 
names.  Absolute cell addresses  do  not change when  copied.  For example,  the C4 becomes
absolute when you enter it as $C$4.

48. Mention the advantages using electronic spread sheet. [Mar  -  2011]
 Calculations  are automated through  the built - in  mathematical,  financial and  statistical 

functions.
 Accurate results to any desired level of decimal points are possible.
 Worksheets can be quite big in size. 
 Any part of the worksheet can be viewed or edited.
 Worksheet can be saved and retrieved later.
 Any part or whole of an  existing worksheet can  be merged  with  any existing or new 

worksheet.
 Any part or whole of the worksheet can be printed in a desired format.
 Worksheet data can be viewed in the form of graphs or charts.
 The worksheet information can be transferred to any database or word processing software. 

49. What are Reference operators? Give an example. (or) Write a note on reference operator in Star 
office Calc. Give example. [JUN-2014]

The operators which combine cell areas are called Reference operators 

Operator Name Example 

: (colon) Range A1:G3 

! (Exclamation point) Intersection SUM(A1:B4!B3:C7) 
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50. What are the steps involved in data processing? (March 2007) 

1. Data collection

2. Verification

3. Validation

4. Report generation

51. What is report? (or) Write a note on reports in StarOfficeBase. (March 2007)

 A report is printed information that is  assembled  by gathering  data based  on user supplied

criteria.  Reports  can  range from a simple list of records to customized  formats for specific 

purposes. 

 Report generators  can  use selected  data and  criteria to  carry out automated  mathematical 

calculations as the output is being printed. 

 Report generators in most DBMS create reports from queries. 

52. What is a primary key? [June 2007, Oct 2008, Mar 2009,2012, Oct 2010] 

A primary key is a key that uniquely identifies a record in a database table. In relational databases, a 

primary key can consists of one or more fields.

A Primary Key is a field (or a combination of fields) in a table that uniquely identifies every record 
in the table.
Example:

In a mark list table regno is primary key. Each RegNo will uniquely identify one student and no two 

students can have the same Reg.No.

53. How will you insert a Calc cell range into a text document? [june 2007] 
1. Open a StarOffice Writer (text) document.

2. Open a StarOffice Calc(spreadsheet) that contains the data

3. In the spreadsheet, select the cell range that you want to display as table in the txt document.

4. Choose EditCopy.

5. In the text document, Choose Edit Paste special.

6. In the past special dialog, select DDE link, and then click OK.

7. The copied cell range will displayed in the text document. 

8. Now, modify the data in the spreadsheet. You will see the data automatically changes in the 

text document.   

7. DATABASE  
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54. What is Database? What is DBMS? [Oct-07]

A database is  a repository of collections  of related  data or facts.  It arranges  them in  a specific

structure. 

A DMBS (Database Management System) is a program, or collection of programs that allows any

number of users to access data, modify it (if necessary), and construct simple and complex requests

to obtain and work with selected records.

55. What is meant by Relational Database? [Oct-07]
 A relational structure represents a database made up of a set of related tables. 

 In a relational database, one or more common fields existing in two or more tables create a 

relationship between these tables. The common field or fields are called the Keys.

 A primary key is a key that uniquely identifies a record in a database table. In relational databases, a 

primary key can consist of one or more fields. 

 The relational database structure is the most prevalent database in today-s business organizations.

56. Write the steps in sorting a database in Star office base. [Mar-08]

1. Open the table that you want to sort. 

2. Select the field you want to sort by clicking on the field name at the top of the table. Note that the

entire column becomes highlighted. Then click on the Sort Ascending icon. The records in the 

table are displayed in the ascending order of the specified field.

3. To sort the records in the descending order, select the field and click on the Sort Descending 

icon.

57. What does it mean to ‘filter’ database records (or) Write notes on filter?

[Jun-10,11,13, Oct-11,13, Mar-14]

A filter is also a type of query.  It is also used to select and display records which match a certain

condition.  The remaining records are hidden from the user. 
Thus  to  ‘filter’ database data base records  means  to  select and  display records  which  match  a

certain condition. StarOfficeBase allows us to use two types of filters.

They are Auto Filter and Default Filter. 
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58. What distinguishes information from data? or How does the Information differ from data? (or) 

Differentiate between Data and Information. [Jun 2008, Jun 2009, Oct 2009, Sep-2014] 

S.No DATA INFORMATION 

1. Data is  a raw fact. Information is a processed fact 
2. Data is  a fact about people,  places  or

some other entities
Information is a group of related data conveying
some meaning. 

3. Data does not convey any meaning. Information conveys meaning. 
4. Example:

Name = Vijay
Class = 12

Example:
Vijay is 16 years old. 

59. How will you copy text and objects between StarOffice applications using Drag-and-drop? [Jun08] 

1. Open StarOffice Impress presentation

2. Open the Calc spreadsheet that contains the data that you want to copy.

3. In the spreadsheet, select the cell range that you want to copy.

4. Just drag and drop the selected range into the presentation. 

60. What is meant by multiple sorting? [oct 2008][Jun - 2012] 

Multiple sorting means sorting on more than one field of a table at the same time.  For example, a 

mark list can be sorted in alphabetical order of names and also in ascending order of the register

numbers.

1. Open the table that you want to sort. 

2. Click the sort icon The sort order dialog box will appears on the screen. 

3. Specify the fields you want to sort on by selecting them from the Field Name drop-down

list boxes.

4. Specify the order in which you want to sort, in the Order drop-down list box. Click OK

after you finish.

5. The records will be displayed in the sorted order. 

61. What is the difference between a query and a filter? [Mar 2009, 2013]

QUERY FILTER 

Queries are special views of the data in a 
table.

Filter is a type of query 

Queries does not affect the original table Filter affects the original table. 

Query can be saved for later use. Filters cannot be saved for later user. 

The result from a query is  always  stored 
separately and can be viewed later.

The result of the filter cannot be saved 
separately. 
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62. What is Database Management System (DBMS)? (or) Define:DBMS.

(or) Write a  note on Data  base Management System(October 2007,  June 2009,  oct 2010, mar 

2011)

A DBMS is a program, or collection of programs that allows any number of users to access

data, modify it and construct simple and complex requests to obtain and work with selected records.

The biggest asset of the DBMS is its ability to provide quick access and retrieval from large data

bases.

A DBMS is a software tool that allows users to create database tables and that provides access to 

multiple users. 

63. What is a database?  [Oct 2007, Oct 2009, Mar 2010] 

A database is a repository of collections of related data or facts.  It arranges them in a specific

structure. 

Data in a database in most commonly viewed in one or more two dimensional tables, each

consisting of columns and rows.

Example: Star office Base.

64. Explain how to use Auto Filter? [Mar 2010]

The Auto Filter icon is available on the toolbar; click on this icon displays only the records,

which match the value of the current field.

65. List and define the three components that make up a database. [Jun 2010] 

1. File or Table

2. Record

3. Field

File or Table : The entire collection of related data in one table is referred to as a 

File or a Table.

Record : Each row in a table represents a Record, which is a set of data for each database entry. 

Field : Each table column represents a Field, which groups each piece or item of data among

the records into specific categories or types of data. 

66. Write in brief about hierarchical database [Mar 2011]

 The hierarchical database structures were primarily used on Main Frame Computers.

 In hierarchical database, records are organized in a tree like structure by type.

 The relationship between record types is said to be a parent-child relationship, in which any child 

type relates only to a single parent type. 

 
www.Padasalai.Net                                                              www.TrbTnps.com

http://www.trbtnpsc.com/2018/02/latest-12th-study-materials-2018.html

www.Padasalai.Net



 
M.VIJAYA KUMAR, MCA.,M.Phil.,B.Ed.,PGDCA., 

 

        Sastra Matriculation Higher Secondary School                          89 
 

 

  

         

67. Explain (i) Record (ii) Field in Star office Base. [Jun-11]
Record : Each row in a table represents a Record, which is a set of data for each database entry. 

Field : Each table column represents a Field, which groups each piece or item of data among the

records into specific categories or types of data.

68. What is meant by SQL? (or) What is a Structured Query Language (SQL)? [Oct-12]
SQL stands  for Structured Query Language.  Every DBMS supports  a language that is

similar to a programming language. This  language,  called the Structured Query  Language

(SQL), is designed specifically for communicating with  a database using statements  that are

closer to English than to programming languages.

69. What is a Form in Star office Base? [Oct-12]

 A form is simply a screen that displays the fields of a record in well spaced out manner.

 Forms are user defined screens that are used to make it easier to enter, view and edit the data in a

table or a query.

70. What are the categories of the data management tasks in DBMS?[ Oct-2013,Jun-2014] 

The data management tasks in a DBMS fall into one of the following three general categories. 

1. Entering data into the database.

2. Reordering records in the database.

3. Obtaining subsets of the data.

71. What is Data processing? [Jun-2014]

Processing means to do some operations or computations on the data of different variables to relate

them so that these data, when related, convey some meaning. 

72. What is a Query? [Sep-2014]
 Queries are user-constructed statements that set conditions for selecting and manipulating data in one

or more tables and assembling the criteria-matching data into information. 

 Queries are special views of the data in a table. Unlike sort, the output from a query does not affect

the original table. The result from a query is always stored separately and can be viewed at any time. 
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73. Explain Inline Sound and Video. (Mar 2007, Mar 2010, Mar 2011, Sep-2014)
 Sounds and video in multimedia applications can be played "inline" or by using a "helper". 
 How the sound or video is played depends on the HTML tags that we use. When sound or video is

included as part of a web page, then it is called inline sound or video. 
 The disadvantage of using inline sound or video is that it plays automatically whenever the web 

page loads without giving the viewer any control. 
 We can add inline sound to a web page by using the <bgsound> and the <img> tags.

74. What is morphing? (or) What are the uses of morphing? (or) Define: Morphing.

[Mar 07,10,12, Jun 09,10, Oct 10,11]

 Morphing is a technique by which we can blend two or more images to form a new image. 

 Most modern multimedia applications, particularly games, combine these techniques with virtual

reality to create an environment in which gives the viewer the feeling that he is part of that 

environment.

 Once the animations are created it can be enhanced using morphing. 

75. What is multimedia? [Jun 2007, Mar 2008, Jun 2009, 2014, Oct 2012]

Multimedia is a computer based presentation technique that incorporates text, graphics, 
sound, animations and video elements. A combination of these elements grabs the viewer-s attention

and retains it.  The multi-sensory inputs address the different learning needs and styles different users 

and enhance the entire experience for the user.

76. What are the types of video compressions available? [June 2007, Oct 2007, 2012, Mar-11, 12]

Compression is a technique by which a recurring set of information is identified and replaced by a
single piece of information. There are two types of video compressions.

i.Lossless compression:

Retains the exact image throughout the compression. 

ii.Lossy Compression:

Provides a comparatively higher ratio of compression but results in some loss of quality.   

8. MUTIMEDIA
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77. Compare Lossless and Lossy video compressions. [Oct-09]

Lossless Compression Lossy Compression

Retains the exact image throughout the

compression.
Result in some loss of quality. 

Compression ratio is less.
Provides a comparatively higher ratio of

compression. 

Example: GIF Files Example: JPG Files 

78. What are the two categories of 2-D animations? (or) Write a note on 2D animations.

(October 2007, June 2008, Jun - 2010) 

2 - D animations are classified into two categories. They are Cel-based animations and Object - 

based animations.

Cel-based animation:

Cel-based  animation  consists  of multiple drawings, each one a little different from the others.

When displayed in rapid sequence, these drawings appear to move.

Object - based animations: 

Object based animations also referred to as slide or path animations are created by moving an object

across a screen. This type of animations is usually seen in a computer game. Example a ball moving 

across the screen.

79. Explain the steps for creating 3-D animation. [Mar 2008]

Creating a 3-D animation is a 3-step process:
1. Modeling 

2. Animating

3. Rendering

Modeling:

To create a 3 -D animation, we have to first create the broad shapes  and structures of the 3 - D

objects to be included in the animation.

Animating:

Then, the created models must be animated to define their motion.

Rendering:

Finally, we have to render them by giving attributes, such as colors and textures to the objects. 
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80. Expand and explain : (i) AVI     (III) MIDI

Write a note on AVI Format [Mar-08, 09] 
 The Audio Video Interleave or AVI format was developed by Microsoft in 1992.

 It is supported by all computers running the Windows operating systems and by most of the popular 

web browsers.

 It is a very common format on the Internet.

 Video Files stored in the AVI format have the extension .avi.
Expand MIDI and Write a short note on MIDI. [Jun  -  2012]

 MIDI or the Musical Instrument Digital Interface is one that is commonly used for transferring music 

information between electronic music devices like synthesizers and sound cards in computers.

 It was developed in 1982.

 It is a very flexible format used for a wide range of musical applications.

 MIDI format cannot contain sounds. It contains only digital notes.

 These files are relatively light. 

 Sound files in the MIDI format have the extension .mid or .midi.

81. Name the special software used in the multimedia content.

 Flash

 Dreamweaver

 Maya

82. Write full form of.     i)MIDI ii) AIFF iii) MPEG iv) AVI      [Oct 2008]

MIDI – Musical Instrument Digital Interface

AIFF – Audio Interchange File Format

MPEG – Moving Pictures Experts Group 

AVI – Audio Video Interleave

83. What is Warping? (or) Explain: Warping. [Mar 09,13,14, Oct 09, 10,11, 13, Jun-11,13]

 Warping is a technique of distorting a single image to represent something else.

 Most modern  multimedia applications,  particularly games,  combine these techniques  with  virtual
reality to  create an  environment in  which  gives  the viewer the feeling that he is part of that
environment.

 Once the animations are created it can be enhanced using warping. 
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84. What is plug-in? What is its advantage? [Oct 2010]
 A helper application, also called as a Plug-in, is a program that can be launched by the browser to

"help" play sound or video.
 The advantage of using helper applications is that you can allow the viewer control some or all of 

the player settings.
 For example, the viewer can control the volume settings, in addition to letting him rewind, play, 

pause, and stop the sound or the video.

 Helper applications can be launched using the <embed>, <applet>, or the <object> tags.

85. Expand and explain: i) MPEG ii)AVI  [Jun-11, Mar-14]
MPEG  -  Moving Pictures Experts Group

 The MPEG format was developed by the Moving Pictures Experts Group. This MPEG format

developed for video files.

 These formats have become one of the most popular formats on the Internet in recent years.

 The main reason for the popularity of these formats is that they offer good compression and high

quality.

 They are also cross-platform and supported by most popular web browsers.
AVI  -  Audio Video Interleave.

 The Audio Video Interleave or AVI format was developed by Microsoft in 1992.

 It is supported by all computers running the Windows operating systems and by most of the popular 

web browsers.

 It is a very common format on the Internet.

 Video Files stored in the AVI format have the extension .avi.

86. Write the names of 3D animated films. [Oct-11]

Some of the animated films are Finding Nemo, Polar Express, Ice Age, Sindbad, Hanuman.

87. Write any four multimedia formats. [Oct-11]
1. The Musical Instrument Digital Interface (MIDI).

2. The RealAudio/RealVideo Format.

3. The Audio Interchange File Format (AIFF). 

4. The WAVE format. 
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88. Write a short note on Shockwave format. [Mar-13]

 The Shockwave format was  developed  by Macromedia and  is  used  to  store multimedia 

components created using Flash.

 This  format requires  an extra component to  play.  However,  this  additional component comes

preinstalled with the latest versions of Netscape and Internet Explorer.

 Files in the Shockwave format have the extension .swf.

89. What do you mean by sampling? (or) What is digital sampling [Jun-13, 14]
 This conversion of analog sound waves to a digital format is called Sampling. 

 You can further enhance the quality of the converted sound waves and add special effects, such as

echo, fade in, and fade out effects, by using sound editing programs such as Sound Forge. 

90. Write note on Quick time format. [Mar-14]
 The QuickTime format was developed by Apple primarily to store videos.

 It is a popular format on the Internet but requires the installation of an additional component in non- 

Windows computers. Files in the QuickTime format have the extension .mov. 

91. What is the use of Master page of presentation? [Mar  -  2007, Jun  -  2012, 2014, Oct-2012, 2013]
 The Master page can be used to specify basic background information that needs to be included in all 

the slides.
 It can determine the text formatting  style for the title and outline and the background  desing  for

individual slides.
 For example we can insert a company logo to the master slide and it will appear in the all slides. 

92. How will you create Handouts in star office impress? [Mar -2007, 2012]

 If you want to provide handouts you can use the Handout view mode.
 Since the handouts contain both the individual slides and space for notes, they can be a very helpful 

presentation aid. 
 Click the Handout View tab in the view bar. Open the Layout Pane in Tasks Pane.
 Choose a layout to specify how many slides are printed on a single sheet of paper.
 To print them, choose File  Print and click Options to define the print settings   

9. PRESENTATION 
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93. What is meant by Rehearse Timing of Slide Changes? (or)What is Rehearse Timings?
[Mar-10, 13, 14, Jun-07, 09, 10, 13, 13, Oct-08, 09, 10]

 StarOffice assists us in defining the right rehearse timings for automatic slide changes. 

 StarOffice records the display time for each slide, so the next time we play the show with automatic 

slide changes, the timing will be as recorded.

To record a show with rehearse timings:

 Open a presentation, and switch to Normal View.

 Start the show with the Rehearse Timings from Slide Show menu. You see the first slide and a timer

in the bottom left corner. 

 When  it is  time to  advance to  the next slide,  click  the timer. Continue for all slides  in your 

presentation.

 Star Office has recorded the display time for each slide. 

 If you  want the whole presentation  to auto-repeat,  open  the menu Slide Show  Slide Show

Settings. A window appears on the screen.

 Select Auto and then click OK.

94. What can you do with the left pane of the presentation window? (or) What is the use of left pane?
(June 2007)

The left pane of the presentation window is slides pane. It displays a thumbnail image of the slide
and allows us to rename, delete or rearrange them.

95. How will we insert pictures in a presentation? [Oct  -  2007] 
 To insert a picture in a slide, choose Insert  Picture  From File or click the Insert Picture icon 

from the insert toolbar.
 In the Insert Picture dialog box, choose the desired picture to be inserted from the open dialog box. 

96. How will you change Slide Background? (Oct-07, 13,Jun-08, 10, 11) 
 To change the background color or the background fill of the current slide or all of the slides in our

document choose Format Page Background.
 Select the background fill from the following options.

 Color
 Gradient
 Hatching
 Bitmap Image

 In the Fill area, do one of the following:
• Select Color, and then click a color in the list.

• Select Gradient, and then click a gradient style in the list.

• Select Hatching, and then click a hatching style in the list.

• Select Bitmap, and then click bitmap image in the list. 
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97. How will you customize a presentation?

1. We can create as many as custom slides shows as we want. 

2. Staroffice Impress allows us to star slide shows from the current slide.

3. We can hide/show the slides during a slide show. 

4. We can define the right rehearse timings for automatic slide changes.

98. Write the steps to record a show with rehearse timings?
[Mar  -  2008]

 Open a presentation, and switch to Normal view.
 Start the show with the Rehearse Timings from Slide Show menu. We see the first slide and a

timer in the bottom left corner. 
 When  it is  time to  advance to  the next slide, click  the timer.  Continue for all slides  in  our

presentation.
 Star Office has recorded the display time for each slide. 
 If we want the whole presentation to auto - repeat, open the menu Slide Show  Slide Show

Settings. A window appears. 
 Select Auto and then click OK.

99. What is the use of slide sorter view? [Jun-08]
Slide Sorter view: Allows you to view miniature images of all the slides in the presentation.

This view is also used to rearrange slides.

100. What is the use of Insert OLE object tool in Star Office Impress? [Oct-08]
 Insert OLE Object icon is used to import object from other application into a presentation. 
 For example Staroffice spreadsheet, formulae, text and even Microsoft applications objects can 

be inserted. 

101. How will you rename a slide? [Mar  -  2009, 2010]
 To rename a slide, select the slide, which we want to rename and choose Slide  Rename Slide

or right click on the slide and choose Rename Slide. 
 A dialog box appears. In the name text box type in the name and click OK.

102. What is the use of Custom Animation in presentation? (or)What is custom animation?
[Mar  -  2009][Oct  -  2009]

 The custom Animation page displays various options that allow us to add or modify animation
effects to elements of a slide.

103. What is the use of Slide Transition in presentation? [Jun  -  2009, 13 Mar-11]
 The Slide Transition page displays various transition effects that can be attached to a slide along 

with other options that allow us to control the transition of the slides.
 Note that we can have a different transition for each slide in the presentation. 
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104. List the features of Star Office Impress. [Oct-10]

1. Star Office Impress is the Star Office application that allows us to create attractive and 

professional-looking presentations.

2. It provides various tools that allow us to save and modify presentations, print them as handouts 

and view presentations as slide shows or HTML pages. 

3. It also allows us to import and modify Microsoft Power Point presentations.

105. How will you insert, rename, delete a slide in presentation? [Mar - 2011] 
 To insert a slide, click the Slide button in the presentation toolbar or choose Insert  Slide

from the menu bar. The new slide uses the page layout of the previous slide.
 To rename a slide, select the slide, which we want to rename and choose Slide  Rename Slide

or right click on the slide and choose Rename Slide. A dialog box appears. In the name text box
type in the name and click OK. 

 If we want to delete a slide, select the slide, which we want to delete in the slides Pane and press
Delete key or right click on the slide and choose Delete slide.

106. Write the steps to create a custom slide show (or) Write about creation of custom slide show. 
[Oct-2011]

 Choose SlideshowCustom Slideshows and then click New. 

 Custom Slideshows dialog box appears. 

 Enter a name for the slide show in the Name box of Custom slide show dialog box.

 Under Existing Slides, select the slides we want to add our slide show and click the >> button. Hold 

down shift to select a range of slides or ctrl to select multiple slides.

 We can change the order of the slides in our custom slide show by dragging and dropping the slides 

under selected Slide.

 Click OK.

107. What is the use of Notes View and Normal View in presentation? [Oct-2012]

Notes view: Allows you to add notes to the slides or view any existing notes for the slide. Notes are 
typically used by a presenter to add additional information to a slide. 

Normal view: Allows you to create and edit slides. 

108. What is meant by handout view? [Mar-2013]
 Handouts view: Allows you to scale the slides so that several slides can fit into a page.

 This view is typically used when the presentation is to be printed and distributed as a handout. 
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109. How will you hide a slide? [Jun-2014]
 Select the slide(s) that we want to hide in the slide show.

 Choose Slideshow  Show / Hide Slide

 The slide number is struck out but it is not removed from our presentation.

110. How will you print a Slide to Fit a Paper Size? [Sep-2014]
 We can reduce the size of a slide when we print so that the slide can fit on a printed page. 

 Open the document that we want to print.

 In Normal View, Choose Format  Page, and then Page tab.

 In Layout settings area, select the Fit object to paper format check box.

 In the Paper format area, select a format.

 Click OK.

 The slide is resized to fit the printed page, while maintaining the relative positions of the objects
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VOLUME II     TWO & THREE MARKS   
CHAPTER 1 -12  

 
 

CHAPTER 1: OBJECT OREINTED CONCEPTS USING C++  
 
1. Define Object?  

 The group of data and the operators together are termed as ‘object’.
 An object is a group of related functions and data that’ serves those function.
 An object is a kind of a self – sufficient “sub - program” with a specific functional area.

2. Define Encapsulation?  
 The Mechanism by which the data and functions are bound together within an object 

definition is called as Encapsulation.
3. Define Polymorphism?  

 The ability of an object to respond differently to different messages is called as 
Polymorphism.

 Polymorphism reduces software complexity, as multiple definitions are permitted to 
an operator or function.

4. Define Inheritance?  
 The Process of acquiring the Base class properties is what is called Inheritance.
 Inheritance allows a class to be derived from an existing class of updated modules to meet the 

requirements of the dynamic world.
5. Write the Advantages of Oops?  

 Class data type allows programs to organize as objects that contain both data and functions.
 Data hiding or Abstraction of data provides security to data, as unrelated member 

functions (functions defined outside the class) cannot access its data or rather it reveals 
only the essential features of an object while curtailing the access of data.

 Polymorphism reduces software complexity, as multiple definitions are permitted to 
an operator or function.

 Inheritance allows a class to be derived from an existing class, thus promoting reusability of 
code, and also promote insertion of updated modules to meet the requirements of the dynamic 
world. 

 
CHAPTER 2: OVERVIEW OF C++ 

6. Define Tokens. Give Example? 
 A Token is the smallest individual unit in a program. Tokens are classified in to five types. 

 
 
 
 
 
 
 
 
 
7. Define Keywords. Give Example?  

 Keywords are special meaning to the Language Complier. These reserved words 
for special purpose.

 These words cannot be used as normal identifiers. 
Example:  

 Auto, Break, default, new, friend.
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8. Define Identifiers. Give example?  

 Identifiers are also called as variables. Variables are memory boxes that hold values or 
constants. A variable name must begin with an alphabet or underscore followed by 
alphabets or numbers. 

Example: 
 test ; exam_no ;  sum12  are some valid identifiers.


9. Define Constant?  

 Constants are data items whose values cannot be changed during the execution of the 
program. A constant is of numeric or non-numeric type. Numeric constants consist of only 
numbers, either whole numbers or decimal numbers. Integer, floating-point are numeric 
constants.

 A constant is a numeric or non-numeric type
Eg:  20 , “Bjarne” , ‘s’


10. Write about Escape sequence?  

 Non graphical characters are called as escape sequences. Escape sequences are represented 
using characters prefixed with a backslash.

 Certain special characters like tab, backspace, line feed, null, backslash are called as non-
graphic character constants 

Example: 
Escape Sequence Non Graphic Character 

\a Bell 
\0 Null 
\n New Line 
\b Back space 

 
11. Write note on String Literal? 

 String Literal is a sequence of characters surrounded by double quotes.
 String literals are treated as array of characters. Each string literal is by default added with a 

special character ‘\0’ which marks the end of a string. 
Example: 

 “testing”

12. Which operator are specific to C++? 

 The operators that are specific to C++ are 
:: - Scope resolution operator. 
.* - Dereference operator. 

->* - Dereference pointer to class Member. 
 
13. How are operators classified based on operator requirements? 

 Based on operand requirements operator are classified as
 Unary operator require one operand


 Binary operator require Two operand


 Ternary operator require Three operand





14. List out the relational operator associated with C++? 
 Relational Operators are used to compare values. The list of relational operators are

 
= =  equal to
> greater than


<  lesser than


>= greater than or equal to 
 <= lesser that or equal to


!=  not equal to 
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15.  Explain Conditional Operator or ternary operator. Give Example?  

 A ternary operator ( ?:) is also called as conditional operator. 
 The general syntax is E1 ? E2 : E3 where E1,E2,E3 are operands. E1 should essentially be 

of scalar type, E2 and E3 are values or statements.
 

 max = (num1 > num2) ? num1 : num2;


 The variable max will take the value of num1 if num1 is greater than num2, otherwise 
max will be assigned with the value of num2.


16. Write note on Assignment operator?  

 = is the simple assignment operator. It is used to assign the result of an expression (on the 
right hand side) to the variable (on the left hand side of the operator). In addition to the 
simple assignment operator, there are 10 ‘shorthand’ assignment operators 

Example:  
 a = 5; b 

+ = 5;

17. List any four Punctuators in C++ and write a line about them? 
 

 Punctuators are characters with a specific function  
Punctuators Purpose 

 

  
 

; Terminates a C++ statements 
 

  
 

{ } 
Used to group a set of C++ 

 

statements  

 
 

‘ ’ Used to enclose a Single Character 
   

“ ”  Used to enclose a Double Character 
 
 

18. What is Data type in C++? Write its types.? 
 Data types are the kind of data that variables hold in a programming language.
 Data is grouped into different categories for the following two reasons.

 The compiler may use the proper internal representation for each data type.


 The programmer designing the programs may use appropriate operators for each data type.


 They can be broadly classified into the following three categories.
 User defined type
 Built-in type (Primary data types)


 Derived type





19. List out the User defined datatype? 
 Structutre
 Union
 Class
 Enumeration
 Type def


20. What are the four storage specifiers in C++? 

 
 The four storage specifiers are Auto, Static, Extern and Register. 3
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21. Write Type definition. Give Example? 
 Type definition is one of the user defined data types.
 Type definition allows the users to define a variable that would represent an existing 

data type.
Syntax: 

typedef data_type user_defined_data_type_identifier; 
EX: 

typedef int marks;  
 In the above example marks is a user defined identifier for int data type 

typedef char grade;


 In the above example grade is a user defined identifier for char data type




22. Write a note on enumerated data type?  
 Enumerated data type helps users in creating a list of identifiers also called as symbolic 

numeric constants of type int.
Syntax: 

enum data type identifier (value 1, value 2, … value n); 
 Example: 

enum working_days (Monday, Tuesday, Wednesday, Thursday, Friday); 
enum holidays (Sunday, Saturday); 

 The identifiers working_days , holidays are user defined data type.

Monday, Tuesday … is the list of values also called as enumeration constants or numeric constants. 
 Users can declare variables of this enumerated data type using the syntax : 

enum identifier variable1, variable2 …,variable n;  
Ex: 

Holidays d1,d2; 
 
23. Give any two uses of void data type? 

 To indicate the a function does not return a value
 To declare a generic pointer


24. What is Derived data type?  

 These are built from the basic integer and floating type (built in type) 
or user defined data types.

 
 int num_array[5] = {1,2,3,4,5};
 chardayname[7][3] = {“Sun”, “Mon”, “Tue”, “Wed”, “Thu”, “Fri”, “Sat”};


25. What are the Pointer variables? Give Example?  

 A pointer is a variable that holds a memory address. Pointers provide the means through 
which the memory locations of a variable can be directly accessed.

 
 In the above example, p is a Pointer variable of type int.


26. What is the use of the operator related to pointer variable?  

 When dealing with pointer data type one needs to know about the address of (&) operator and 
the value at operator (*).


 The asterix ( * ) is
1) Used to declare a pointer variable 
2) Used to display the contents stored at a location ( value at the address operator ) 
3) It is a unary operator. 

 
 

 

www.Padasalai.Net                                                              www.TrbTnps.com

http://www.trbtnpsc.com/2018/02/latest-12th-study-materials-2018.html

www.Padasalai.Net



 
M.VIJAYA KUMAR, MCA.,M.Phil.,B.Ed.,PGDCA., 

 

        Sastra Matriculation Higher Secondary School                          103 
 

27. How is Pointer variable different from ordinary variable?  
 Pointer:

 
Example: 

int*iptr, x; x=5; iptr=&x; 
iptr is a pointer variable which holds the memory address of x.  

 Ordinary variable:
Ordinary variable are memory locations that hold the value.  

Example: 
Int x = 5;  
The variable X holds the value 5. 

 
28. Define Modifiers. Give example? 

 The modifier alters the base data type to yield new data type.
 Prefix the data type with modifier at the time of declaring variable.

Example:
Unsigned, Signed, Long and Short


29. What is the impact of modifiers? 

 unsigned modifies the range of the integer values as the sign bit is also used to store data.
 long increases the bytes for a particular data type, thus increasing the range of values.


30. Write note on Implicit conversion?  

 Implicit conversions: refers to data type changes brought about in expressions by the 
compiler. For example consider the following snippet: 
 float f = 7.6;


 int x = f;



 The value stored in the variable x is 7, as float is converted to int. The compiler does 
this conversion automatically.


31. How are the Pointer variable declared  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

32. Write note on Size of operator?  
 sizeof is an operator . It returns the size (memory requirement) in terms of bytes, of the 

given expression or data type. 
Example: 

int x=10;  
cout<<size of(x); 

It returns the value 2. 
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33. Write note on Type cast?  
 Type cast refers to the process of changing the data type of the value stored in a variable . 

The statement (float) 7 , converts the numeric constant 7 to float type. 
Syntax: 

(data type) <varaible/value> or data type (variable/constant)  
Example: 

x = 8% (int) 7.7; or x = 8% int (7.7); 
 

CHAPTER 3: BASIC STATEMENTS  
 
34. What are the various section of C++? 

 Include files
 Declaration of variables, data type, user defined functions.
 Main( ) function


35. What are Control statements? What are the two main categories of control structures?  

 Program statements that cause a jump of control from one part of a program to 
another are called Control statements.

 
The two main categories of control structures are: 

 Decision Making or Branching Statements


 Looping Statements.




36. What is loop? What are its types ? 
 Loops executes a set of instruction repeated for a certain number of times.
 There are three kinds of loops in C++.

 for loop - Entry check loop 
 while loop - Entry check loop 


 do.. while loop - Exit check loop  
37. What is the Purpose of continue statement?  

 The continue statement forces the next iteration of the loop to take place, skipping any 
code following the continue statement the loop body 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
38. What is the Purpose of break statement?  

 A loop’s execution is terminated when the test condition evaluate to false. Under certain 
situations one desires to terminate the loop, irrespective of the test expression.

 Break statement would exit the current loop only.
 Break statement accomplishes jump from the current loop.
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39. What are the rules for the formation of loops?  
 An outer loop and inner loop cannot have the same control variable, as it will lead to 

logical errors.
 The inner loop must be completely nested inside the body of the outer loop.


40. What is the use of insertion or put to operator? Give example?  

 The operator << is called the insertion operator or put to operator. It directs the constant 
of the variable it its right to the object to its left.

 Example: 
int marks = 8;  
cout<<“\Marks obtained is”<< marks; 

 
CHAPTER 4: FUNCTIONS  

 
41. What are the advantages of Functions?  

 Reduce the size of the program
 Induce reusability of code
 A function can be shared by other programs by compiling it separately and loading 

them together.

42. What is the main purpose of using function prototype?  

 The main purpose of function prototype is to help the compiler to check the data requirement 
of the function

 With function prototyping, a template is always used when declaring and defining a function.

43. Write the general syntax of a function prototype. Give an example?  

 Syntax:
 <type> <function identifier> <(arguments)>;



 Example: 
void fun (char);  
int max (int, int);  
int max (int a, int b); 

 
44. What is Parameters? (or) What are the two methods parameter passing in functions?  

 Parameters are the channels through which data flows from the call statement to the 
function and vice versa.

 In C++, functions that have argument can be invoked by
 Call by value.


 Call by reference.





45. What are the rules for actual parameters?  
 The actual parameters can be passed in the form of constants or variables or expressions 

to the formal parameters which are of value type.


 The actual parameters can be passed only as variables to formal parameters of 
reference type.
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CHAPTER 5: STRUCTURED DATA TYPE – ARRAYS  
 
46. What is an array? Write its different types?  

 An array is a collection of variables of the same type that are referenced by a common name. 
There are two types of array.

 One dimensional – comprising of finite homogenous elements.
 Two dimensional – comprising of elements, each of which is itself a one – dimensional 

array.

47. What are strings? Or What is meant by array of characters?  

 String are otherwise called as literals, which are treated as single dimensional array of 
characters. A characters array(string) should be terminated with ‘\0’ (NULL) character.

 Example: 
Char name[10];  
Char vowels[ ] = {‘a’, ‘e,’ ‘i’, ‘o’, ‘u’};  
Char rainbow[ ] = “VIBGYOR”; 

 
48. What is 2-dimensional array? How can it declared?  

 A two dimensional array is an array in which each elements is itself an array.
Syntax:

 Type  array_id[Rows][Columns];
 Row refers the 1st index and Columns refers the 2nd index.

Example:  
 int marks [3] [4];declare a 2-D array with 3 row and 4 columns
 const int i = 5 ;
 float num [i] [3]declare a 2-D array num with 5 rows and 3 columns.
 Short fine[‘A’] [‘E’]; declare a 2 –D fine 65 rows and 69 columns.


49. Explain the memory representation of 2 -D arrays?  

 A 2-D array is stored in sequential memory block. The elements are stored either.
 row-wise manner (this method is called as row-major order)


 column-wise manner (this method is called as column-major order)



Example:
int sales [2] [4]; will be stored as follows. 
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50.  Write the Syntax for One – dimensional array. Give Example  
 
 
 
 
 
 
 
 
 

Example:  
int num_array [5]; 

 
51. Write the syntax and purpose of the function strlen( )?  

Strlen( )   : This function returns the number of characters stored in the array.  
Syntax: strlen (char *);  
Example  : char name[6] = “ARAVIND” ; strlen(name);  it returns 7. 

 
52. Write the syntax and purpose of the function strcpy( )? 

Strcpy ( ) : This function copies source string to target string,  
Syntax : strcpy (char*, char*)  
Example : strcpy (a,b). This command copies the ‘b’ string into the target string ‘a’. 

 
53. Write the syntax and purpose of the function strcmp?  

Strcmp ( ) : This function Compares the two given strings, and returns 0 if strings are equal, value >0,  
if string 1 is greater than string 2. Otherwise values less than 0. 

 
Syntax : strcmp ( char*, char*);   

Example : strcmp( “Abc” , “Abc”); - returns 0 
 strcmp( “Abc” , “abc”); - returns a value less than 0 
 strcmp( “abc” , “Abc”); - returns a value greater than 0 

 
54. Write about any two string functions in C++? 

 
S.No Functions Uses 

1 strlen ( ) Returns the number of characters stores in the array 
2 strcpy( ) Copies the source string to target string. 
3 strcmp( ) Compares the two given strings. 
4 strcat ( ) Concatenation of two given strings. 

 
55. What is array of strings? Give example?  

An array of strings is a two – dimensional character array. The size of first index (rows) 
determine the number of strings and the size of second index (columns) determines maximum length of 
each string.  

Example: char day_names [7] [10] = {“Sunday”, “Monday”, “Tuesday”, “Wednesday”, 
“Thursday”, “Friday”, “Saturday”} 

 
56. What are the member function of standard input and output stream?  

getline ( ) is a member function of standard input stream. i.e., istream.  
write ( ) is a member function of standard output stream. i.e., ostream.   
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57. Write a note on write ( ) functions.  
Write( ) is a member function of standard output stream, i.e., ostream. All member 

functions of a class, should be accessed through an object/ instance of class. The two parameters 
required for write functions are identifier string characters and number of characters to be displayed. 

Example:  
cout.write(pincode,7); or  cout.write(pincode,sizeof(pincode)); 

 
58. What are the different ways to indicate the dimensions (rows / columns) of 

arrays? The dimensions (rows / columns) of an array can be indicated.  
 Using integer constant.
 Using const identifier of integer or ordinal
 Using char constants.
 Using char identifiers.


59. How array can be passed as arguments to functions?  

 Arrays can be passed on as arguments to functions. The actual parameter 
is Passed only by the identifier, ignoring dimensions.

 Array parameters by default behave like reference parameter as the array 
identifier unlike other identifiers, represents the base address of the array.

 Hence the result in sending an address to the formal parameter. (like 
reference parameters)


60. How to size of 2-D array is calculated? Give example?  

 The Size of the 2-D array is calculated as 
Number of elements * memory required for one element. 

 
For example the size of the array int sales [2] [4]; will be calculated as 

 
 Number of elements = Row X Columns  
   = 2 X  4    
   = 8    
 Size = 8 X 2 (2 byes is required for integer)  
     

  Size =  16 bytes   
     

61. Write the Syntax for gets ( ) and getsline ( )?    
        

 gets ( )    getline ( )  
 Explain:   Explain:  
 To treat spaces as part of string literal.  To treat space as part of the string literal. It  
 It has defined in stdio.h. it has only one is a member function of standard input stream  
 parameter(character array identifier)  (istream).  
 Syntax:   Syntax:  
 gets(char*)    cin.getline(char*no.of.chracters, delimeter)  

 Example:   Example:  
 char name[15];   char name[15];  
 cout<<“\n Enter a name:”;    cout<<“\n Enter a name:”;  
 gets (name);    cin.getsline (name, 7 , ‘*’);  
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CHAPTER 6: CLASS AND OBJECTS.  
 
62. What is a class? Give example?  

 A class is a way to bind the data and its associated functions together.
 A Class new way of creating and implementing a user defined datat type.

Example:
Class student
{

char name [30];
int roll no, marks1, marks2, total_marks;

};
63. What are the two parts of a class specification? 

 
 Class specification
 Class function definitions.


64. What is meant by Data hiding?  

 The members and functions declared under private are not accessible by 
members outside the class, this is referred to data hiding.

 Data hiding is the key feature of object oriented programming. (OOPs)

65. What is data abstraction?  

 Instruments allowing only selected access of components to objects and to 
members of other classes is called as Date Abstraction.

 Data Abstraction is achieved through data hiding.

66. Write the general form of a class and give an example?  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

67. What are the three access specifiers used in a class?  
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68. What is the use of dot operator? Or How are the class members accessed?  
 
 
 
 
 
 
 
 
 
 
 
 
 
69. Write short note on memory allocations of objects?  

 Memory space required for the member variables are only allocated separately 
for each object.

 Separate memory allocations for the object essential because the member 
variables will hold different data values for different objects.


70. Write note on members of a class. Or What are Data members and Members functions of a class? 

Class comprises of members. They are Data members and Members functions.  
 Data Members are the data variables that represents the features or properties of 

a class and data members are also called attributes.
 Member Functions are the functions that performs specific tasks in a class. Member 

functions are called as methods.

71. Write about static data members?  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
72. What is meant by Nesting of member functions?  

 A member functions can call another member functions directly, without using 
the dot operator. This is called as nesting of member function.


73. Write the prototype and example for member function definition for outside the class?  

 The member function defined outside the class has the prototype as 
Syntax: 

 type class_name ∷ function_name( );


Example:  
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74. Write note on Array of objects?  
 We can create array of variables that are the type class. Such variables are 

called array of objects. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
75. What effect does the visibility label private has on the member of a class?  

 Specifying private visibility is optional, by default the members will be treated 
as private if a visibility label is not mentioned.

 The members that have been declared as private, can be accessed only from 
within the class.

 Private members are not inherited but they continue to exist in the derived class.

76. What are the characteristics of member functions?  

 Several different classes can use the same function name. The ‘membership’ label 
will resolve their scope.

 Member functions can access the private data of a class. A non – member 
function cannot do so.

 A member function can call another member function directly, without using the 
dot operator. (This is called nesting of member functions).

 The member functions can receive arguments of a valid C++ data type. Objects 
can also be passed as arguments.

 The return type of a member functions can be of object data type.
 Member functions can be of static type.

77. Explain the method of creating objects?  
In C++, the class variables are known as objects or instances. Objects can be created by 

two methods.  
Method 1 : The declaration of an object is similar to that of any basic type.  
Method 2 : Objects can also be created by placing their names immediately after the closing brace of 

the class declaration.  
Method 1 Method 2   

class student 
{  
private:  
protected: 
public:  
};  
void main()  
{student stud;} 

  
class student 
{  
private:  
protected:  
public:  
} stud;  

Here stud is an instance or object of the class student. 
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CHAPTER 7: POLYMORPHISM  
 
78. How are functions invoked in function overloading?  

The compiler adopts BEST MATCH strategy. As per this strategy the compiler will  
 Look for the exact match of a function prototype with that of a function call 

statement.
 In case an exact match is not available, it looks for the next nearest match. That is 

he compiler will promote integral data promotions and then match the call 
statement with function prototype.


79. List out the operator that can be overloaded? 

o Membership operator ( .) 
o Scope resolution operator (∷)  
o Size of ( ) operator  
o Conditional Operator (?:) 


80. What are the various process involved in operator overloading?  

 Create a class that defines the data type that is to be used in the overloading 
operations.

 Declare the operator functions operator<symbol>( ) in the public part of the class.
 Define the operator functions to implement the required operations.


81. What is function overloading?  

 The ability of the function to process the message or data in more than one 
form is called as function overloading. 

Example: 
float area ( float radius);  
float area ( float half, float base, float height); 
float area ( float length, float breadth); 

 
82. What is Operator overloading?  

 The mechanism of giving special meaning to an operator is called as operator 
overloading.

 The term operator overloading, refers to giving additional functionality to 
the normal C++ operator like +, ++, -, --, +=, *, <, >.


83. Define Overloading? 

 The term overloading means a name having two or more district meanings.
 In C++, there are two types of overloading such as function overloading and 

operator overloading.

84. Writ the possible integral promotions while invoking overloaded functions? 

 Integral promoters are purely complier oriented.
 char data type can be converted to integer / float / double
 int data type can be converted to char / double / float
 Float data type to integer / double / char
 Double data type to float or integer
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CHAPTER 8: CONSTRUCTOR AND DESTRUCTOR  
 
85. What are the functions of a constructor?  

 The constructor function initializes the class object
 The memory space is allocated to an object.


86. When is a copy constructor executed? 

 
 When an object is passed as a parameter to any of the member functions 

Example: void add :: put data (add x);
 When a member function returns an 

object. Example: add getdata( );
 When an object is passed by reference to 

constructor Example: add a, b(a);

87. Write the rules for constructor definition and usage?  

 The name of the constructor must be same as that of the class
 A constructor can have parameter list.
 A constructor function can be overloaded.
 The compiler generates a constructor, in the absence of a user defined constructor.
 The constructor is executed automatically.


88. Write the rules for destructor definition and usages?  

 The destructor has the same name as that of the class prefixed by tilde character(~)
 The destructor cannot have parameter list.
 It has no return type.
 Destructor cannot be overloaded i.e., there can be only one destructor in a class.
 On the absence of user defined destructor, it is generated by the compiler.
 The destructor is executed automatically when the control reaches the end of class 

scope.

89. Tabulate the difference between Constructor and Destructor. 

 

 Constructor Destructor   
 

     
 

 Constructor initializes and allocates memory to Destructor removes the memory of an object   
 

 an object   
 

    
 

 Constructor executes automatically when an Destructor executes automatically when an   
 

 object is created object is destroyed   
 

 A class can have multiple constructor Destructor will be only one   
 

     
 

 It has the same name as that of the class It has the same name as that of the class prefixed   
 

 by tilde (~) character   
 

    
 

 A constructor can have Parameter list The destructor cannot have arguments   
 

     
 

 The constructor function can be overloaded Destructor cannot be overloaded   
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90. Match the following for the class ‘my class’. 
 

i) my class( ) - a) copy constructor 
ii) myclass(int x, int y) - b) method 
iii) void show ( ) - c) default constructor 
iv) myclass(myclass & a) - d) parameterized constructor 

Answer:    

i) my class( ) - a) default constructor 
ii) myclass(int x, int y) - b) parameterized constructor 
iii) void show ( ) - c) method 
iv) myclass(myclass & a) - d) copy constructor 

 
 

91. Find the error in the following questions:  
Class simple 

  

Line No
 

  
 

{   
 

   
 

Private: 

AN
SW

ER
 

 3 
 

int x;  
5 

 

simple ( )  
 

  
 

   
 

{    
 

   
 

X = 5;    
 

} 
   

 

   
 

};    
  

 
CHAPTER 9: INHERITANCE  

 
92. What are the types of Inheritance?  

There are five types of Inheritance:  
 Single Inheritance  
 Multiple Inheritance  
 Multilevel Inheritance  
 Hybrid Inheritance  
 Hierarchical Inheritance 

 
 
 
 

Error Correct Code 

Private: public: 

The keyword public Constructor should be 
should be placed declared under public part 
 of the class 
   

 

 
93. What are the Advantages of Inheritance? 

 
Reusability of code :  

 Code developed for one application can be reused on another application if such 
functionality is required. This save lot of development time. 

Code Sharing :  
 The method of the base can be shared by the derived class.

 
Consistency of interface :  

 The inherited attributes and methods provide a similar interface to the Calling 
methods. 
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94. Write the Syntax for creating a derived class from base class? 
The derived class should be indicated as  

Class der_name : visibility mode base class_id  
{  

Data members of the derived_class; 
Members functions of derived_class;  

} 
 

95. What are Abstract class?  
Classes used only for deriving other classes are called as Abstract classes i.e., to say that 

objects these classes are not declared. 
 

96. What is Inheritance?  
The process of acquiring base class properties. It is the most powerful feature of OOP. It 

is the process of creating new class (derived class) from the existing class (base class). The derived 
class inherits all propertied of the base class. 

 
 
 

97. What is Accessibility? or What is Visibility mode?  
An important feature in Inheritance is to known as to when a member of a base class 

can be used by the objects or the members of the derived class. This is called as accessibility. This 
is specified using then access specifiers / visibility mode. The default visibility mode is Private. Three 
access specifiers are Private, Public, Protected. 

 
CHAPTER 10: IMPACT OF COMPUTERS ON SOCIETY  

 
98. What is E – Banking?  

 E – Banking permits banking from the comfort of the home by using internet 
facilities.


 It has truly improved the reach and services of banks. It saves time and man 
power. 

 
99. What is E – learning?  

 E – Learning enables Online education programs leading to degrees and 
certifications.

 There are many e – learning packages such as CBTs / WBTs are available for this 
purpose. The people can learn themselves from their own places and at any time.


100. What is ATM?  

 ATM – Automatic teller Machine
 ATM is an Advanced machine which enables withdrawal of money from the 

accounts in a particular bank anytime and anywhere.
 This helps the user in emergency situations where money is needed during the 

night time and holidays.
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101. How are the computers are used in areas of Educations? 
Computers are used in many areas of Education including: 

 
 Buying and browsing the latest edition of books by both local & foreign 

authors Educational CDROMs
 Computer Based Tutorials (CBT).
 Spreading information about schools, colleges, universities and courses 

offered, admission procedures, accommodation facilities, scholarships, 
educational loans, career guidance.

 e-Learning that enables online educational programs leading to degrees and 
certifications.


102. What are Emotion containers?  

 Emotion containers are small compartments with a screen, speaker and scent to 
drive emotional comfort. This can prevent people from acquiring bad habits.


103. What is the use of memo frame?  

 Easy interaction with other people through touch screen, scanner and microphone 
facilities.


104. What are the three technical elements we need to reach out benefits of IT to the common name.  

 Connectivity ( computer networks and internet facility )
 Affordable computers or other similar devices.
 Software

105. Define E – shopping?  
 One can purchase any product, any brand, any quantity from anywhere through 

e – shopping.
 He need not go to the shop. The pictures and other details of what can be 

purchased are available on the websites of the shop. He has to select and order.
 Advance payment for these items is assured by various methods. Credits cards 

and Prior registration with the shop are the popular methods. The items 
purchased will be delivered at home

 
CHAPTER 11: IT ENABLED SERVICES  

 
106. What is meant by IT Enable services?  

Information Technology that helps in Improving the quality of services to the 
user is called IT Enabled Services.(ITES). It enabled services are human intensives services that are 
delivered over tele communication networks or the internet to a range of business. 

 
107. What is the Use of Call centers?  

 A call center is sometimes defined as a telephone based shared services center for specific 
customer activities and are used for customer – related functions like marketing, selling, 
information, transfer, advice and technical support and so on.

 A call center has adequate telecom facilities, trained consultants and access to wide database, internet 
and other on – line information support to provide information and support services to customers. It 
operates to provide round the clock and year round the service i.e., 24 x 365 services.
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108. What is Data Management?  
 Data management is a category of IT enabled services pertaining to collections, digitization 

and processing of data coming from various sources.
 Traditional data processing services comprises punching data from manually filled forms, 

images or publications, preparing databases and putting them together.


109. What are the benefits of data digitization?  
 Long term preservation of the documents.
 Storage of important documents at one place.
 Easy to use and access to the information.
 Quick and focused search of relevant information in terms of images and text.
 Easy transfer of information in terms of images and text.
 Easy transfer of information through CD-ROM, internet and other electronic media.


110. What are Data Digitization? 

 Digitization refers to the conversion of non-digital material to digital form.
 A wide variety of materials as diverse as maps, manuscripts, moving images and sound 

may be digitized.


111. What is Medical Transcription?  
 Medical Transcription is a permanent, legal document that formally states the result of 

a medical investigation.
 It facilitates communication and supports the insurance claims. The Process involved here 

is the conversion of audio format into text format.
 There are three main steps involved in medical transcription.


112. Mention IT enable services. 

 e – Governance
 Call centers
 Data Management
 Medical [ Telemedicine and Transcription ]
 Data digitization
 Web site services


113. What is e – Governance ? 

 Computers help you to look at the government websites and the services provided by them.


 The various websites provided by the government give the details about the departments, 
specific functions, special schemes, documents, contacts, links, IAS intranet, site map, 
search, what’s new, press releases, feedback.


 These websites are both in English and Tamil.

 
 

CHAPTER 12 : COMPUTER ETHICS  
 

114. What is Piracy? 
 Making and using duplicate hardware and software is called as Piracy


 Without the Knowledge of the concerned company or without any payment the access 

or duplicating of software / hardware is called as piracy
 x 
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115. List out some of the common computer crimes? 
 Crimes related to money transfer on the internet
 Making long distance calls illegally using computers
 Illegal access to confidential files
 Stealing hardware
 Selling or misusing personal
 Hardware and software piracy
 Virus
 Cracking
 Theft of computer time


116. What is a Computer crime?  

 A Computer crime is any illegal activity using computer software, data or access as the 
object, subject or instrument of the crime.
Example: Virus, Cracking, Piracy


117. What is called as “ Theft of Computer” ?  

 Most of the computer in an organization have a lot of free computer time to spare. 
Many solutions for using this spare time are being researched.

 The ideal time of computers in an organization is being stolen illegally. Some other 
software runs on ideal computer without the knowledge of the organization . This is called 
as “theft of computer”.


118. What are Ethics?  

 Ethics is the set of rules for determining moral standards or what is considered as 
socially acceptable behaviors.

 The general guidelines on computer ethics are


 Protection of personal data.
 Computer crime
 Cracking



119. What is cracking? What are the reasons for combining this crime?  
 Cracking is the illegal access to the network or computer system.
 Illegal use of special resources in the system is the key reason for crackling.
 The resources may be hardware, software, files or system information.
 Revenge, business reasons and thrill are other common reasons for committing this crime.


120. What is Computer virus?  

 A virus is a self-replicating program that can cause damage to data and files stored on 
your computer. These are programs written by programmers with great programming skills who 
are motivated by the need for a challenge or to cause destruction. 57000 known virus programs are 
in existence. 6 new viruses are found each day.

 
****************************************************************  
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VOLUME-I [ 5-MARKS ] 
 

1. AN INTRODUCTION TO STAROFFICE WRITER 
 

1. Explain the different ways of selecting text in star office writer document. (or) How will you select 
the required portion of the text in a document using mouse, keyboard and shortcuts?     

 
 
SELECTING TEXT: 

 Even though the document is built up by typing one character at a time, while editing and formatting 

one always work with words, lines, paragraphs and sometimes with the whole document. 

 For this purpose one should learn how to select the text. Once the text is selected, change can be made 

to that text. 

 The text can be moved, copied and made as bold. The font and color of the text can also be changed. 

 For selecting text the mouse or the keyboard can be used. 

 
1. Selecting Text with Mouse: 

Following steps are to be followed: 

1. Insertion point is moved to the start of the text to be selected. 

2. The left mouse button should be clicked, held down and dragged across the text to be selected. 

3. When the intended text is selected, the mouse button should be released. 

4. To unselect the wrongly selected text a click should be made outside the selected text. 

 
2. Selecting Text with Keyboard: 

Following are the steps to be followed: 

1. Insertion point is moved to the start of the text to be selected. 

2. The Shift key is pressed down and the movement keys are used to highlight the required text. 

3. When the Shift key is released, the text is selected. 

 
SELECTION SHORTCUTS: 

The following shortcuts can also be used for selection. 

ACTION TO BE PERFORMED   : TO SELECT WHAT 

Double click on a word   -  To select a word 

Click once next to the line   -  To select the particular line 

Press Ctrl + A     -  To select the entire Document. 
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2. Give the steps involved for replacing a word with another word in a given text and explain. (or) Write the 
steps to be followed to find and replace a given text (or) How will you find and replace a given word in star 
office writer document?    
 
Finding and Replacing Text: 
 

You can use the Find & Replace feature in Star Office Writer to search for and to replace words in a text 
document. 
 
To Find and Replace Text 
 

1. Choose Edit → Find & Replace. The Find & Replace dialog box appears on the screen. 
2. In the Search for box, type the text that you want to find in your document. 
3. In the Replace with box, enter the replacement word or phrase. 
4. Click Find to start the search. 
5. When Writer finds the first instance of the word or 
phrase, do one of the following: 
 To replace the found instance of the text with what 

you entered in the Replace with box, click 
Replace. 

 To replace all instances of the text with what you 
entered in the Replace with box, click Replace All. 

 To skip the found text and to continue the search, click 
Find again. 

6. Click Close when you have finished the search. 
 

3. Explain Moving the Text & Copying the Text. 
 

Moving the Text: 

The selected text can be easily cut and pasted in the required location. Following steps are to be followed. 
 

1. The text to be moved to a new location is selected. 
2. Edit → Cut is selected or  in the tool bar is selected to cut the selected text. 
3. Insertion point is moved to the place where the text is to be pasted. 
4. Edit → Paste is selected or  in the tool bar is selected to paste the text in the new location. The text 
can also be pasted in this way to another or another type of document. 
 

The following keyboard shortcuts can be used to move text. 
 

Ctrl + X → to Cut 
Ctrl + V → to Paste 

 

Copying the Text: 

1. The text to be copied is selected. 
2. Edit → Copy is selected or  is clicked. 
3. The insertion point is selected where the copy of the text should appear and is  clicked. 
 

The following keyboard shortcuts can also be used for copy and paste: 
 

Ctrl + C → to Copy 
Ctrl + V → to Paste 
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2. TEXT FORMATTING 

 
1. How will you indent a given text by using paragraph dialog box? [Mar-09, Mar-12, June-12] (or) How will 
you indent a given text by using paragraph dialog box and by using formatting tool bar?   
           
 

Indenting Text with the Toolbar 
 
 If a left indent is required - useful for setting off a paragraph from the main body text - the toolbar can 

be used to set the indent. 
 Click the Increase Indent  icon; the paragraph is indented 1/2 inch from the left margin. The button 

again can be clicked to increase the indent. 
 Each time the button is clicked, the paragraph is indented another 1/2 inch. 
 If the indent is too much or if one wants to undo the indent, the Decrease Indent  icon is clicked to 

decrease of undo the indents. 
 
Indenting Text with the Paragraph Dialog Box 
 
1. Move the insertion point to the beginning of the paragraph to be indented. To indent several paragraphs, 
select those paragraphs. 
2. Select Format → Paragraph command. Now paragraph dialog box appears on the screen. 
3. Click the Indents & Spacing tab in the Paragraph dialog box 
4. Do any of the following. 

 To indent from the left, type the amount to be indented in the Before text spin box or use the 
spin arrows to select a value. 

 To indent from the right, type the amount to be indented in the After text spin box or use the 
spin arrows to select a value.  

 Click the OK button. 
 The First line option can be used to indent the line of the paragraph. Using the spin arrows, if a 

positive value is specified, the first line will be indented. 
 A negative value will result in a hanging indent; that is, the first line will hang outside the 

paragraph. 
 
2. What are the various types of paragraph alignment that can be made? Explain.   
 
Paragraph Alignment: 
 In addition to formatting individual chunks of text, one can also format the paragraphs. One of the most 

common changes is to change the alignment of a paragraph. 
 A paragraph is any text followed by a hard return. A hard return is inserted every time when Enter is 

pressed. 
 Soft returns are inserted as line breaks by StarOffice Writer and are adjusted when text is added or 

deleted. 
 A single line, for instance, can be a paragraph. One can apply the paragraph formatting options to a 

single paragraph or to several paragraphs 
 Also, each time Enter is pressed, the paragraph options for that paragraph are carried down to the next 

paragraph. 
 

 When typing in StarOffice Writer, all text is left aligned, and the right margin is ragged or uneven. 
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 Four types of alignment can be selected, and the best way to make a change is to use the Formatting 
toolbar. Following steps are used to align the text: 

 

 
1. To change the alignment of one paragraph, first click within that paragraph. To change the 

alignment of several paragraphs, select the ones needing change. 
 

2. Do one of the following 

Click the icon   to left align text. 
Click the icon   to right align text. 

Click the icon   to justify text. 

Click the icon   to center text. 
 

The following keyboard shortcuts can also be used to change the alignment. 
 

To make the text as Left-aligned press Ctrl + L 
To make the text as Right-aligned press Ctrl + R 
To make the text as Centered press Ctrl + E 
To make the text as Justified press Ctrl + J 

 
 
3. How will you create a numbered list and bullet list in StarOffice writer document? 
 

Creating Bullets and Numbered List 

 When the document presents a matter using text in the form of long paragraphs the reader may not 
be able to quickly notice the important points or messages. 

 For this purpose bullets and numbers are used to list the important points and messages. 
 StarOffice Writer automatically numbers all the items in a list, and the text is indented. 

 
Following steps are used to create a Bulleted list: 

 Select the text that to which bullets are to be added. The StarOffice Writer will add bullets to each 
paragraph within the selection, and not to each line. 

 StarOffice Writer will add bullets to any blank lines within the selection. 

There are two ways to add the bullets for the paragraph, 
 

1. Click on the Bullets icon  from the formatting tool bar, to creates a bulleted list. 
2. Choose Format → Bullets and Numbering, command can also be add various types of bullets to the 
paragraph. 
 

Following steps are used to create a Numbered list: 

 Select the text that to which numbers are to be added. The StarOffice Writer will add numbers to 
each paragraph within the selection, and not to each line. 

 StarOffice Writer will add numbers to any blank lines within the selection. 
 

 There are two ways to add the numbers for the paragraph, 
1. Click on the Numbering icon  from the formatting tool bar, StarOffice Writer creates a 

Numbered list. 
 

2. Choose Format → Bullets and Numbering, command can also be add various types of 
Numbers to the paragraph. 

 

Removing the Bullets or Numbers 
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 To remove bullets from a list, the list is selected and the Bullets button is clicked again. 
 To remove numbers for a list, select the list and click the Numbering button. 

 
 

 
4. What are the formatting changes that can be made with respect to the fonts? 

 

Formatting Options 
 StarOffice Writer offers a number of choices for formatting such as bold or italics, and defining the 

font, type, and font size. 
 Bold, italic or underlined are the most common types 

of text formatting. 
 Almost all the formatting options are available 

under Format menu. 
. 

 Alternatively Ctrl + B, Ctrl + I and Ctrl + U keys can be used to makethe selected text bold, italic 
and underlined respectively. 

 The same can also be achieved by clicking on Format → Character and then selecting an option 
from the Typeface list box. 

 

1. Changing the Fonts: 

 A font is a set of characters and numbers in a certain style. Each font looks different from other 
fonts. 

 Some fonts, like the Times New Roman, look professional and are suited for business documents. 
 Some fonts, like FAJITA, are decorative. Some fonts, like Symbol and Wingdings, are actually 

sets of symbols. 
Method 
 Click the down arrow in the Fonts Combo box  of font tab in Character dialog box. 
 The text changes to the selected font type 

 

2. Changing the Font Size 

 The size of the text is also important. 
 The size of a font is measured in points, and there are 72 points to an inch. 

Method 

 Click the down arrow in the Size combo box  of Fonts tab in Character dialog box. 
 The text changes to the selected font size 

 

3. Changing the Font Colour 
 A different colour for selected text can be used.  
 In the absence of a colour printer, the document will be displayed on screen in colour. 
 But these changes will be printed as shades of gray on a black-and-white printer. 

Method 
 To use a different text color, select the text and click the arrow in the Font Colour icon  .  A 

colour palette is displayed from which the required colour can be selected 
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3. CORRECTING SPELLING MISTAKES 

1. How would you carry out the spell check after the entire document is typed?  
 
Checking the Spelling after the Document is Typed 
The following steps are used for a spell check. 
 Tools → Spelling → Check is selected or icon is clicked. To check a part of the document only 

that portion is selected. 
 The F7 key may also be pressed to select the spelling command. 

 
 Not in dictionary text area 

displays the misspelled word and 
the Suggestions list displays any 
alternative spellings. 

 
Any of the following can be done: 
 To skip this occurrence but stop on 

the next one. Ignore Once 
button is clicked. To skip all 
occurrences of this word. 
Ignore All button is clicked. 

 To replace the word with one of the selected spellings, in the suggestions list that spelling is 
clicked, and Change button is clicked to change this occurrence and Change All button is clicked 
to replace all occurrences of the world. 

 If none of the replacements is correct, correction can be made manually in the Not in dictionary 
text area. Add button is clicked to add the word to the dictionary.  

 
2. How will you add an entry to the auto correct list in star office writer?   

AutoCorrect Option 
 In addition to flagging some words, StarOffice Writer will automatically correct some spelling 

mistakes. 
 StarOffice Writer recognises some common misspellings and typographical mistakes and makes 

the replacement automatically. 
 For instance, if a word is typed as “teh”, StarOffice Writer automatically replaces this with the 

correct word “the”. 
 In addition to the ones StarOffice Writer automatically corrects, the user can add other words to the 

list. 
Add a word in the auto correct list: 
 

 If the error and its correction are to be added to the Auto Correct list the following command is 
used Tools → AutoCorrect, now auto correct dialog box appears on the screen. 

 

 In this box, with the Replace tab selected the word to be replaced is typed in the Replace text box 
and the replacement word in the With text box. 

 When the same mistake is made StarOffice Writer will automatically replace the misspelled word 
with the correct spelling. 
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4. WORKING WITH TABLES 
 

1. Draw and explain the various function icons in the table formatting toolbar in a star office writer 
document? 
 
Table Formatting Toolbar 

Once a click is made inside a table a floating toolbar for tables appears at the top of the screen. 

 
 
 
 
 
 
 
The function of each icon in the toolbar is indicated below: 
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2. How will you add and delete rows, columns in a star office writer table?  
 
Creating a Simple Table 
 

 Table → Insert → Table command is used to create the simple table 
 StarOffice Writer displays the table as a grid with the specified number of columns and rows. 
 By default each cell includes a border. 

 

Adding Rows: 

 The simplest way to add a row is to press Tab in the last row of the table. 
 Choose Table → Insert → Rows command can be used to insert more than one row in a table. 
 Also click the  icon is used to insert a row below the current row. 

 
 

Adding Columns: 

 Choose Table → Insert → Columns command can be used to insert more than one column in a 
table. 

 Also click the  icon inserts a column to the right of the current column. 
 

Deleting Rows: 

 Choose Table → Delete → Rows command can be used to deleting the rows. 
 Also click the  icon deletes the current row from the table. 

 

Deleting Columns: 

 Choose Table → Delete → Columns command can be used to deleting the columns. 
 Also click the icon  deletes the current Column from the table. 

 
 

5. PAGE FORMATTING 
 

1. Explain the methods of changing margins. (or) Write in detail about how to change the 
margins using page style dialog box and ruler.    
 

Changing the Margin 
 Margins control how close StarOffice Writer prints to the edge of the page. 
 The default margins are 1inch top and bottom margins and 1.25 inches left and right margins. 
 These margins work fine for most of the documents. 

 

Using any one of the following methods, margins can be changed, 
1. Page Style Dialog Box 
2. Changing Margins Using Rulers 

 

Page Style Dialog Box 
 If the user knows the exact value for the margins then the page style dialog box can be used to 

make a change. 
The following steps are used: 
 Format → Page command is selected. Page style dialog box appears on the screen. 
 Click the Page tab, if necessary. 
 In Margins group, type the new values in the spin boxes or use the spin arrows to change the value. 
 Click the OK button. 
 Use the Page Preview option in the File menu can be used to see the change. 
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Changing Margins Using Rulers: 
 If the user is not having the exact value for the margins then the Ruler option on the View menu 

can be used to change the margins. 
 
Following steps are used in this method: 
 If the ruler is not displayed in the screen, View → Ruler option is clicked. 
 The gray area of the ruler indicates the margin’s top area. 
 The mouse pointer is then moved in between the gray and white area of the ruler. 
 When the pointer is in the right spot, it changes into a line with arrows on both sides. 
 The margin guide is dragged to a new location. 

 
 
 
2. Explain creating header and footer and adding remarks and insert page numbers in a 
text document.           
 
HEADER AND FOOTER: 
 Header is an area at the top of page. 
 Footer is an area at the bottom of the page. 
 Header and footer are some references remarks added at every page of the document of the top and 

bottom margins respectively. 
 
To Create header: 
 To create a header, the Header tab on the Page Style dialog box can be used. 
 In this dialog box, the Header on check box is clicked. 
 Four spin boxes are also displayed. In those spin boxes the distance of the header from the text 

area, the header height, the distance from the left margin and the right margin are entered. 
 
To Create Footer: 
 To create a footer, the Footer tab on the Page Style dialog box can be used. 
 In this dialog box, the Footer on check box is clicked. 
 Four spin boxes are also displayed. In those spin boxes the distance of the footer from the text area, 

the footer height, the distance from the left margin and the right margin are entered. 
 
To insert page numbers in footer: 
 Click in the header or footer area. clicking on Insert → Fields → Page Number will insert page 

numbers on every page. Normal text can also be included in the header and footer. 
 

 
 

  

www.Padasalai.Net                                                              www.TrbTnps.com

http://www.trbtnpsc.com/2018/02/latest-12th-study-materials-2018.html

www.Padasalai.Net



 
M.VIJAYA KUMAR, MCA.,M.Phil.,B.Ed.,PGDCA., 

 

        Sastra Matriculation Higher Secondary School                          128 
 

6. SPREADSHEET 
 

1. Write the advantages of using Electronic Spreadsheet?    

 Calculations are automated through the built-in mathematical, financial and statistical functions. 
 Accurate results to any desired level of decimal points are possible Worksheets can be quite big in 

size 
 Any part of the worksheet can be viewed or edited. 
 Worksheet can be saved and retrieved later. 
 Any part or whole of an existing worksheet can be merged with any existing or new worksheet. 
 Any part or whole of the worksheet can be printed in a desired format. 
 Worksheet data can be viewed in the form of graphs or charts 
 The worksheet information can be transferred to any database or word processing software. 

 
 
2. What are functions? How can you use them in your worksheet? Explain with an example?  
    
Using Functions: 
 StarOffice Calc has a wide variety of functions that allow you to perform several frequently done 

calculations. 
 Functions are predefined formulae that are available in StarOffice Calc. 

 

To insert a function: 

 To select a function, go to Insert menu and Select the Function option. The Function Wizard dialog 
box appears. 

 A list of all functions is displayed in the Function box when All is selected in the Category box. 

 
To select a function: 
 
 Select the category in the Category box. 
 
 Scroll down the list to find the function you 

want. Click once on the function 
 name to see a short description of that 

function on the right side of the window. 
 Double – click on it to insert it into the 

worksheet. 
 

 fx  The Function Wizard shortcut icon on the formula bar can also be used to select and insert 
functions. 

For example, 
 To insert the SQRT function, place the cursor in the cell where you want to insert the function and 

click on the Function Wizard icon. 
 Select Mathematical from Category. 
 Select the SQRT function from the list of functions, which appears by double clicking on it. 
 Enter the number 64. When you click on OK, the result is displayed in the cell in the worksheet is 8. 

 Σ  One of the most commonly used function is the Sum function. This function calculates the sum of a 
given set of numbers. 
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3. List out the Applications of Spreadsheet. 

 Payment of bills 
 Income tax calculations 
 Invoices or bills 
 Account Statements 
 Inventory Control 
 Cost-Benefits Analysis 
 Financial Accounting 
 Tender Evaluation 
 Result analysis of students 

 

 
4. Explain the procedure to insert a chart in a worksheet? (or) What spread sheet feature 
allows you to represent data visually as a data – analysis tool? (or) Describe the steps to be followed 
for presenting the data in the worksheet in the form of charts (or) Explain the procedure to be 
followed to draw chart.    
 
Working With Charts: 

 One of the most popular features of StarOffice Calc software is the ability to generate charts based on 
numeric data. 

 The purpose of chart is to visually present the data for easy understanding. 
 
To draw a chart, follow the procedure given below: 

 Select the data you want to chart. 
 Click on Insert → Chart or click on the Insert Chart icon 
 The cursor becomes a + sign with a small picture of the graph. Place this cursor where you want to 

insert the chart and click. 
 The Auto format Chart window appears on the screen.  
 It prompts you to enter the area in the worksheet to be charted. Enter the range as C3 : F7 and click 

Next. 
 The next window displays the different types of charts that can be created along with a preview of 

each. Select the type of chart in which you want to present the data. The preview window shows the 
chart. Click on Next. 

 For each type of the chart (say Pie, Bar, Column, etc.), there are different formats available. 
 These formats are displayed in the next window a preview of the each format is also displayed. Here, 

select the desired format. Click on Next. 
 In the next window, you have provisions to give a Title for the chart, Titles for X and Y axes and 

legends. 
 Click on Create. Now, your worksheet will display with a chart.  

 
 
 
 

5. How can you generate a series of values? Explain with an example? (or) Explain the fill command 
in StarOffice calc?     
 
 
  

 AutoFill automatically generates a data series based on a defined pattern. 
1. On a sheet, click in cell, and type a number. 
2. Drag the fill handle in the bottom right corner of the cell across the cells that you want to fill, and 
release the mouse button. 
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 Fill command to generate a series of data directly from the values of the selected cells. First, select the 

cells of the worksheet that you want to fill.  Choose the command Edit→ Fill → Series. Select the 
type of series from the options 

 
As another example, select the range A1:D6 in the worksheet. 
 Click on Edit →Fill → Series. Choose 
 2 as your Start value 
 2 as your Increment 
 Growth as the Type, and 
 Down as the Direction. 
 Now, click on OK button.  

 
 

 

6. How will you insert cells, rows and columns in staroffice calc? (or) How will we insert an empty 
cell in a worksheet?      

  
Click the Insert Cell from View → Toolbar menu. 
 A floating toolbar with four icons appears.  
 These icons are,  

o Insert Cells Down 

o  Insert Cells Right  

o Insert Rows 

o  Insert Columns  
 

Insert Cells Down: 
 

 In order to insert an empty cell in a column and move the existing cells down, place the  
cursor in the cell where you want to insert the new cell and click on the Insert Cells Down 
icon. 

 For example, in the Marks worksheet, to insert a cell in D4 and move the contents of the 
cell D4:D7 down, select D4 and click the icon. 

 
Insert Cells Right 
 
 In order to shift the content of a cell to the right and to create an empty cell, select the cell 

and click the Insert Cells Right icon. 
 For example, suppose that the data in the fifth row of the Marks  orksheet has to be shifted 

from C5-F5 to D5-G5. To do so, select the cell C5 and click the icon. 
 
Insert Columns 
 
 In order to insert a column, select the column where you want to insert and click the Insert 

Columns icon.  
 For example, to insert a new column between E and F in the Marks worksheet, select the 

column F and click the icon. 
 
Insert Rows 
 
 In order to insert an empty row in a worksheet, select the row where you want to insert the 

new row and click the Insert Rows icon.  
 For example, if you want to insert a new row between rows 4 and 5 in the Marks worksheet  

select the row 5 and click the icon.  
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7. What are the various formatting options available in staroffice calc? (or) How to format the 
worksheet?          
 

 
Listed below are some of the formatting options available in Star Office Calc. 

 
 

 
  

 The Format menu can also be used to format cells. To do so, select the cells you want to format 
and click on Format → Cells. 

 

 
 
8. What are the various icons in the insert object floating tool bar of worksheet? Mention 
their functions and uses.     
 
Inserting Objects: 
 StarOffice Calc provides tools for inserting objects like charts, images from image editor, formula, 

etc. in a worksheet. 
 For this purpose, click on the Insert Object from View → Toolbar. 

 
A floating toolbar appears with the following icons in the order listed below: 

1. Insert Chart Icon 
2. Insert Formula Icon 
3. Insert Floating Frame Icon 
4. Insert Movie and Sound Icon 
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5. Insert OLE Object Icon 
6. Insert Applet Icon 

 

Insert Chart Icon 
 This icon is used for presenting the data in the worksheet in from of charts of different kinds such 

as Bar Chart, Pie Chart, Lines, XY plot, etc. 
 

Insert Formula Icon 
 This icon is used for inserting a formula in the worksheet for performing calculations. 

 
Insert Floating Frame Icon 
 This icon provides to generate a scrolling screen within a worksheet. 

 

Insert Movie and Sound Icon 
 This icon is used to insert sound or video files into the current worksheet. 

 

Insert OLE Object Icon 
 This icon is used to insert objects from other application into a worksheet. 

Insert Applet Icon 
 This icon is used to import Applets written in Java programming language into the worksheet. 

 

 
 
9. Explain the different types of operators in star office calc?  
 

Types of operators in star office calc: 
Various types of operators available in staroffice calc. 

1. Arithmetic Operators: 
These operators return numerical results 

7.  
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8.  

9.  

 
10. Explain the procedure for Inserting a Picture or a Special character in a worksheet. 
 

Inserting Pictures and Special characters 

In the worksheet, StarOffice Calc also provides for inserting pictures and special characters like á, â. 
For inserting a picture or a special character in a worksheet follow the procedure given below 
 
 Place the cell pointer in any cell, say B2. 
 Choose Insert →Picture →From File. The Insert 

Picture dialog box appears. 
 In the File name combo box, you can type the path 

of the file that contains the picture or you can 
directly select the desired file from the gallery 
directory of StarOffice. 

 After selecting the picture file click Open. 
 

 For example, select Apple file from the gallery directory and click Open.  

Inserting Special characters 
 For inserting special characters, click the Insert →Special characters from the menu bar 
 Select the desired special characters from the Special Character dialog box. 
 For example, select to from the Special Character dialog box and click the OK button. 

 
 

  

www.Padasalai.Net                                                              www.TrbTnps.com

http://www.trbtnpsc.com/2018/02/latest-12th-study-materials-2018.html

www.Padasalai.Net



 
M.VIJAYA KUMAR, MCA.,M.Phil.,B.Ed.,PGDCA., 

 

        Sastra Matriculation Higher Secondary School                          134 
 

7. DATABASE 
 

1. Explain different database types. (or) Explain the classifications of database?  
 

    Database Types: 

Based on the conceptual structures, the databases can be classified as follows: 
 

1. Flat – File database 
2. Relational database 
3. Hierarchical database 
4. Network database 
5. Object-Oriented database 

 
Flat – File Database 
 A database file that consists of a single data table is a Flat-file database. 
 Flat-file database can be quite useful for certain single user or small-group situations, especially for 

maintaining lists such as address lists or inventories. 
 Data that is stored, managed, and manipulated in spreadsheet is another example of a flat-file 

database. 
 
Relational database 
 A relational structure represents a database made up of a set of related tables. 
 In a relational database, one or more common fields existing in two or more tables create a 

relationship between these tables. The common field or fields are called the Keys. 
 A primary key is a key that uniquely identifies a record in a database table. 
 In relational databases, a primary key can consist of one or more fields. 
 The relational database structure is the most prevalent database in today’s business organizations. 

Hierarchical database 
 

 The hierarchical database structures were primarily used on Main Frame computers. 
 In hierarchical databases, records are organized in a tree like structure by type. 
 The relationship between record types is said to be a parent-child relationship, in which any child 

type relates only to a single parent type. 
 
Network database 
 

 The Network database is very similar to the hierarchical structure except that any one record type 
can relate to any number of other record types. 

 
Object Oriented database 
 

 An Object Oriented database is a newer structure that has been generating a great deal of interest in 
recent years. 

 The object oriented structure groups data items and their associated characteristics, attributes, and 
procedures into complex items called objects. 

 An object is defined by its characteristics, attributes and procedures. 
 A procedure refers to the processing or handling that can be associated to the object. 
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2. Explain manipulation of a database? (or) What are the ways of manipulating a database?  
    
Manipulation of a Database: 

We may manipulate the database in one or more of the following ways: 
1. Searching 
2. Sorting 
3. Merging 
4. Performing Calculations on data 
5. Filtering 
6. Editing the database 
7. Report Generation 

Searching 
 Searching is a process to select a desired specific data from a database. 
 For instance, you want to select the student ranking first in a class with respect to the total marks. 
 Searching is done using database commands on the relevant fields. 

 
Sorting 
 Sorting is the process of arranging the data in a table in some order. 
 In the case of the student database, you may sort the passed students and failed students separately 

or you may sort the students in the ascending or descending order of their total marks, and so on. 
 
Merging 
 Merging is a process of joining data from two or more tables of the same or different databases. 
 For example, in a student database, you may have mark lists for different classes. 
 You want to prepare one table that shows all the first ranking students of each class. 

 
Performing Calculations on data 
 You may do any kind of arithmetic calculations on the data stored in the database. 
 For example, to obtain the total marks of all the subjects of a student, you may add the marks in the 

concerned fields of the database and store them in a separate field. 
 
Filtering 
 There are times when viewing the entire table is unwieldy. Filter is a way of limiting the 

information that appears on screen. 
 Filters are a feature for displaying and browsing a selected list or subset of records from a table. 
 The visible records satisfy the condition that the user sets. Those that do not satisfy the condition 

are hidden. 
 
Editing the Database 
 Editing is a process of performing corrections on the existing data, deleting the existing data, 

field(s), or record(s), adding new data, field(s), record(s) or changing the format of the database, 
and so on. 

 
Report Generation 
 You may generate any desired report, from the data of the database. 
 For example, in the case of student database, you may generate a report of all the students who 

have scored marks less than the minimum marks required for a pass, and another report that gives 
the list of passed students, and so on. 
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3. What are the advantages of (EDP) Electronic Computerized Data Processing?     
 
Advantages of Computerised Data Processing: 
 
 Once we collect and enter the data into a computer system, We can perform other operations with 

less manual labour. So, manpower is considerable saved. 
 
 Though it takes some time to develop, test and put the required computer programs to use, the 

processing speed is fast, reducing the processing time, in certain cases, from man-years and man-
months to minutes and seconds. 

 
 The chances of errors are less in computerized data processing. 

 
 We can store large amount of the data and information in the computer storage medium, which is 

compact. Hence, we need not store bundles of paper records, thus saving space. 
 
 Today computer networks are so common that we can share data and resources from one computer 

system to the other at a very fast speed and with very little effort, as in the case of railway and 
airline reservation systems. 

 
 It is easy to edit the data including correction, changes and modifications. 

 
 Computerized database is highly effective for searching, sorting and merging files and for other 

data manipulation activities. 
 
4. Explain how to create form using star office base? (or) Explain the form designing and describe 
how it is used?         
 

A form: 

A form is simply a screen that displays the fields of a record in a well-spaced out manner. 
A form can be associated with a single table or with multiple tables. 

 
To design a form in Star Base, follow the procedure given below: 
 
1. Select Form icon from the <Database> pane and then select ‘Use Wizard to Create Form’. 

 
2. Select the table or query for which the form is to be designed. The field names of the selected table or 

query are displayed in the ‘Available fields’ text area. 
 
3. Select the field names that you would like to include in the form using the > or >> button and then 

click the Next button. 
 

4. Next, StarOffice Base displays ‘Set up a subform’ window. Select the ‘Add Subform’ checkbox, if 
you want to insert another form with within this form else click Next. The Style icons show you how 
the form will look if it is selected. Click on the Style icon and click on the Next button. 

 
5. The next window to selecting the data entry mode. Click on the radio button to choose whether 
       the form is to be used only for entering new data or to be used for displaying all data. 
6. The next window Form Wizard – Apply Styles specifies the form style. The page style decides the 

font attributes like font type, size color and background of the text in the form. The Field border 
specifies the field border style for the form. 

7. Next, Set the name of the form window appears asking for a name for the form. Type the            
name of the form and click the Finish button. 
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5. How can a database be queried in staroffice base? (or) What is query? Write the steps involved in 
generating a query?         
 
Query: 
 Queries are user-constructed statements that set conditions for selecting and manipulating data in 

one or more tables and assembling the criteria-matching data into information. 
 SQL is a special query language for communicating with a database by describing data. 
 Queries are special views of the data in a table. Unlike sort, the output from a query does not affect 

the original table. 
 

To create a query: 
 To create a query in StarOffice Base, right click on Queries in the <Database> pane. 
 On the Tasks pane ‘Create Query in Design view’, ‘Use wizard to Create Query’, ‘Create 

Query in SQL view’ options appears. 
 Click on ‘Use wizard to Create Query’ option. The Query wizard dialog box appears on the 

screen. 
 From the Tables combo box, which contains the list of available tables, select the table on which 

you want to create the query. 
 To select the fields to be included in the query, click on the field in the Available fields Text area 

and then click on the > button. 
 To select all the fields at the same time, click on the >> button. 
 And click on the Next button. Sort Order window appears. 

 

Sort Order Window: 
 This window allows you to specify four fields on which the results should be sorted. 
 The radio buttons on the right allow you to specify if the sort should be in the ascending order or in 

the descending order. Click on the Next button. 
 
Search conditions Window: 
 This window is used to specify the fields and the conditions on which the query should be based. 
 If you want to display the records that satisfy any one of the search criterion then select ‘Match 

any of the following’ or select ‘Match all of the following’ to display records that satisfy all the 
search criterion. 

 Click on the Next button. 
 
Query wizard - Detail or Summary Window: 
 This window specifies whether to display all records of the query, or only the results of aggregate 

functions. Click on the Next button. 
 
Aliases window: 
 This window allows you to provide the alias names for the fields. Click on the Next button. 

 
Overview window: 
 This window allows you to specify a name for the query. 
 Selecting the Display Query radio button will execute the query immediately. And the Modify 

Query option will allow you to modify the query. 
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6. What are the steps involved in generating a report? 

A report is printed information that is assembled by gathering data based on user supplied criteria. 
1. Creating a report in StarOffice Base is very similar to creating a query or a form. To create a 
report, right click on Reports in the <Database> pane. Then click ‘Use Wizard to Create Report’. 
 
2. As in the case of form, this window displays a list of available tables and queries. Select the table 
or query you want. A list of fields from the selected table or query appears on the screen. Select the 
fields to be included in the report by using the > or >> buttons and click on the Next button. 
 
3. Next, a Labeling fields window appears with the field and Label. Modify the labels for the 
corresponding fields, if you want. Click on the Next button. 
 
4. The Grouping window is displayed , This window is used to specify the fields based on which 
the records can be grouped together. 
 
5. The Grouping window is followed by the Sort Options window . Here the sort criteria, if any, 
can be specified. 
 
6. The Choose Layout window as shown in displayed, here you can customize the report by 
selecting the Layout of Data, Layout of Headers and Footers and Orientation options for the 
report. 
 
8. The Report Wizard window which is 

displayed, next, allows you to choose 
Static or Dynamic Report. 
 

8. Enter the title for the report and click the 
Finish button to view the report.  
 

 
 
 
7. What are the disadvantages of manual Data processing? 
 

1. The efficiency and correctness of data processing are limited to the capabilities of the individual 
who is processing the data. 
 

2. Manual methods take more time. 
 
3. In general human beings are liable to make computational and parallax errors. 
 
4. Manual data processing involves use of papers at each stage. Preservation and maintenance of 

large volume of paper records becomes difficult and unmanageable. 
 
5. Implementation of corrections, changes and modifications are tedious in manual data processing. 
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8. Explain filter and its types with examples.        
 
Filters 
 A filter is also a type of query. It is also used to select and display records, which match a certain 

condition. The remaining records are hidden form the user. 
 The difference between query and filters is that queries can be saved for later use. 
 StarOffice Base allows you to use two types of filters. They are 

1. AutoFilter and 
2. Standard Filter. 

AutoFilter 
The AutoFilter icon is available on the toolbar. Click on this icon to display only the records, 

which match the value of the current field. 
 
Standard Filter 

Filter used with a condition called Default Filter. The condition can be specified by clicking on the 
Standard Filter icon on the toolbar. 
 
For example, 

 Open an existing query form the Queries pane by double clicking on it. 
 Click the Standard Filter icon from the main toolbar. A Filter window will appear. 
 Select Maths in the Field name box. 
 Select > operator in the Condition box. 
 Type 90 in the Value box. 
 Click on OK. 

 
 To remove the filter, click on the Remove Filter / Sort icon. The original table, with all the records 

is displayed. 

 

***************************************  
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VOLUME-II [ 5-MARKS ] 
 

1. Explain simple if statement with an example. 
 

 

Simple if statement: 
 Simple if statement is a one way Decision Making Statement. It is used to control the flow of 

execution of the statement. 
 Test logically to find whether the condition is true or false 

 
Syntax: 

if(condition / expression) 
{ 
action block; 
} 
 

 If there is only one statement in the if block, the braces { } are optional. 

Example: 
#include<iostream.h> 
#include<conio.h> 
void main() 
{ 
int a; 
clrscr(); 
cout << “Enter a number”; 
cin >> a; 
if ( a%2 = = 0) 
{ 
cout << “\n The given number”  << a << “is even”; 
} 
getch(); 
} 

 
OUTPUT: 

Enter a number   10 
The given number  10 is even 

 
2. Explain if-else statement with an example. 
if-else statement: 

 if-else statement is a two way decision making statements. And also used to test logically to find 
whether the condition is true or false. 

 “if – else statement which chooses between two alternatives , executes the chosen block based on 
the condition”. 

Syntax: 
if(condition / expression) 
{ 
action block 1; 
} 
else 
{ 
action block 2; 
} 

www.Padasalai.Net                                                              www.TrbTnps.com

http://www.trbtnpsc.com/2018/02/latest-12th-study-materials-2018.html

www.Padasalai.Net



 
M.VIJAYA KUMAR, MCA.,M.Phil.,B.Ed.,PGDCA., 

 

        Sastra Matriculation Higher Secondary School                          141 
 

 
 
Example: 

# include <iostream.h> 
# include <conio.h> 
void main() 
{ 
int a; 
clrscr(); 
cout << “Enter a number ”; 
cin >> a; 
if ( a%2 = = 0) 
{ 
cout << “\n The given number” << a << “is even”; 
} 
else 
{ 
cout << “\n The given number “ << a << “is odd”; 
} 
getch(); 
} 
 

OUTPUT: 
Enter a number   11 
The given number  11 is odd 

 
 
3. Explain nested if statement with an example. 

Nested if statement: 
 The statement sequence of if or else may contain another if statement. That is if .. else statements 

can be nested within one another is called nested if statement. 
 

 In an nested if .. else statement, “Each else matches with the nearest unmatched preceding if” 
 

Syntax: 

if(condition 1 / expression 1) 
if (condition 2 / expression 2) 
{ 
action block 1; 
} 
else 
{ 
action block 2; 
} 
else 
{ 
action block 3; 
} 
 

Example: 

#include<iostream.h> 
#include<conio.h> 
void main() 
{ 
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clrscr(); 
int a; 
cout<<“ENTER YOUR TENTH AVERAGE MARK \n”; 
cin>>a; 
if((a >= 60) 
if( a >= 90) 
cout<<“FIRST CLASS WITH DISTINCTION \n”; 
else 
cout<<“FIRST CLASS \n”; 
else 
cout<<“SECOND CLASS \n”; 
getch(); 
} 

OUTPUT: 
 
ENTER YOUR TENTH AVERAGE MARK 
96 
FIRST CLASS WITH DISTINCTION 
 

ENTER YOUR TENTH AVERAGE MARK 
80 
FIRST CLASS 
 
ENTER YOUR TENTH AVERAGE MARK 
55 
SECOND CLASS 

 
4. Explain switch statement with an example. 
 

Switch Statement: 
 

 Switch statement is a multiple branching statement where, based on a condition, the control is 
transferred to one of the many possible points. 

 
 “Switch selection expression must be of integral type “which means that switch expression should 

be evaluated to an integer constant only.  
 
Syntax: 

switch(expression) 
{ 
case 1: action block 1; 
break; 
case 2: action block 2; 
break; 
case 3: action block 3; 
break; 
default: action block 4; 
break; 
} 

Example: 
 

#include<iostream.h> 
#include<conio.h> 
void main() 
{ 
clrscr(); 
int a; 
cout<< “ENTER THE VALUE OF A \n”; 
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cin>>a; 
cout<< “THAT NUMBER IS \n”; 
switch(a) 
{ 
case 1: cout<< “ONE”; 
break; 
case 2: cout<< “TWO”; 
break; 
case 3: cout<< “THREE”; 
break; 
case 4: cout<< “FOUR”; 
break; 
case 5: cout<< “FIVE”; 
break; 
default: cout<< “YOUR NUMBER IS WRONG”; 
break; 
} 
getch(); 
} 
 

OUTPUT: 
ENTER THE VALUE OF A  
3 
THAT NUMBER IS  
THREE  
 

 
5. Explain entry controlled loop with an example. (or). Explain while loop with an example (or) 
Discuss about the general working of for loop in C++ 

 
 Loops execute a set of instructions repeatedly for a certain number of times. 

ENTRY CHECK LOOP 
1. While Loop    
2. For Loop 

 

1. While loop: 
 

 While loop is also called as entry check loop. The body of the while loop will be executed only if the 
test expression results true placed in the while statement. 
 

 The control exits the loop once the test expression evaluated to false.  
 
Syntax:- 

while (condition) 
{  
action block; 
}  

 
Example: 

#include<iostream.h> 
#include<conio.h> 
main() 
{ 
clrscr(); 
int n=2; 
while(n<6) 
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{ 
cout<<n*n<< “\t”; 
n=n + 1; 
} 
getch(); 
} 
 

OUTPUT: 
4  9  16  25  
 

2. for (; ; ) .. loop: 
 
 for (; ; ) loop is an entry controlled loop. It is used when an action is to be repeated for a 

predetermined number of times. 
 The body of the for loop is executed only if the test expression results is true placed in the for 

statement. 
 The control exits the loop once the test expression evaluated to false. 

 
Syntax: 

for(intial value ; test-condition ; increment) 
{ 
action block; 
} 

 The body of the loop has one or more statement. The blocking with braces are needed only if the 
contains two or more statements. 

 
Example: 

#include<iostream.h> 
#include<conio.h> 
void main() 
{ 
clrscr(); 
int i; 
for(i=0; i<5; i++) 
{ 
cout<< i << “\n”; 
} 
getch(); 
} 

 
OUTPUT: 

0 
1 
2 
3 
4 
 

 
6. Explain do-while loop with an example (or) Explain exit check loop with an example. 
 
do-while loop: 
 do … while <(condition)> is called as exit- check loop, as the condition(test expression) marks the last 

statement of the body of the loop. 
 The body of the do-while loop is executed at least once, if the irrespective of the test expression. 
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 In the do-while loop, the body of the loop is executed first and after that the condition will be 
evaluated. 

 Body of the loop repeatedly executed until the condition becomes false. 

Syntax:- 
do 
{  
action block; 
}  
while (condition); 

Example: 
#include<iostream.h> 
#include<conio.h> 
main() 
{ 
clrscr(); 
int n=2; 
do 
{ 
cout<<n*n<< “\t”; 
n=n + 1; 
} 
while(n<6); 
getch(); 
} 

 
OUTPUT: 

4  9  16  25  

 

4. FUNCTIONS 
1. What are the functions? Explain with an example. 
 
Functions: 
 

 Functions are the building blocks of C++ programs. Functions are also the executable segments in a 
program. 

 The starting point for the execution of a program is main ( ). 
 
Advantages of functions: 

 Reduce the size of the program. 
 Induce reusability of code. 
 A function can be shared by other programs by compiling it separately and loading them 

together. 
 

Syntax: 
data_type function_identifier(arguments) 
{ 
function block; 
return; 
} 
 

 return statement marks the end of the function and also transfers control to the statement after call 
statement. 
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Example: 
#include<iostream.h> 
#include<conio.h> 
int sum( int x, int y) 
{ 
return x+y; 
} 
void main() 
{ 
clrscr(); 
int a=10, b=5, s=0; 
s=sum(a,b); 
cout<< “THE RESULT IS…..\n”<<s; 
getch(); 
} 

OUTPUT: 
THE RESULT IS….. 
15 

 

2. Explain inline function with an example.  

Inline Functions: 

 An inline function looks like a normal function in the source file but inserts the function’s code 
directly into the calling program. 
 

 Inline function execute faster but require more memory space. 
 

 To make a function inline, one has to insert the keyword inline in the function header. 
 

 When the functions are small, the compiler replaces the function call statement by its definition ie, 
its code during program execution. This feature is called as inline function. 

 
Syntax: 

inline data_type function_identifier(arguments) 
{ 
function block; 
return; 
} 
 

 return statement marks the end of the function and also transfers control to the statement after call 
statement. 

 
Example: 
 

#include<iostream.h> 
#include<conio.h> 
inline int sum( int x, int y) 
{ 
return x+y; 
} 
void main() 
{ 
clrscr(); 
int a=10, b=5; 
cout<< “THE RESULT IS…..\n”<< sum(a,b); 
getch(); 
}  
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OUTPUT: 

THE RESULT IS….. 
15 

 

Advantages of inline functions: 

 Reusability of code leading to saving of memory space and 
 Reduction in code size. 

 
3. Explain call by value method with suitable example. 
 
Call by value method: 
 

 In this method, the called function creates new variables to store the value of the arguments passed to 
it. 
 

 This method copies the values of actual parameters into the formal parameters, thus the function 
creates its own copy of arguments and then uses them. 
 

 “In call by value method, any change made in the formal parameter is not reflected back to the actual 
parameter.” 
 

 In this method, the called function creates new variable to store the value of the arguments passed to it. 
 
Example: 

#include<iostream.h> 
#include<conio.h> 
void sawp(int n1,int n2) 
{ 
int temp; 
temp=n1; 
n1=n2; 
n2=temp; 
cout<<n1<<’\t’<<n2<<’\n’; 
} 
main() 
{ 
int m1=10,m2=20; 
clrscr(); 
cout<< “Before swap”<<m1<<’\t’<<m2<<’\n’; 
cout<< “Calling swap\n”; 
swap(m1,m2); 
cout<< “Back to main values are”<<m1<<’\t’<<m2<<’\t’; 
getch(); 
} 

 
OUTPUT: 
 

Before swap 10  20 

Calling swap 

20  10 

Back to main values are 10  20  
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4. Explain call by reference method with suitable example?  
In this method, the called function arguments-formal parameters become alias to the actual 

parameters in the calling function. 
 

 The function is working with its own arguments. 
 

 It is actually working on the original data. 
 

 In this method, any change made in the formal parameter is reflected back in the actual parameter. 
 
Example:  
 

#include<iostream.h> 

#include<conio.h> 

void sawp(int &n1,int &n2) 

{ 

int temp; 

temp=n1; 

n1=n2; 

n2=temp; 

cout<<n1<<’\t’<<n2<<’\n’; 

} 

main() 

{ 

int m1=10,m2=20; 

clrscr(); 

cout<< “Before swap”<<m1<<’\t’<<m2<<’\n’; 

cout<< “Calling swap\n”; 

swap(m1,m2); 

cout<< “Back to main values are”<<m1<<’\t’<<m2<<’\t’; 

getch();  

} 
 
OUTPUT: 
 

Before swap 10  20 

Calling swap 

20  10 

Back to main values are 10 20 
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5. Define scope. Explain the various types of scopes in C++. (or) How many types of variable scopes 
are there in C++? Explain them with sample snippet.    
 
 Scope refers to the accessibility of a variable. 

 There are four types of scopes in C++.  

They are, 
1. Local scope 
2. Function scope 
3. File scope 
4. Class scope 

Local scope: 
 
 A local variable is defined within a block. 
 The scope of a local variable is the block in which it is defined. 
 A local variable cannot be accessed from outside the block of its declaration. 
 Local variables are not known outside their own code block. A block of code begins and ends with 

curly braces { }. 
 Local variables exist only while the block of code in which they are declared is executing. 
 The life time of a local scope variable is the life time of the block in its state of execution. 
 Local variable are die when its block execution is completed. 
 A local variable is created upon entry into its block and destroyed upon exit. 

 
Function scope: 
 
 The scope of variables declared within a function is extended to the function block, and all sub-

blocks therein. 
 The variable is accessible in the function main ( ) only. It is accessible in all the sub-blocks therein 

- viz, while block & if block. 
 The life time of a function scope variable is the life time of the function block. 
 The scope of formal parameters is function scope. 

 
File scope: 
 
 A variable declared above all blocks and functions (precisely above main ( ) ) has the scope of a 

file. 
 The scope of a file scope variable is the entire program. 
 The life time of a file scope variable is the life time of a program. 

 

Class scope: 
 
 The data variables declared within the class has the scope of a class. 
 Their scope will be decided by the access specifier private, protected, public. 
 The life time of a class scope variable is the life time of the class. 

 
Scope Operator: 
 
 The scope operator reveals the hidden scope of a variable. 
 :: is called as scope resolution operator. 
 It is used to refer variables declared at file level. 
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7. POLYMORPHISM 
1. What are the rules for operator overloading? (OR) Define operator overloading. Write the rules 
for operator overloading. 
 
Operator overloading: 
 The mechanism of giving special meaning to an operator is called as operator overloading. 
 The term operator overloading, refers to giving additional functionality to the normal C++ 

operators like +,++,-,—,+=,-=,*.<,>. 
 The functionality of ‘+’ operator can be extended to strings through operator overloading. 

 
Rules for overloading operators: 

There are certain restrictions and limitations in overloading operators. They are: 
 Only existing operators can be overloaded. New operators cannot be created. 
 The overloaded operator must have at least one operand of user defined type. 
 The basic definition of an operator cannot be replaced or in other words one cannot redefine the 

function of an operator. One can give additional functions to an operator. 
 Overloaded operators behave in the same way as the basic operators in terms of their operands. 
 When binary operators are overloaded, the left hand object must be an object of the relevant class 
 Binary operators overloaded through a member function take one explicit argument. 
 
2. What is function over loading? Explain with an example. (or) Define function overloading. Give 
an example. What are its various rules? 
 
Function overloading: 

 The ability of the function to process the message or data in more than one form is called as 
function overloading. 

 Thus an ‘overloded functions’ refers to a function having more than one distinct meaning. 
 Function overloading is one of the facets of C++ that supports object oriented programming. 
 The compiler adopts BEST MATCH strategy. 

 
Example: 

#include<iostream.h> 
#include<conio.h> 
void area(float a) 
{ 
float s; 
s = a*a; 
cout<< “AREA OF THE SQUARE IS:” <<s; 
} 
void area(float l, float b) 
{ 
float s; 
s = l*b; 
cout<< “\n AREA OF THE RECTANGLE IS:” <<s; 
} 
void area(float a, float b, float c) 
{ 
float s; 
s = a*b*c; 
cout<< “\n AREA OF THE TRIANGLE IS:” <<s; 
} 
void main() 
{ 
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clrscr(); 
int x=5, y=8; 
area(x); 
area(x,y); 
area(0.5, x, y); 
getch(); 
} 

Output: 
AREA OF THE SQUARE IS: 25 
AREA OF THE RECTANGLE IS: 40 
AREA OF THE TRIANGLE IS: 20 

Rules for function overloading: 
1) Each overloaded function must differ either by the number of its formal parameters or their data types 
2) The return type of overloaded functions may or may not be the same data type 
3) The default arguments of overloaded functions are not considered by the C++ compiler as part of the  
     parameter list 
4) Do not use the same function name for two unrelated functions 

 
8. CONSTRUCTORS & DESTRUCTORS 

 
1. Write rules and usage of constructor and destructor. 
CONSTRUCTOR: 
 
 When an instance of a class comes into scope, a special function called the constructor gets 

executed. 
 A constructor is a function that allocates the memory of an object 

 
Rules for constructor definition and usage 

1) The name of the constructor must be same as that of the class. 
2) A constructor can have parameter list. 
3) It has no return type. 
4) The constructor function can be overloaded. 
5) The compiler generates a constructor, in the absence of a user defined constructor. 
6) The constructor is executed automatically. 

 
DESTRUCTOR: 
 
 When an instance of a class goes out of scope, a special function called the constructor gets 

executed. 
 A destructor is a function that removes the memory of an object which was allocated by the 

constructor at the time of creating a object. 
 
Rules for destructor definition and usage 
 

1) The destructor has the same name as that of the class prefixed by the tilde character ‘~’. 
2) The destructor cannot have arguments. 
3) It has no return type. 
4) Destructors cannot be overloaded i.e., there can be only one destructor in a class. 
5) The compiler generates a destructor, in the absence of a user defined destructor. 
6) The destructor is executed automatically when the control reaches the end of class scope. 
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9. INHERITANCE 
 

1. Explain the different types of inheritance?  
  

There are different types of inheritance. 

1. Single inheritance 
2. Multiple inheritance 
3. Multilevel inheritance 
4. Hybrid inheritance 
5. Hierarchical inheritance 
 

1. Single inheritance:- 
When a derived class inherits from only one base class, it is called as 

single inheritance. 
 
 

 
2. Multiple inheritance:- 

When a derived class inherits from multiple base 
classes, it is called as single inheritance. 

 
 

 
3. Multilevel inheritance:- 

The transitive nature of inheritance is reflected by this from of 
inheritance.  

 
When a class is derived from a class, which is a derived class itself. It 

is called as multilevel inheritance. 
 
 

 
 
 
 
 
 

4. Hybrid inheritance 
 
Combination of multiple and hierarchical inheritance is called hybrid 
inheritance. 
 
 
 
 
 
 
 

 
 
5. Hierarchical inheritance 

Multiple derived classes with same base class is called 
hierarchical inheritance. 
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2. What are the advantages of inheritance? 
 

 Reusability of code: - 
Many applications are developed in an organization. Code developed for one application 

can be reused in another application. This saves a lot of development time. 
 
 Code sharing: - 

The method of the base class can be shared by the derived class. 
 
 Consistency of interface: - 

The inherited attributes and methods provide a similar interface to the calling methods. 
 

Aeroplane, Car and Bicycle. These three derived classes are said to be having a consistence 
interface.  

 
 

3. Explain: Visibility Mode / Accessibility specifier: 
 

An important feature in Inheritance is to know as to when a member of a base class can be used by 
the objects or the members of the derived class. This is called as accessibility. The three access specifiers 
are private, protected and public.  

 
Access specifier is also referred to as visibility mode. The default visibility mode is private. The 

following Table explains the scope and accessibility of the base members in the derived. 
 

 
 
 When classes are inherited publicly, protected or privately the private members of the base class are 

not inherited they are only visible i.e continue to exist in derived classes, and cannot be accessed. 
 
 
 

**********************************  
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COMMANDS AND SHORTCUTS FOR VOLUME - I & II 

 

1. File -> New -> Text Document (Star Office Writer is opened) 

2. File -> Save (Save As dialog box is opened) Ctrl + S 

3. File -> Close (Closes a document and not the Star Office application) 

4. File -> Open (Open dialog box is opened) Ctrl + O 

5. Edit -> Cut (Cut the selected text) Ctrl + X 

6. Edit -> Copy (Copy the selected text) Ctrl+ C 

7. Edit -> Paste (Paste the selected text) Ctrl+ V 

8. Edit -> Find & Replace (Find and Replace dialog box) Ctrl + F 

9. Ctrl + A (Select the entire the document) 

10. Format -> Character (Character dialog box is opened) 

11. Center alignment (Ctrl + E) 

12. Left alignment (Ctrl + L) 

13. Right alignment (Ctrl + R) 

14. Justified alignment (Ctrl + J) 

15. Format -> Paragraph (opens the Paragraph dialog box) 

16. Format -> Bullets and Numbering (Opens Bullets and Numbering dialog box) 

17. Shift + F1 (Extended Tip) 

18. Tools -> Spelling -> Check (Opens the Spelling check dialog box) 

19. Tools -> AutoCorrect (AutoCorrect dialog box) 

20. F7 (Opens the Spelling check dialog box) 

21. Table -> Insert -> Table (Opens Insert Table dialog box) 

22. Table -> Insert -> Rows (Opens insert rows dialog box to add rows in a table) 

23. Table -> Insert -> Columns (Opens insert columns dialog box to add columns in a table) 

24. Tab (To move forward through the cells in a table) 

25. Shift + Tab (To move backward through the cells in a table) 

26. Table -> Delete -> Rows (To delete rows from a table) 

27. Table -> Delete -> Columns (To delete columns from a table) 

28. Edit -> Select -> All (To select the entire document) 

29. Table -> Delete -> Table (To delete the entire table) 

30. Table -> Table Properties (To open the Table Properties dialog box) 

31. Format -> Page (Opens Page Style dialog box) 

32. View -> Ruler (It is used when the ruler is not visible in the work area) 

33. Insert -> Fields -> Page number (To insert a page number on every page) 

34. File->New -> Spreadsheet(Opens StarOfficeCalc Window) 
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35. Edit -> Fill -> Series (Opens Fill Series dialog box) 

36. Insert -> Function(Opens Function Wizard dialog box) 

37. Ctrl+ F2 ->(Opens Function Wizard dialog box) 

38. Format -> Cells(Opens the Format Cells dialog box) 

39. Format -> AutoFormat(Opens AutoFormat dialog box) 

40. Format -> Column -> Width (Opens Changing Column Width dialog box) 

41. Format -> Row -> Height(Opens Changing Row Height dialog box) 

42. View -> Toolbar -> Inset Cell(Opens Floating toolbar) 

43. View -> Toolbar -> Insert Object (Opens Floating toolbar) 

44. Edit ->Delete Contents (Opens Deleting Contents dialog box) 

45. Edit ->Delete Cells (Opens Deleting Cells dialog box) 

46. Insert ->Picture ->From File(Opens Insert picture dialog box) 

47. Insert -> Special Character (Opens the Insert Special Character dialog box) 

48. Insert -> Chart(Opens AutoFormat Chart Window) 

49. File -> Print (Print dialog box is opened) 

50. Format -> Print Ranges -> Edit (To select a print range) 

51. Format -> Print Ranges -> Delete (To delete a print range) 

52. File -> Page View (To preview a worksheet before printing) 

53. Edit -> Fill -> Down or Left or Right 

54. Edit -> Fill -> Series 

55. File -> New -> Database (Opens Database Wizard dialog box) 

56. Edit -> Paste Special (Opens Past Special dialog box) 

57. File -> Send -> Outline to Presentation (Sends outline of a text document into a Presentation) 

58. File -> Send -> AutoAbstract (Sends outline along with its accompanying paragraphs) 

59. Alt + Tab (To switch between multiple applications) 

60. TO COMPILE C ++ PROGRAM ALT + F9 

61. TO RUN C++ PROGRAM CTRL + F9 

 
 
 
 

*************************************  
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Model Question Paper-2018 Volume-I  (Chapter 1 to 5) 

 

STD : XII       SUBJECT: COMPUTER SCIENCE 
TIME : 2.30 Hr        TOTAL MARKS: 70 

Instructions: 
1) Check the question paper for fairness of printing. If there is any lack of fairness, inform the hall supervisor 

immediately. 
2) Use Blue or Black ink to write and underline and pencil to draw diagrams. 

 

PART-A    15X1=15 
I. Choose the correct answer:  

 1. What is the default name given while saving a document in star office writer?  

a) Untitled 1   b) untitled   c) Document 1  d) Text 1  

2. Which command is used to quit from star office?  

a) File -> Quit  b) file -> exit   c) file-> close   d) file -> abort  

3. In star office writer which information about the current mode?  

a) Title bar   b) menu bar   c) tool bar   d) status bar  

4. An inch is equal to?  

a) 75 points   b) 74 points   c) 80 points   d) 72 points  

5. The shortcut key for opening style list is?  

a) F8    b) F7    c) F5    d) F11  

6. Which option is to be selected from the color palette to remove the highlighting for the selected text?  

a) Clear   b) no fill   c) remove   d) none  

7. Which button is clicked to include the word to the dictionary?  

a) Include   b) replace   c) add    d) move  

8. Which list displays alternative spelling in the spell check dialog box?  

a) Not in dictionary  b) with   c) Suggestions  d) replace  

9. Spelling mistakes are underlined in?  

a) Green color  b) red color   c) yellow color  d) grey color  

10. The intersection of rows and columns creates?  

a) Table   b) cells   c) address   d) formula  

11. To add a row after the last row of the table in star office writer, the key pressed is?  

a) Tab    b) shift   c) alt    d) ctrl  

12. In star writer the insertion point in the which cell of the table after the table is created?  

a) First   b) outside the table  c) middle   d) last  

13. In star office writer, the page preview option is available under the menu?  

a) Format   b) edit    c) file    d) view  

14. The default margins for top, bottom and left, right margins are?  

a) 1.25”, 1”   b) 1”, 1.25”   c) 1”,1”   d) 1.25”,1.25”  

15. In page style dialog box, which tab is used to select the page orientation?  

a) Page   b) header   c) footer   d) orientation  
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PART-B    6X2=12 

 
II. Answer any six questions : Question No. 24 is compulsory  

16. Define word processing.  

17. How to work with multiple documents ?  

18. How will you correct the mistakes in star office writer ?  

19. What is meant by Text Editing ?  

20. What is meant by hanging intent?  

21. What is the use of Auto correct option?  

22. What are the types of page orientation ? Which is default?  

23. What is meant by header and footer ?  

24. In star office writer how do you delete a row and columns in a table?  
 
PART-C    6X3=18 

 
III. Answer any six question : Question No. 32 is compulsory  

25. Define word processing. Write any four word processing packages.  

26. What is the different between copying text and moving text in StarOffice writer?  

27. How to change the line spacing in staroffice writer?  

28. What are the different types of paragraph alignment?  

29. How will you delete the entire table in staroffice writer?  

30. How will you create a header ?  

31. How to insert page number in footer area ?  

32. How will you make the selected row/column into same size in writer ?  

33. How does staroffice writer check spelling while typing ?  
 
PART-D    5X5=25 

 
IV. Answer All questions :  

34. Explain the different ways of selecting text in Staroffice writer document.  
( or )   

What are the steps to be followed to search & replace a given text? 
  
35. How would you create the Bullets and Numbered list ?  

( or )  
 How will you indent a given paragraph by using paragraph dialog box?  
 
36. How would you carry out the spell check after the entire document is typed ?  

( or )   
How will you add an entry to autocorrect list in staroffice writer ?  
 
37. Explain the various functions of the icon in the table formatting toolbar in star office writer?  

( or )   
Explain how to add & delete rows, columns in star writer?  
 
38. Explain creating header & footer and adding remarks and page number in text document?  

( or )  
How will you make use of page style dialog box and ruler to change margin? 

***** 
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